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Chapter 1: Getting Started with Project 
Management

Introduction to Project Management
Project Management enables organizations to streamline and standardize the management of project 
activities using a template-based, collaborative approach.

Project Management defines the step-by-step processes required to complete specific tasks and 
deliverables, guiding users through a dynamic, self-documenting process to support activities such as 
the execution of standardized checklists or the collection of deliverables using document attachments. 
For more information on setting up project processes and related items, see "General Setup 
Considerations" on page 16.

Using project types, the business rules that govern a project or set of projects can be formalized. 
Policies can be set governing various aspects of a project, including schedule health, task auditing, and 
project security. At least one project type must be created before you can create and manage projects. 
For more information on setting up project types, see "Configuring Project Types" on page 28.

When creating a project, you may be able to adjust policies handed down by the project type, as well as 
decide whether to include a work plan or staffing profile. Project security can also be defined. See 
"Creating a Project" on page 65, for more details on creating a project.

Work plans can be defined as hierarchical structures of summary tasks that logically group and 
organize tasks or activities. See "Creating and Managing a Work Plan" on page 74, for details on 
creating a work plan. Once the work plan structure is in place, task details can be configured in batches 
or one at a time, depending on the nature of the changes. See "Configuring Tasks" on page 116, for 
more details on task-to-task navigation.

As the project executes, managers can make use of the Project Overview page to view important 
project metrics such as health indicators, milestones, and issues. See "Viewing and Monitoring Project 
Metrics" on page 151, for details on the use of the Project Overview page.

Project teams can easily manage work plan activities within and across the technology chain because 
all team members, whether internal or external, collaborate and interact through an intuitive interface. , 
explains how resources on a project locate, update, modify, and report on tasks to which they are 
assigned.
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For example, when creating a new and updated version of a business system, a company could 
classify its efforts into summary tasks for each major functional area.

 l Each of these functional summary tasks could be further broken down into tasks directed to areas 
such as web content, application and database tasks.

 l These tasks can be linked to requests and packages from Demand Management and Deployment 
Management, giving instant visibility to more detailed activities supporting an overall work plan. 
Tasks can also have constraints and notifications configured on an individual basis. See 
"Configuring Tasks" on page 116, for more information.

 l In conjunction with Resource Management, role and skill assignments can be tracked against 
resource availability. Resource utilization can also be measured, visualized, and optimized.

Note:  To make use of their full range of features, resources and resource-related 
configurations should be set up in Resource Management prior to using Project Management. 
For more detailed information, see "General Setup Considerations" on page 16, or the 
Resource Management User’s Guide.

 l In conjunction with Time Management, time sheets can be used for actuals reporting on project-
related work. See "Integration with Time Management " on page 288, for more details.

 l As the project executes, risks, issues, and proposed scope changes can be submitted along 
preconfigured project control processes and tracked at the Project Overview level.

 l As the project executes, different sets of users may be called upon to evaluate and move the 
project along its pre-defined lifecycle.

 l Baselines of the work plan can be taken at any time, providing a basis for work plan performance 
comparisons.

 l Work plan cost data is tracked at the task level, and can be used to analyze trends and patterns via 
earned value analysis. Costs can be automatically calculated or manually specified, and actual 
costs can be automatically rolled up into the project financial summary.

 l Project Management also supports standard integration with Microsoft® Project so that functions 
such as task scheduling and resource management can be utilized at any point during a work plan's 
execution. See "Integrating Project Management with Microsoft Project" on page 194, for more 
detailed information.

Related Documents
Related documents for this book are:
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Chapter 1: Getting Started with Project Management
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 l Demand Management User’s Guide

 l Deployment Management User’s Guide

 l Project Management Configuration Guide

 l Resource Management User’s Guide

 l Time Management User’s Guide

 l Time Management Configuration Guide

 l Security Model Guide and Reference
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Chapter 2: General Setup Considerations

Overview of General Setup Considerations
There are several configuration steps that should be completed before you start to make use of Project 
Management. Some of these steps are required in order for you to take full advantage of Project 
Management functionality; others are optional depending on how much you want Project Management 
to fit your business processes.

In general, the configuration and setup work is as follows:

 1.  Set up resources and resource pools.

Resource Management allows you to create resource information for each user of Project and 
Portfolio Management Center, including details such as:

 o Role

 o Skill profile

 o Organization unit

 o Individual resource calendar

In order to assign a resource to a project's staffing profile or work plan, the resource must belong to 
a resource pool you manage. Resources that belong to other resource pools can be requested 
using standard staffing profile functionality.

See "Setting Up Resources" on page 18 for more details on this step.

 2.  Set up regions.

Regions are associated with each project and resource. They define attributes such as:

 o Calendar

 o Holidays

 o Normal working days and hours

 o Default currency

See "Setting Up Regions" on page 19 for more details on this step.
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 3.  (Optional) Configure Project Management validations.

Lists of values for certain fields can be tailored to suit your business needs through validations, 
which can be edited in the PPM Workbench.

See "Configuring Project Management Validations" on page 20 for more details on this step.

 4.  (Optional) Configure fields displayed on the Project Details tab of the Project Overview page.

The fields in the Project Details tab are preconfigured content, but they can be modified to suit 
your business needs. At a minimum, the security settings for these fields should be reviewed.

See "Configuring the Details Tab" on page 22 for more details on this step.

 5.  (Optional) Configure the project process in the PPM Workbench.

The project process is modeled in a preconfigured workflow that can be configured in the PPM 
Workbench to suit your business needs. At a minimum, the security settings for the workflow and 
its steps should be reviewed.

See "Configuring the Project Process" on page 23 for more details on this step.

 6.  (Optional) Configure project control processes.

Project issues can be submitted against a particular project to raise issues that require attention. 
Once submitted, project issues follow their own workflow to resolution. Project issue fields and 
behavior, as well as the underlying workflow, can be configured in the PPM Workbench to suit 
your business needs. Similar management tools are provided for project risks and scope changes.

See "Configuring Project Control Processes" on page 23 for more details on this step.

 7.  Set up project types.

Every project is created from a project type, which contains project policies that you can 
preconfigure for ease of use, or even lock down when appropriate. In order to create a project, you 
must first configure at least one project type. The Enterprise project type comes preconfigured, but 
should be reviewed to ensure that it suits your business needs.

See "Setting Up Project Types" on page 25 for more details on this step.

 8.  (Optional) Set up activities.

Tasks in the project work plan can be associated with activities, which can be used for Statement 
of Position (SOP) 98-1 tracking, classifying tasks as capital or operating expenses when they are 
actualized. If you choose not to activate SOP 98-1 tracking, activities can still be associated with 
tasks as a categorization tool.

See "Setting Up Activities" on page 25 for more details on this step.
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 9.  (Optional) Set up integration with Time Management.

Setup for Time Management integration is mostly done on the project type level. But, before using 
Time Management for reporting on project-related work activities, you should ensure that each 
resource has the proper permissions and delegations set up in Time Management. See the Time 
Management User’s Guide and Time Management Configuration Guide for more information.

 10.  (Optional) Set up integration with Microsoft Project.

Project Managementcan integrate with Microsoft Project. In order to take advantage of this 
integration, there are a few server settings that must be configured.

See "Setting Up Microsoft Project Integration" on page 26 for more details on this step.

 11.  (Optional) Set up task user data.

Task user data are custom fields that can be associated with every task in Project Management.

See "Setting Up Time Management Integration" on page 26 for more details on this step.

Setting Up Resources
Resources in Project Management can be tracked to optimize their time and capabilities with Resource 
Management. Resource Management allows a project manager to:

 l Set a calendar for each resource, determining total availability as well as specifying vacation days

 l (Optional) Assign a primary skill and role to a resource

 l View resource load by time period, work plan, or individual

 l Analyze and search resource availability

Resource pools can be used to track the supply of resources and are also necessary for work plan 
assignments. Each resource expected to be assigned to a project staffing profile or directly to a work 
plan must belong to a resource pool managed by the project manager. Either of the following project 
resource management strategies can be employed:

 l If your resources are not being actively managed, you can place all possible project resources into a 
single resource pool and designate all possible project managers as the resource pool's managers. 
This allows you to select any resource for your project staffing profile or work plan.

Note:  This strategy is not recommended if you have a large number of resources. Managing a 
large number of resources from a single resource pool affects performance and server stability.
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 l If your resources are being actively managed in such a way that their time must be requested from 
their managers, a staffing profile should be used. This allows you to request resources from a 
resource pool you do not manage using Resource Management functionality. The resource's 
manager will approve or reject the request.

Resources (including calendar information) and resource pools should be set up in Resource 
Management before creating a project in Project Management. Roles and skills should also be set up 
even if you do not intend to associate them with resources.

See the Resource Management User’s Guide for detailed information on how to perform these tasks.

Cost rates for individual resources are set using cost rate rules, which are controlled through Financial 
Management. See the Financial Management User’s Guide for detailed information on cost rate rules 
and their setup.

The following tasks can also be performed using Resource Management:

 l Mapping of resources into an organization model and tying organization units to security groups

 l Projecting the allocation of resources over time using staffing profiles

See the Resource Management User’s Guide for additional details.

Setting Up Regions
Regions are set up in Resource Management and contain their own calendars. These regional 
calendars specify the following:

 l Number of hours in a working day

 l Working days for each week

 l Holidays

A project can then be associated with a region for accurate project and resource scheduling.

See the Resource Management User’s Guide for detailed information on setting up regions and regional 
calendars.
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Configuring Project Management Validations
Values for certain fields in PPM Center are controlled by validations that are configurable or extensible. 
To change the list of possible values in a field, you must open its validation in the PPM Workbench and 
edit it from there.

Note:  Configurable or extensible validations only exist for fields associated with the Project 
Details tab of the Project Overview page and the project control processes. Values for work plan 
fields cannot be changed.

The Business Unit field on the Project Details tab of the Project Overview page is an example of a 
static list validation, which provides a static list of options to the user. A static list validation can be a 
drop-down or an auto-complete list component. 

Note:  If your PPM Center instance supports multiple languages, any validation you create is 
defined in the language you selected at logon (your session language). After the validation is 
created, it can be modified only in its definition language. For more information, see Multilingual 
User Interface Guide.

To add values to the validation list:

 1.  Log on to PPM Center and open the PPM Workbench.

 2.  From the shortcut bar, click Configuration > Validations.

 3.  On the Query tab of the Validation Workbench window, click List.

The Results tab opens, displaying the results of the search.

 4.  Select PFM - Business Units and click Open.

The Validation window opens with the Business Unit field's validation loaded.

 5.  Click New.

The Add Validation Value window opens.

 6.  Provide information for the validation value as described in the following table. 

Field Definition

Code The underlying code for the validation value. The code is the value stored in the 
database or passed to any internal functions, and is rarely displayed. 
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Field Definition

Meaning The displayed meaning for the validation value in the drop-down list or auto-
complete.

Desc A description for the validation value.

Enable? Determines whether the validation value is enabled. This should be checked if you 
want the value to appear in the field.

Default Determines whether the value is the default value for the list. This value is initially 
displayed in drop-down lists (this is not used for auto-complete lists). There can be 
only one default value per list.

 7.  (Optional) Set the validation value as the default by selecting the Default field. 

The default option is only available for drop-down lists.

 8.  Click OK to close the window and add the value to the validation. Click Add to add the value and 
keep the Add Validation Value window open.

Validation values can be re-ordered using the up and down arrow icons, sorted alphabetically using 

the Sort Order icon ( ), and moved to a specific sequence using the Jump To icon ( ). The 

sequence of the validation values determines the order that the values are displayed in the list.

 9.  When you are done adding values to the validation, click Save or OK in the Validation window to 
save the new values.

Note:  You can copy existing values defined in other validations using the Copy From button. 
Click Copy From and query an existing list-validated validation and choose any of the validation 
values. Click Add or OK in the Copy From window and the selected value or values are added to 
the list.

Be careful when creating validations (drop-down lists and auto-complete lists) that are validated by 
lists. Each time the set of values changes, you will be forced to update the validation. Consider, 
instead, validating using a SQL query or PL/SQL function to obtain the values from a database 
table. 

For more information on editing and creating validations of various types, see the Commands, Tokens, 
and Validations Guide and Reference.
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Configuring the Details Tab
The Details tab of the Project Overview page contains fields delivered as preconfigured content for 
projects.

Figure 2-1. Project Overview page: Details tab

These fields do not need to be set up or altered in any way before you start using Project Management, 
but if you want to change them, they can be customized to suit your business needs in the following 
ways:

 l Individual field names and values can be changed.

 l Fields themselves can be configured to be hidden, visible, or read-only depending on what stage 
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has been reached in the project process, which is driven by the workflow discussed in "Configuring 
the Project Process" below.

These fields and their workflow interactions are contained and defined by a request type that can be 
altered in the PPM Workbench.

For detailed discussion of this request type and workflow configuration, see the Project Management 
Configuration Guide.

Configuring the Project Process
The project process is determined by a workflow in PPM Center. This workflow is delivered as best-
practice content ready for you to use in Project Management, but if you want to change it, it can be 
customized to match your organization's project execution process. Steps in the workflow can also be 
configured to integrate with fields on the Details tab of the Project Overview page, determining whether 
they are visible or editable.

For detailed discussion of this request type and workflow configuration, see the Project Management 
Configuration Guide.

Configuring Project Control Processes
Project Management includes specialized project control items that can be submitted and managed 
during project execution as Demand Management requests:

 l Issues can be filed against a particular project to raise issues that require attention.

 l Risks can be brought up to highlight risks that may endanger project execution.

 l Scope changes can be requested to adjust the scope of the project.
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Figure 2-2. Project scope change
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Once submitted, these requests follow their own workflows to resolution. Each request type and its 
workflow are delivered as best-practice content ready for you to use, but if you want to change them, 
they can be customized to match your project control processes. The following project control request 
aspects can be changed to suit your business needs:

 l Individual fields and possible values can be changed.

 l Fields themselves can be configured to be hidden, visible, or read-only depending on what stage 
has been reached in the workflow.

 l The workflows can be changed.

For detailed discussion of these project control request types and workflow configuration, see the 
Project Management Configuration Guide.

Setting Up Project Types
All projects are created from project types. A project type is used to default or impose the business 
rules that will be used to manage a new project. Project types include policies for different aspects of 
managing the project, including:

 l What types of actuals are collected 

 l Whether built-in project costing or Time Management are used for the project

 l Whether the project will include a work plan

Project types and their policies must be set up before you can begin creating projects. For detailed 
discussion of configuring project types, see "Configuring Project Types" on page 28.

Setting Up Activities
Activities are simple configuration entities that can be associated with tasks in the project work plan. 
Activities marked as capitalized are used in this capacity for Statement of Position (SOP) 98-1 
tracking, and will categorize the costs of associated tasks as capital if the project supports 
capitalization. If you choose not to activate SOP 98-1 tracking, activities can still be associated with 
tasks as a categorization tool, and any associated costs will be considered operating expenses.

You do not need to configure activities nor associate them with tasks if you are not interested in SOP 
98-1 tracking, or if you do not wish to track task categories to this level of granularity. Project 
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Management comes with a pre-defined set of activities reflecting common SOP 98-1 categories that 
can be configured for use with tasks.

For detailed discussion of configuring activities and activity behavior, see theFinancial Management 
User’s Guide

Setting Up Time Management Integration
Time Management can be used in conjunction with Project Management for detailed entry of time and 
effort actuals using time sheets. Time sheets have their own sets of approvers and approval 
processes, and can be used for more granular cost reporting.

Setup for Time Management integration is mostly done on the project type level, but before using Time 
Management for reporting on project-related work activities, you should ensure that each resource has 
the proper permissions and delegations set up in Time Management. See the Time Management User’s 
Guide and Time Management Configuration Guide   for more information.

A few configuration tasks must be completed before using Time Management with Project 
Management. They are as follows:

 l Ensure that users who will be updating project actuals through Time Management have the proper 
licenses and access grants

 l Ensure that project managers have the proper access grants to approve time sheets submitted by 
users

 l For each project, ensure that the proper project settings have been configured for Time 
Management integration

For detailed discussion of Time Management integration, see "Integration with Time Management " on 
page 288.

Setting Up Microsoft Project Integration
Project Management integrates with Microsoft Project, allowing you to create a work plan in either 
application and synchronize scheduling and actuals information between the two. For example, if you 
are more comfortable creating work plans in Microsoft Project, but want to take advantage of Project 
Management's project participant functionality (such as the My Tasks portlet), you can create a work 
plan in Microsoft Project and send it to Project Management.
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There are a few tasks that must be completed before using Project Management with Microsoft 
Project. See the Project Management Configuration Guide for more details.

For more detailed discussion of Microsoft Project integration, see "Configuring Project Types" on 
page 28.

Setting Up Task User Data
Task user data are custom fields that can be associated with every task on a work plan. If you have no 
need of custom fields for tasks on your work plans, then you do not need to configure task user data.

For detailed discussion of task user data setup, see the Project Management Configuration Guide.
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Chapter 3: Configuring Project Types
 l "Overview of Configuring Project Types" below

 l "Working with Project Types" on page 30

 l "Setting Project Policies" on page 31

Overview of Configuring Project Types
This section discusses project types and project policies, and gives instructions on how to create and 
modify them.

Project Types

Each project is associated with a project type on creation. A project type is used to default or impose 
the business rules, or project policies, that will be used to manage a new project. At least one project 
type must be created in order for you to be able to create projects in Project Management, though an 
Enterprise project type is included with Project Management upon installation.

You can define ownership of each project type, allowing you to control which users can make changes 
to that project type. This can be useful when multiple organizations within a business maintain their 
own project types. You can also define limits on who can use a given project type to create projects. 
Project types can be copied. Project types can also be disabled, but any project currently using that 
project type will be unaffected.

Project Policies

A project type includes policies for a project concerning:

 l Which health metrics will be tracked for the project, as well as threshold levels for each health color

 l Security and audit controls for the project

 l The request type that will define the fields on the Project Details tab and drive the project process
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 l Costing exception rules that will be used to calculate indicators showing costing and earned value 
violations

 l Whether the project will include a work plan

 l What types of actuals are collected

 l Rules that govern work plan scheduling

 l Scheduling exception rules that will be used to calculate indicators showing a scheduling problem

 l Whether built-in project costing or Time Management are used for the project

 l Settings for Microsoft Project integration

 l Settings dictating the items that count as workload for resources for the project

 l The ability to create requests for change (RFCs) in Service Manager

The project type and its policies determine a project's settings.

Enforcing Project Policies

For each policy, the project type determines whether projects using the project type will be allowed to 
modify the associated settings. When you create a project using a project type with overridable 
policies, you can change the corresponding settings on that project as needed.

For example: A project type called "Alpha Project" is created for Company A. "Alpha Project" has an 
overridable Cost and Effort policy. A manager creates a project using the "Alpha Project" type, and 
changes the Cost and Effort settings to suit the needs of the project at hand. The manager cannot 
change any other settings, as they are non-overridable.

For projects that are already in progress, changing a project type policy or its override status has the 
following effects:

 l Changing an overridable policy to non-overridable will change that policy for projects in progress, 
switching their settings to match the new policy if settings were altered previously.

 l Changing a non-overridable policy to an overridable policy has no effect on projects in progress.

 l Making a change to a non-overridable policy changes the settings on projects in progress to match 
the new policy.

 l Making a change to an overridable policy has no effect on projects in progress.
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In cases where changes to a project type will cause recalculation of data (such as changes to 
exception thresholds), these calculations are deferred.

Making Changes to Policies that Do Not Propagate

Certain policies do not propagate changes to existing projects, even if they are set to be non-
overridable. These policies are:

 l Project Fields

 l Cost and Effort

 l Microsoft Project Integration

 l Work Plan Template (changes do propagate, but do not alter existing work plans)

If you want to make changes to a project type policy that does not propagate, follow the general 
procedure outlined below:

 1.  Identify a time when system activity is low.

 2.  On the project type, unlock the project policy.

 3.  Open existing projects and change the settings on each where allowed.

 4.  On the project type, lock the project policy.

Working with Project Types
To create a project type:

 1.  Log on to PPM Center.

 2.  From the menu bar, select Create > Administrative > Project Type.

The Create Project Type page opens.

 3.  Type a Project Type Name and, optionally, a Description.

 4.  Set the desired project policies as described in "Setting Project Policies" on the next page.

 5.  Click Create.
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Setting Project Policies
Project policies are grouped into related areas. These policies become the settings for a project created 
from the project type they belong to.

To set project policies, click the button corresponding to the policy you want to edit and make the 
necessary changes before clicking Save.

Note:  When you save project settings, PPM by default calculated the staffing profile labor cost. If 
your project has a large staffing profile that contains more than 200 positions, or it takes more than 
2 minutes to save project settings, you should set the parameter ENABLE_SP_LABOR_COST_UPDATE 
to false in the server.conf file, so that PPM will not calculate the staffing profile labor cost when 
yo save project settings.

Project Fields

The Project Fields policy controls the fields tracked by a work plan. Selecting the checkbox or option 
next to a field activates it. Some fields contained in the Project Fields policy are required in order for 
you to take full advantage of Project Management functionality, and should be left active.
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Figure 3-1. Project Fields policy

Table 3-1 describes the fields controlled by the Project Fields policy.

Field Name Description

Schedule Fields section

Scheduled 
Start

The scheduled start for a task.

Scheduled 
Finish

The scheduled finish for a task.

Scheduled 
Duration

The scheduled duration for a task.

Scheduled 
Effort

Allows you to specify scheduled effort per task. This field is controlled by the Cost 
and Effort policy.

Actuals Fields section

Table 3-1. Project Fields policy
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Field Name Description

% Complete The amount of the task that has been completed.

Actual Start The date at which work on the task actually begins.

Actual Finish The date at which work on the task actually ends.

Actual 
Duration

The actual duration of the task, calculated from the Actual Start and Finish.

Actual Effort Allows you to specify actual effort values for each task. This field is controlled by 
the Cost and Effort policy.

Estimated 
Remaining 
Effort

Allows you to specify an estimated remaining effort value for each task. This field is 
controlled by the Cost and Effort policy.

Estimated 
Finish Date

Allows you to specify an estimated finish date for each task.

Additional Fields section

Service Allows you to track, categorize, and analyze business services for a task. Service 
and PFM Project field groups must be enabled in order to use this field.

is required Allows you to make the Service field a required field.

Activity Allows you to assign an activity to a task; used primarily for SOP 98-1 tracking.

Role Allows you to specify a role for each task.

Milestone Display section

Major 
Milestones

Allows you to identify tasks as "major milestones" that appear on the Project 
Overview page.

Table 3-1. Project Fields policy, continued

Work Plan

The Work Plan policy allows you to specify whether a project will have a work plan, who can access 
the work plan, who can view the actuals, and suggest or enforce a specific work plan template to be 
used with the project type. 
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Figure 3-2. Work Plan policy

Work Plan Accessibility

You can restrict the users who can view the work plan and the actuals on the Task Details page using 
the work plan policy settings described in "Table 3-2. Work plan and actuals user accessibility" below.

Note:  The project manager can always access the work plan and view actuals. The project 
manager cannot be restricted from accessing and viewing the work plan and actuals.

A user can always view his actuals. However, a user may be restricted to view only his actuals.

Field Name Description

Work plan can be accessed 
by

Restricts who can access the work plan.

 l All Users. Default. All PPM Center users can view the work plan.

 l Project Managers, Summary Task Owners, and 
Stakeholders. Only project managers, summary task owners, or 
stakeholders can view the work plan.

 l Project Managers only. Only project managers can view the 
work plan.

Resources restricted from 
work plan can view only their 
actuals on Task Details 
page

Enable this setting to restrict the user to view only his actuals on the 
Task Details page. If enabled, other user's actuals are displayed as 
Restricted. If disabled, the user may view other user's actuals.

Table 3-2. Work plan and actuals user accessibility
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"Table 3-3. Work plan and actuals user accessibility" below shows what a PPM Center user (end user, 
summary task owner/stakeholder, or project manager) can access or view depending on the settings 
selected.

Settings Selection User can:

Work plan can be 
accessed by

Resources restricted from work 
plan can view only their actuals on 
task details page

Access 
work 
plan

View other’s 
actuals on Task 
Details page

User: End Usera

All users N/A Yes Yes

Project managers, 
summary task owners, 
and stakeholders

  No Yes

x No No

Project managers only   No Yes

x No No

User: Summary Task Owner or Stakeholder

All users N/A Yes Yes

Project managers, 
summary task owners, 
and stakeholders

  Yes Yes

x Yes Yes

Project managers only   No Yes

x No Nob

User: Project Manager

All users N/A Yes Yes

Project managers, 
summary task owners, 
and stakeholders

  Yes Yes

x Yes Yes

Project managers only   Yes Yes

x Yes Yes

a. An end user is any PPM Center user who is not a summary task owner, stakeholder, or project 
manager.

b. A summary task owner or stakeholder will not see the actuals for child tasks unless he owns 
them.

Table 3-3. Work plan and actuals user accessibility
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For example, if a project's work plan policy has Project managers only set for the Work plan can be 
accessed by field and the Resources restricted from work plan can view only their actuals on 
task details page field is enabled, a summary task owner, logged in to PPM Center, who has access 
to the project does not have access to the work plan. While the summary task owner can view his 
actuals on the Task Details page, he cannot view anyone else's actuals.

Work Plan Template

The work plan template and override behavior is as follows:

 l If you specify a work plan template in the Work Plan Template field and set the policy to non-
overridable, a project created from this project type can only create a work plan based on this work 
plan template. Moreover, the default work plan template cannot be changed.

 l If you specify a work plan template in the Work Plan Template field and set the policy to 
overridable, the manager for a project created from this project type can choose to create the work 
plan from the default template, another template, or manually.

 l If you do not specify a work plan template, the policy is set to overridable by default. This should be 
done for project types that do not require a specific work plan template.

For more detailed information on work plan templates, see "Setting up a Work Plan Template" on 
page 77.

Request Types

The Request Types policy specifies the following items:

 l The request type that controls the fields which appear on the Project Details tab of the Project 
Overview page. This request type is also associated with the workflow that drives the overall 
project process. This item is required.

If you have installed Portfolio Management, this request type will also represent the project in your 
portfolio. See the Portfolio Management Configuration Guide for more details.

 l The request type (and, implicitly, the associated workflow) used to report and resolve project 
issues.

 l The request type (and, implicitly, the associated workflow) used to report and resolve project risks.
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 l The request type (and, implicitly, the associated workflow) used to report and resolve project scope 
changes.

Figure 3-3. Request Types policy

Scheduling

The Scheduling policy specifies options that govern how the work plan is scheduled, including:

 l Default start date to schedule the work plan from

 l Resource dependency

 l Critical path threshold

 l Scheduling warning rules
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Figure 3-4. Scheduling policy

Default Start Date

This part of the Scheduling policy controls the default start date from which tasks are scheduled. This 
is set on each project, regardless of whether the policy is set to non-overridable. This is used to set a 
consistent date from which to schedule the work plan, no matter what occurs during the planning 
process.

The policy also determines whether the scheduler considers existing actual start and finish dates for 
tasks when rescheduling. By default actual dates are considered.
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For example, once a work plan becomes Active, its tasks can be marked In Progress. When tasks are 
marked In Progress, actual start dates are specified for that task. If the project is set to use actual 
start/finish dates in scheduling, the In Progress tasks will move to start on their actual start dates.

Resource Dependency

Every business initiative has some minimum resource requirements, usually in the form of available 
personnel. Project Management checks to ensure that resources are assigned on their working days. 
The Include days in schedule when options can be set to consider resource requirements when 
creating the work plan schedule. For instance, it is possible for the Scheduling policy to set the project 
to ignore resource availability and schedule accordingly.

The default configuration is set to require all resources to be available on any given day. When creating 
the work plan schedule, Project Management will only consider days when all resources are present.

Critical Path Threshold

A work plan's critical path is the series of tasks that determines the duration of the project. The Critical 
Path Threshold is the amount of slack (the amount of time that a task may be delayed from its start 
without delaying the project) specified as the threshold for identifying a task as part of the critical path. 
Tasks with slack less than or equal to this value are on the critical path. Use of a threshold allows the 
project manager to control the degree of risk tolerated in management of the work plan.

Schedule Warning Rules

You can select which Schedule Warning Rules are used to alert the project manager about potential 
structural problems when scheduling a work plan. Schedule warnings are calculated whenever task 
data is saved, so they can be used even without using the scheduler.

Note:  Project Management will only issue warnings based on the schedule warning rules you 
have selected.

Tolerance

Tolerance is used to determine if a resource has affected the estimated remaining effort (by updating 
actuals on a task) and results in the total effort differing significantly from the scheduled effort. As a 
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result of this warning, the project manager may need to adjust the schedule or resource allocation.

Tolerance is the difference between scheduled effort and total effort as a percentage of scheduled effort 
(where total effort is the sum of actual effort and estimated remaining effort): ((SE - (AE + ERE)) / (SE)) 
* 100. If the scheduled effort differs from the total effort by more than this threshold, a warning indicator 
is added to the schedule warnings column of the work plan.

If a value is specified, the warning is cleared when the planned effort does not differ from the total effort 
by more than the specified tolerance. If a value is not specified, warnings are not calculated and any 
existing warnings are cleared.

The value specified must be an integer.

Schedule Health

The Schedule Health policy controls the project's schedule health indicator, as well as determines the 
active exception rules for a project.
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Figure 3-5. Schedule Health policy

Schedule Health Indicator

The project's schedule health indicator is a simple color-coded indicator of the health of a work plan. A 
project only has a schedule health indicator when the work plan is Active; it disappears when the work 
plan is completed or put On Hold. A project's schedule health indicator color begins green and changes 
to yellow or red depending on the percentage of tasks identified as contributing to work plan health that 
have triggered exceptions (completed tasks are ignored). This percentage is configured by the 
Schedule Health policy. A project's schedule health indicator will not be calculated until the project is 
saved.

You can specify the following two rules In the Health section of the Schedule Health section to 
configure the percentage (schedule health indicator):
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 l Percent of tasks that have Exceptions to turn the Schedule Health Red

 l Percent of tasks that have Exceptions to turn the Schedule Health Yellow

The schedule health indicator is calculated as Count of Exceptional Tasks / Count of Total Tasks. For 
example, a project is created from a project type whose Schedule Health policy sets the threshold 
value for red to 60% and threshold value for yellow to 30%. If the percent of tasks that have exceptions 
is less than 30%, the schedule health indicator is green. If the percent is more than 30% but less than 
60%, the indicator is yellow. If the percent is more than 60%, the indicator is red.

Note:  When calculating the count of total tasks, PPM does not include summary task or tasks 
whose status is either "Completer" or "Cancelled".

 l If seven tasks trigger an exception in a work plan consisting of ten tasks in total, then the schedule 
health value computed for this project is 7 / 10, or 70%. As a result, the schedule health indicator 
turns red, and will remain red until at least five tasks are reworked until they no longer trigger 
exceptions (this could be accomplished by changing a start date, or modifying resources, or starting 
the tasks). Once this occurs, the schedule health indicator turns green.

 l If four tasks trigger an exception in a work plan consisting of ten tasks in total, then the schedule 
health value computed for this project is 4 / 10, or 40%. As a result, the schedule health indicator 
turns yellow, and will remain yellow until at least two tasks are reworked until they no longer trigger 
exceptions (this could be accomplished by changing a start date, or modifying resources, or starting 
the tasks). Once this occurs, the schedule health indicator turns green.

 l If one task triggers four exceptions in a work plan consisting of ten tasks in total, then the schedule 
health value computed for this project is 1 / 10, or 10%. As a result, the schedule health indicator 
remains green.

Scheduling Exception Rules

Projects come with a set of predefined exception rules. The Schedule Health policy can specify which 
exception rules are to be enabled, as well as the criteria needed to trigger them. As discussed above, 
the policy can also set the schedule health indicator, which is a simple color-coded indicator of the 
schedule health of a project. The schedule health indicator watches for schedule exceptions that have 
been triggered, and changes color according to the policy.

This can be a good way to keep track of high-risk projects. For example, for a project type with a very 
low margin for error, the policy can set the percentage of tasks that must have exceptions to turn the 
schedule health indicator red to 20, giving clear early warning of problems.

The Schedule Health policy controls the exception rules relating to project scheduling and execution.
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The following parameters for almost all exception rules are configurable:

 l Enabled. Project managers can decide whether or not the particular exception rule is enabled.

 l Rule (number of days). Specifies the number of days the particular exception rule waits for or 
monitors.

 l Include in Health. Decides whether or not the violations of the particular exception rule are 
included in the schedule health indicator (see "Schedule Health Indicator" on page 41).

Each exception rule within the policy can be configured independently.

Cost and Effort

The Cost and Effort policy dictates how the costs, effort, and workload for the project will be 
managed, including how this information flows between project entities such as the work plan, staffing 
profile, financial summary, and time sheets, if any. The policy determines whether financial information 
will be tracked for projects, how actuals are captured, and how costs are calculated. If you have 
installed Time Management to capture actuals, this policy controls the Time Management settings for a 
project type. If you do not have Time Management or choose not to use it, you can select and configure 
Financial Management options.
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Figure 3-6. Cost and Effort policy
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Resource Load Settings

Resource Management automatically keeps track of resource workload and availability. These settings 
determine how to track workload for a project type.

Resource Management allows you to attach a staffing profile to a project to track resource demand and 
usage. You can choose between the following options:

 l Staffing Profile represents the work load imposed by the project. You can then choose 
whether to enter actuals on the staffing profile manually, or roll actuals from the work plan or Time 
Management up to the staffing profile. In order for roll-up to work, you must enable the tracking of 
actual effort in this policy, described in "Actual Effort in the Work Plan" below. For more information 
on staffing profiles, see the Resource Management User’s Guide.

 l Work plan task assignments represent the load imposed by the project. In order for this 
option to be selected, you must enable the tracking of scheduled and actual effort in the work plan, 
described below.

Scheduled Effort in the Work Plan

You can decide whether or not to track the scheduled effort needed to accomplish each task in the work 
plan. This is required if you are setting the project to automatically calculate the planned cost of tasks 
(set in the Cost and Effort policy under Financial Management), or if the work plan task assignments 
are set to represent resource load (set in the Cost and Effort policy under Resource Load Settings).

If you decide to Use Scheduled Effort during planning, you can then choose to have the system 
automatically calculate it, or provide it manually. Additionally, you can choose to allow the calculation 
method to be changed in the work plan on a task-by-task basis.

Actual Effort in the Work Plan

You can decide whether or not to track actual effort per resource assignment during the execution of a 
project. This is required when automatically calculating actual costs, when using Time Management to 
track actuals for the work plan, or when work plan task assignments represent resource work load.

If you decide to Track Actual Effort per resource assignment, you can also choose whether to 
Require resources to enter % Complete along with actual effort when they specify actual effort 
(on time sheets if they use Time Management, or elsewhere). If resources are not required to enter % 
Complete, project managers can still specify it later.
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If you decide to Track Actual Effort per resource assignment, you can also choose to Track 
Estimated Remaining Effort per resource assignment. This setting cannot be used in conjunction 
with Time Management if you are tracking time at anything other than the task level, nor can it be 
changed once actuals have been captured.

Note:  Estimated remaining effort (ERE) is an estimated value derived from actuals. If there are no 
actuals, PPM resets ERE to zero. If actuals have been logged against a task, the ERE value is 
updated whenver the % Complete field on the Task Details page is changed. That means ERE 
stays in sync with changes in the % Complete field.

If you manually input ERE, % Complete is calculated as Actual Effort / (Actual Effort + ERE).

If you manually input % Complete, ERE is calculated as one of the following:

 l ERE = Scheduled Effort (SE) - Actual Effort (AE)

 l ERE = (Last ERE + Last AE) - AE

Time Management

If you choose to enable Time Management for this policy, there are a range of options to configure, 
described in "Table 3-4. Cost and Effort policy: Time Management settings" below.

Field Name Description

Use Time 
Management to ...

Enables tracking of actuals using Time Management time sheets.

Track time at the ... Specify whether to track time at the task, summary task, or project level.

You can specify the summary task hierarchy level to track down to.

If you are using Time Management to track actuals and are also capturing 
estimated effort, you can only track time at the task level.

Allow the following 
...

Specify whether you want Project resources,All resources, or only 
Assigned resources to track time.

 l Project Resources. Resources assigned to tasks on the work plan or who 
appear on the staffing profile can log time on any task.

 l Assigned Resources. Only resources who are assigned to a task can 
report time on those tasks.

 l All resources. Any resource who can see the project (including 
stakeholders) can log time for any task.

Table 3-4. Cost and Effort policy: Time Management settings
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Field Name Description

After a task is 
complete...

Specify whether time can be logged after a task completes, and if so, for how 
long.

Time logged 
against this project 
...

Specify who must approve time logged against the project, either by 
participant group or specific security group.

Table 3-4. Cost and Effort policy: Time Management settings, continued

Financial Management

Financial Management can calculate certain costs automatically depending on criteria selected (such 
as the fields that are enabled):

 l In order to automatically calculate planned costs for the work plan, you must first enable the 
Scheduled Effort field as described in "Scheduled Effort in the Work Plan" on page 45.

 l In order to automatically calculate actual costs for the work plan, you must first enable the Actual 
Effort field as described in "Actual Effort in the Work Plan" on page 45.

 l In order to automatically calculate planned labor costs from the staffing profile, a staffing profile 
must exist.

If you choose to enable Financial Management for this policy, there are a range of options to configure, 
described in "Table 3-5. Cost and Effort policy: Financial Management settings" below.

Field Name Description

Allow 
capitalized 
costs ...

Specify if the project tracks capitalization for costs, identifying all costs as either 
capital or operating expenses according to the activity assigned to each task.

Changes to this setting affect the capitalization tracking for the financial summary 
associated with the project.

Capitalization information is only tracked if capitalization tracking has been enabled 
on the PPM Server.

A proposal may or may not track capitalized costs (in addition to operating costs) 
based on the setting of the option The proposal is for a project that tracks capital 
costs on the Financial Summary Settings page of the proposal. When the proposal 
becomes a project, this setting can conflict with the setting of the option Allow 
capitalized costs on this project on the Cost and Effort policy of the project.

If the Cost and Effort policy of the project type is locked (meaning that no individual 

Table 3-5. Cost and Effort policy: Financial Management settings
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Field Name Description

project of that type can be made to override any settings of that policy) and if the 
policy setting for tracking of capitalized costs conflicts with the financial summary 
setting for the proposal, the setting of the Cost and Effort policy prevails. Otherwise, 
the setting for tracking the project's capitalized costs is consistent with the setting for 
the proposal.

See the Financial Management User’s Guide for more detailed information.

Enable 
Financial 
Management 
for Work 
Plan

Enables tracking of work plan costs using Financial Management.

Planned 
labor costs 
on the work 
plan will be:

Specify if planned costs are automatically calculated based on scheduled effort and 
rates, or manually entered.

Actual labor 
costs on the 
work plan 
will be:

Specify if actual labor costs are automatically calculated based on actual effort and 
rates, or manually entered.

Costs on the 
Financial 
Summary

Specify if cost values roll up to the financial summary associated with the project. 
You can choose to roll up forecasted labor, labor and non-labor costs, actual labor 
costs only (non-labor costs are entered manually), or no cost data at all (actual costs 
are entered manually). If you want to roll up non-labor costs, you must also roll up 
labor costs.

For detailed information about the calculation of the costs on the Financial Summary, 
see "Costs on the Financial Summary" below.

Table 3-5. Cost and Effort policy: Financial Management settings, continued

For more information about some of these fields, see the Financial Management User’s Guide.

Costs on the Financial Summary

Dependency of the check boxes

The check boxes in this section follow the following dependency:
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 l Selecting the Enable Financial Management for work plan check box enables: 

 o The  Allow manual adjustment on the actual labor cost check box and its parent check box.

 o The Allow manual adjustment on the actual non-labor cost check box, and its parent check 
box

 l Selecting the parent check boxes  enables the child check boxes.

Cost and Earned Value Health

The Cost and Earned Value Health policy controls whether or not to track the cost health for a 
project, and if so, which metrics will be evaluated to determine health. It is used to indicate the health of 
a project in terms of its cost. Project cost health is indicated by the colored indicator in the project 
header

Project cost health is calculated in the following areas:
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 l If CPI is less than. CPI, the Cost Performance Index, is the cost efficiency ratio of the project's 
Earned Value  to Actual Costs. CPI is calculated as Earned Value / Actual Cost (when Actual Cost ! 
= 0). For a healthy project, CPI should be near 1.

 o If Earned Value is null, CPI is null.

 o If Earned Value = 0 and Actual Cost = 0, CPI=1.

 o If Earned Value ! = 0 and Actual Cost = 0, CPI = 0.

Note:  For detailed information about how to calculate Earned Value, see Financial Management 
User’s Guide.

 l If SPI is less than. SPI, the Schedule Performance Index, is the difference in value between the 
scheduled completion of a task/project and its actual completion. SPI is calculated as Earned Value 
/ Planned Value (when Planned Value ! = 0). For a healthy project, SPI should be near 1.

 o If Earned Value is null, SPI is null.

 o If Earned Value = 0 and Planned Value = 0, SPI=1.

 o If Earned Value ! = 0 and Planned Value = 0, SPI = 0.

Note:  For detailed information about how to calculate Planned Value, see Financial Management 
User’s Guide.

 l For prior months, if actual costs exceed the plan of record by. This is a comparison of project 
costs with the plan of record. It is a percentage calculated as ((Actual Cost - Plan of Record) /Plan 
of Record) * 100. Both the actual costs and plan of record are derived from the planned start period 
to the last day of the previous month. For example, if the planned start period is April 2009, and 
today's date is June 15, 2009, this calculation is based on actual costs and the plan of record from 
April and May of 2009.

If a plan of record does not exist, this calculation is not used in the overall project cost health.

Any one of these factors can be enabled or disabled when calculating work plan cost health, but if more 
than one factor is enabled, the indicator represents the factor in the worst condition. If one factor out of 
three turns red, the cost health turns red.

Figure 3-7. Cost and Earned Value Health policy
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Table 3-6 below details the default color change values for each relevant cost health factor.

Color changes to CPI less than SPI less than Plan of record exceeded by

Yellow .95 .95 5

Red .8 .8 20

Table 3-6. Default color change values for cost health indicator

Microsoft Project Integration

Project Management and Microsoft Project can be integrated, allowing you to perform tasks such as:

 l Opening a Microsoft Project file in Project Management

 l Sending an Project Management work plan to Microsoft Project

 l Using Microsoft Project to maintain the work plan while collecting actuals through Project 
Management

 l Mapping Project Management user data and Microsoft Project custom data

The Microsoft Project Integration policy controls the level of integration between the two applications. 
For more detailed discussion of these settings, see "Project-Level Settings for Integration" on 
page 232.
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Figure 3-8. Microsoft Project Integration policy
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Staffing Profile Assignments

Resource Management allows you to attach a staffing profile to a project to track resource demand and 
usage. The Staffing Profile Assignments policy allows you to specify a default resource pool to 
which all resource requests for the staffing profile will be routed. For more information on staffing 
profiles, see the Resource Management User’s Guide.

Figure 3-9. Staffing Profile Assignments policy

Project Health

The project summary condition indicator that appears in the project header on the Project Overview 
page  is an indicator of the project's overall health as a weighted average of the health indicators for 
schedule, cost and earned value health, and issue health.

Figure 3-10. Project health indicators

The Project Health policy controls the relative weights of these indicators. By default, each weight is 
counted equally. To change the weighting for the summary condition calculations, provide a weight 
value in the appropriate field next to the desired indicator.
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The Project Health policy also controls whether project managers can override the project's calculated 
health.

Figure 3-11. Project Health policy

The summary condition value is calculated as Sum(Weight * Indicator Value) / Sum of Weight. The 
default indicator values are:

 l Green: 1/6

 l Yellow: 3/6

 l Red: 5/6

The project summary condition indicator changes depending on the summary condition value:

 l If summary condition value < 1/3, the project summary condition indicator is green.

 l If 1/3 <= summary condition value < 2/3, the project summary condition indicator is yellow.

 l If summary condition value >= 2/3, the project summary condition indicator is red.

For example, a project has schedule health indicator red, cost health indicator red, and issue health 
indicator green. The weight values are set as follows:

 l Schedule Weight: 4

 l Cost Weight: 5

 l Issue Weight: 6

The summary condition value for this project is (4 * 5/6 + 5 * 5/6 + 6 * 1/6) / (4 + 5 + 6), or 56.7%. 
Because 1/3 <= 56.7% < 2/3, the summary condition indicator for this project is yellow.
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For more information about schedule, issue, or cost health, see the following sections: "Schedule 
Health" on page 40, "Issue Health" below, and "Cost and Earned Value Health" on page 49.

Issue Health

While a project is in progress, any number of issues may come up that need to be submitted and 
resolved using the project issue request. The real-time status of a project in terms of the issues 
submitted against it is represented by the issue health indicator..

Figure 3-12. Project health indicators

The Issue Health policy determines whether issue health is tracked for a project, and also controls the 
following factors in issue health indicator calculation:

 l The weight of each issue priority.

The issue priorities that appear in this policy are determined by the validation for the Priority field, 
which is extensible.

 l The total weight needed to change issue health indicator color.

As the weight and indicator color change values are pure numerical totals and not relative percentages, 
you may want to plan accordingly for project types that are expected to generate large numbers of 
issues.

Figure 3-13. Issue Health policy
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You can assign different weights to issues that are assigned different priorities. You can also assign 
thresholds for the health status levels signified by yellow and red indicators. 

For example, suppose that you have assigned weights to the issue priorities for the project as follows:

 l Critical: 8

 l High priority: 5 

 l Medium priority: 3 

 l Low priority: 1 

Suppose your project has the following issues: 

 l 3 high priority issues 

 l 2 medium priority issues 

The overall health value computed for these project issues is (3 * 5 + 2 * 3), or 21.

If the threshold value for the yellow health indicator is 20, and the threshold value for the red health 
indicator is 40, then the issue health indicator for this project is yellow. 

The default indicator thresholds are: 

 l Red: 40 

 l Yellow: 20 

 l Green: all values less than 20

The default weights assigned to project issue priorities are:
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 l Critical: 5

 l High priority weight: 3 

 l Medium priority weight: 1 

 l Low priority weight: 0

Task Auditing

Project Management can maintain an audit trail of changes to task fields in addition to a history for task 
status, which is always recorded. The Task Auditing policy controls which of these fields will be 
recorded. You must enable a field through the Project Fields policy in order to maintain a transaction 
history for it.

Figure 3-14. Task Auditing policy
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Project Overview Layout

The Project Overview Layout policy controls the settings used to print and display portlets for a project. 

Field Description

Allow project 
managers to 
override these 
settings?

If enabled, a project manager can modify the display and print settings and 
layout of a project.

If disabled, the project manager cannot modify the display and print settings 
and layout of a project. The policy is inherited from the project type and the 
fields, for the project manager, are disabled.

Default Tab for 
display

The default tabbed area displayed on the project overview page.

If Project Exceptions is selected and there are no exceptions for the project, 
the Project Summary tabbed area is displayed instead.

Print Settings

Work Plan Default: 15. The number of tasks to print in the Work Plan portlet.

Milestones Default: 15. The number of tasks to print in the Milestone Summary portlet.

Issues Default: 15. The number of issues to print in the Issues portlet.

Show Closed 
Issues

Select to include closed issues when printing the Issues portlet.

Risks Default: 15. The number of risks to print in the Risks portlet.

Show Closed 
Risks

Select to include closed risks when printing the Risks portlet.

Scope Changes Default: 15. The number of scope changes to print in the Scope Changes 
portlet.

Show Closed 
Scope Changes

Select to include closed scope changes when printing the Scope Changes 
portlet.

Project Staffing Default: 15. The number of lines to print in the Staffing portlet.

Project 
Associations

Default: Date Summary. Select the type of information to include when printing 
the Project Associations portlet. 

Participants Default: Project Managers, Stakeholders, Summary Task Owners. Select the 
participant information to include when printing the Project Participants portlet.

Display Settings

Table 3-7. Project Overview Layout policy settings
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Field Description

Work Plan Default: 5. The number of tasks to display in the Work Plan portlet.

Milestones Default: 5. The number of tasks to display in the Milestone Summary portlet.

Project Staffing Default: 5. The number of lines to display in the Staffing portlet.

Approve Time Default: 5. The number of time sheet lines to display in the Time Approval 
portlet.

Issues Default: 5. The number of issues to display in the Issues portlet.

Risks Default: 5. The number of risks to display in the Risks portlet.

Scope Changes Default: 5. The number of scope changes to display in the Scope Changes 
portlet.

Layout

Add Portlets Select the portlets to display. Only Project Overview portlets can be selected.

Display area Rearrange, resize, and/or remove portlets to display and print.

Portlets shown in grey can only be printed. Portlets shown in white can be 
displayed and printed.

When printing, the portlets shown are the portlets selected as the defaults to 
print in the Export Project Overview to PDF dialog. From this dialog, you can 
also modify the portlets to print.

Table 3-7. Project Overview Layout policy settings, continued
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Figure 3-15. Project Overview Layout policy
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Project Security

The Project Security policy determines if a summary task owner can edit their summary tasks and the 
users who are able to view the project and its cost data. 

By default, a summary task owner is not allowed to edit the work plan and certain toolbar buttons in the 
work plan are not enabled. If you select Yes for the Allow summary task owners to manage their own 
tasks? option, this allows summary task owners to edit, add, and remove subtasks within their 
summary task. Toolbar buttons are enabled for the summary task owner in the work plan.

For viewing the project itself, choose between:

 l All Users

 l Only participants (Project Managers, Summary Task Owners, Resources Assigned on 
Tasks, Resources Allocated to the Staffing Profile, Stakeholders, and Process Participants)

For viewing project cost data (financial summary, cost information), choose between:

 l All Users that can view the project and its tasks

 l Project Managers and Stakeholders

 l Project Managers, Stakeholders, Summary Task Owners and Process Participants

Figure 3-16. Project Security policy

Process participants for a project are the users who are included in security groups associated with 
steps in the workflow that governs the project process. These security groups, as well as the workflow 
itself, can be configured to suit your business needs. See the Project Management Configuration Guide 
for more information.
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HPE Service Manager

This policy allows PPM Center project managers to enable the ability to create requests for change 
(RFCs) in Service Manager from corresponding tasks in a project. For more information, see the 
Solution Integrations Guide.

Figure 3-17. HPE Service Manager policy

Project Formula

The Project Formula policy determines how PPM calculates Estimate At Completion (EAC). 

Figure 3-18. Project Formula policy
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Hybrid Project

The Hybrid Project policy determines if the project can be set as a hybrid project. When the project 
becomes a hybrid project, it can be integrated with another project within PPM Center and agile 
management systems. 

Figure 3-19. Hybrid Project policy
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Chapter 4: Creating a Project

Overview of Creating a Project
This section describes the process of creating a project. Projects allow organizations to define 
business initiatives with tools including:

 l A configurable list of project participants

 l A staffing profile that defines and tracks resource usage for a project

 l A financial summary that defines and provides a basis of comparison for the amount of money 
devoted to a project

 l A work plan that provides a hierarchical structure of tasks that logically groups and organizes 
activities and deliverables 

Using projects, users can define, browse, edit, and manage key aspects of complex business 
initiatives.

The general process of creating a project for project managers is as follows:

 1.  Log on to PPM Center.

 2.  Create a project.

When creating a project, you must select a project type. See "Creating a Project" on the next page 
for more details.

If you are using Portfolio Management, the project may be created for you automatically from an 
existing proposal.

 3.  Once the project is created, you can perform a number of activities from the Project Overview 
page.

See "Using the Project Overview" on page 67 for more details.

 4.  Adjust the project's settings.

Some project settings may be locked down by project policies, which are dictated by the project 
type. See "Adjusting Project Settings" on page 68 for more details.

 5.  Configure the project's participants.

HPE Project and Portfolio Management Center (9.40) Page 65 of 292



You can add to the project's list of managers and stakeholders. The project's resources and 
summary task owners are determined by the resources assigned in the work plan and the staffing 
profile attached to the project. See "Defining Project Participants" on page 69 for more details.

 6.  Create a staffing profile for the project.

Staffing profiles are a Resource Management tool that can be used in conjunction with projects to 
track and manage resource demand. See "Creating a Staffing Profile" on page 72 for more details.

 7.  Create a work plan for the project.

The work plan is the project's hierarchical structure of tasks that specifies task details such as:

 o Task start and finish dates

 o Task predecessors, if any

 o Assigned resources

See "Creating and Managing the Work Plan" on page 259 for more details.

 8.  Once initial planning is complete, set the project and work plan status to Active to begin project 
execution.

Creating a Project
To create a project:

 1.  Log on to PPM Center.

 2.  From the menu bar, select Create > Project.

 3.  The Create New Project page opens.

 4.  Fill in all required fields and any optional fields, including Project Type.

The project type contains project policies, which determine project settings. Some of these 
policies may be configured to be non-overridable, which lock down their corresponding project 
settings (see "Configuring Project Types" on page 28, for more details on project policies). Make 
sure you are using the desired project type before creating the project. You can only choose from 
project types to which you have been granted access.

 5.  Click Create.

The project is created and the Project Overview page opens.
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Using the Project Overview
The Project Overview page provides a centralized, consolidated view of the project's statuses in many 
areas. It also serves as a central navigation point to the entities associated with the project, such as its 
financial summary and staffing profile, forming a consolidated hub of communication between the 
project manager and others interested in the project. The sections of the Project Overview page are 
self-configuring, appearing when they are relevant for the project, and only to users who have the proper 
level of access, such as cost-related sections. 

Using the Project Overview page and its sections, project managers can keep track of the items 
described in "Table 7-2. Project Overview page tabs and sections" below:

Section Possible Sections and Uses

Project 
header

 l Project general information, including progress, duration, managers, status, and 
so on.

 l Project health, including project overall health, issue health, schedule health, and 
cost health.

 l Project cost data, including projected cost, actual cost, and budget.

Table 7-2. Project Overview page tabs and sections
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Section Possible Sections and Uses

Summary tab  l The progress of work plan phases and major milestones

 l Exceptions that have been triggered

 l Project issues

 l Project risks

 l Project scope changes

 l Project staffing

 l Project cost data including financial summaries and earned value (EV) analysis

 l Time Management integration

 l Programs the project is linked to

Details tab  l Project summary

 l Business case details

 l Risk and value ratings

Exceptions 
tab

Exceptions triggered by work plan tasks

Cost tab Project cost data

Staffing tab Staffing profile associated with the project

References 
tab

References attached to the project

Table 7-2. Project Overview page tabs and sections, continued

Adjusting Project Settings
Every project contains a number of settings that can be configured by the project manager to suit that 
particular project's objectives. These settings are inherited from the project policies, dictated by the 
chosen project type.

See "Setting Project Policies" on page 31 for detailed discussion of each project policy.

To view or edit project settings, click ... > Project Settings in the upper-right corner of the Project 
Overview page.

Note:  Project policies can be set to non-overridable, effectively locking down their corresponding 
project settings and preventing you from editing them.
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Defining Project Participants
In general, Project Management defines participants in a project according to the following groups:

 l Project managers. Project managers take part in project planning and management, overseeing 
project execution, issue resolution, and budgetary concerns.

 l Stakeholders. Stakeholders are users who do not perform any work on a project, but are interested 
in the project's status and need to view project progress.

 l Resources. Resources are users who work on tasks as part of a project team, but do not have the 
administrative responsibilities of a project manager. Resources view and update their tasks in 
Project Management.

 l Summary Task Owners. Summary task owners are the people named on summary tasks who 
have oversight over that section of the work plan.

Note:  If you set a large number of resources as the summary task owners, the length of 
RESOURCE_FULL_NAME_LIST_HOVER will exceed the limit of 4,000. This causes the Summary 
Task List portlet to throw errors. In this case, you should decrease the number of summary 
task owners.

The list of resources for a project is automatically defined by the following sources:

 l Resources assigned to tasks in the work plan

 l Resources specified in the staffing profile for the project

Project managers can specify additional project managers and stakeholders for a project.

Figure 4-2. Configure Project Participants page

Stakeholders can be added individually or by security groups.
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To add additional project managers or stakeholders to a project:

 1.  Create or open a project.

 2.  In the upper-right corner of the Project Overview page, click ... > Configure Participants.

The Configure Project Participants page opens.

 3.  Add additional project managers or stakeholders.

 o Click Add Project Manager to add one or more project managers.

 o Click Add Stakeholder and select Add User or Add Security Group to add new 
stakeholders.

Note:  The individual users and users in the security groups are listed by user ID in the 
database in the following form:

<user_id>#@#<user_id>#@#<user_id>#@#<user_id>

The maximum length of the variable that holds the delimited list of user IDs is 4,000.

The maximum number of stakeholders of a project depends on the character length of user 
IDs. The longer the user IDs are, the less stakeholders can be supported. For example, if 
all user IDs have five digits, then the project can have 4000/8=500 stakeholders, with the 
delimiter "#@#" taken into calculation.

 4.  Click Done.

The new project managers or stakeholders have been added.

Entering Project Details
The Project Details tab of the Project Overview page contains fields that hold important project 
information, such as the business unit responsible for the project, or the business objectives the project 
is designed to fulfill. These fields drive the overall project process, and can be configured by users with 
the proper level of access, such as a program management office.

Note:  When a request type is associated with a project type as the project process request type, 
PPM checks the following conditions:

 l Whether or not stakeholders have permission to view the request type.

 l Whether or not stakeholders have the permission to edit projects or have the right to override 
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project type settings.

 l Whether or not stakeholders have permission to edit the request type.

For stakeholders who only have the View All Projects access grant, they have the right to override 
project type settings. Therefore, they can edit all fields in the Project Details tab.

For stakeholders who only have the View Project access grant, they do not have the right to 
override project type settings. Therefore, they cannot edit fields in the Project Details tab.

For more information on configuring the Project Details tab fields, as well as the project process itself, 
see the Project Management Configuration Guide.

Setting Idle Time for Project Details Page

You might spend long time entering data in the Project Details page. However, PPM would regard this 
as inactivity and then terminate your session. You can use the following parameter to set the duration 
you can stay idle in this page. This helps prevent data loss because of inactivity.

Parameter Description, Usage Values

REQUEST_AND_PROJECT_ 
KEEPALIVE_MAX_IDLE_TIME

You use this parameter to specify the 
duration (in minutes) that you can stay 
idle on the Request Details page and 
Project Details page before your session 
starts to time out.

Default value: 
600 

Valid value: 
positive integer

The KINTANA_SESSION_TIMEOUT parameter, which specifies the time to elapse before a user session 
times out, still takes effect when you use the above  parameter. They work together in the following 
way:

 l When the value of REQUEST_AND_PROJECT_KEEPALIVE_MAX_IDLE_TIME is greater than 0, you can 
stay idle Project Details page for the specified duration. After the duration ends, the session times 
out when the time specified by KINTANA_SESSION_TIMEOUT is up. 

In this case, as long as you are not idle in these pages performing actions like clicking the mouse 
and pressing keys, your session will not time out because PPM keeps the session alive.

 l When the value of REQUEST_AND_PROJECT_KEEPALIVE_MAX_IDLE_TIME is 0, KINTANA_SESSION_ 
TIMEOUT works in the Project Details page as it does in other PPM pages: your session times out if 
no requests are sent from the browser to the server for a duration equal to or greater than the 
KINTANA_SESSION_TIMEOUT value.
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Creating a Staffing Profile
Staffing profiles enable a project manager to track the demand of resources for a project, arranged by 
role or skill. A staffing profile can be created for a project to tie it to business functions and facilitate 
meaningful comparison visualizations.

To create a staffing profile for a project, click Create a Blank Staffing Profile on the Project Overview 
page.

For detailed instructions on creating staffing profiles and making use of staffing profile functionality, see 
the Resource Management User’s Guide.

Working with a Financial Summary
A financial summary can be used to track financial information for a project, with varying levels of data 
dependency. Once the project is in progress, actual project costs can be rolled up to the financial 
summary for comparison purposes. Project cost performance as compared to the plan of record can 
also be taken into account when calculating project cost health. See "Cost and Earned Value Health" 
on page 49 for details.

For more information about financial summaries, see the Financial Management User’s Guide

Searching for Projects
You can search for projects in one of two ways:

 l Search box. Use the search box if you know the name of the project or want to search for one or 
more projects that use a particular phrase or fragment of text in its name. The search box is located 
in the upper-right corner. 

 l Search Projects page. Use the Search Projects page if you want to search for a project based on 
criteria such as project manager, project type, planned start date, planned finish date, finished 
project, health, associate programs, or region.
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Search Box

The search box is used to locate and open projects based on project names that contain the specified 
text.

To locate and open a project using the search box:

 1.  Log on to PPM Center.

 2.  In the search box, located on the right side of the menu bar, type @ followed by the text to search 
for in the project name. When you start typing the text, a submenu appears (the search is not 
case-sensitive).

 3.  Once you have finished typing your search text, select Search for projects: <search_text>.

If the search text matches only one project name, the Project Overview page for that project 
opens.

If the search text matches more than one project name, the Search Project page opens, displaying 
a list of projects with matching names. Click the name of a project to open its Project Overview 
page.

Search Projects Page

The Search Projects page is used to locate and open projects based on the search criteria you select.

To locate and open a project using the Search Projects page:

 1.  Log on to PPM Center.

 2.  From the menu bar, select Search > Projects.

The Search Projects page opens.

 3.  Provide search criteria in the appropriate fields.

 4.  Click Search.

The Search Projects page reloads, displaying the results of your search.

 5.  Click the name of a project to open its Project Overview page.
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Chapter 5: Creating and Managing a Work 
Plan
Once you have created a project, you can create its work plan. Project work plans allow you to define a 
business initiative as a hierarchical structure of tasks and summary tasks that logically groups, 
organizes, and schedules activities and deliverables.

Creating a Work Plan from Another Project
To create a work plan from an existing work plan from another project in Project Management, do the 
following:

 1.  On the Project Overview page, click the Create work plan from another project link.

The Create Work Plan from Another Project dialog opens.

 2.  In the Create Work Plan from Another Project dialog, type the project name from which to copy the 
work plan (required) and select the information to be copied (by default, Notifications is selected).

Note:  If Schedule is not copied, the schedule start date of the new work plan is defaulted to 
the new project's start date.

If Notes are copied, the original date and timestamp are preserved.

If Resource Assignments are copied, only resources from the existing project that are part of 
the new project's resource pool are copied.

The following information is automatically processed from the existing project. You cannot change 
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how this information is processed.

Information How Processed

Actuals Never copied

Internal predecessors Always copied

Microsoft Project link Always removed at the task level

Required task flag Always copied

Roles and activities Copied if these fields are enabled in the project settings

Schedule duration, effort, 
and effort mode

Always copied

Skill proficiencies Always copied

Summary task owner Copied if the summary task owner from the existing project is a 
summary task owner in the new project 

Tasks (non-root) Always set to Ready or Pending (including tasks that were 
cancelled in the existing work plan)

Work plan status Always set to In planning for the new project

 3.  Click Create.

You can import a work plan from another project into an existing work plan. See "Importing a Work 
Plan" on page 83 for more details on this method.

Creating a Blank Work Plan
To create a new work plan in Project Management, do the following:

 1.  On the Project Overview page, click the Create blank work plan link.

 2.  Add tasks to the blank work plan, filling in the following task aspects first:

 o Name

 o Duration

 o Start or finish date
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You can also add predecessors and structure the work plan hierarchy when initially adding tasks 
to the work plan. See "Adding Tasks and Creating a Work Plan Hierarchy" on page 80 for more 
details.

 3.  Create any desired milestones.

Major milestones can also be added if the project's settings have been configured properly. See 
"Creating Milestones" on page 93 for more details.

 4.  Schedule the project.

See "Scheduling the Work Plan" on page 94 for more details.

 5.  Filter the work plan view in different ways to evaluate related information.

You can use different work plan views and filters to evaluate the work plan and make subsequent 
changes to tasks. See "Displaying Work Plan Information" on page 98 for more details.

 6.  Begin configuring individual tasks, if necessary.

See "Configuring Tasks" on page 116for more details.

 7.  View the work plan's critical path.

See  for more details.

Creating a Work Plan from a Work Plan 
Template
If a company has a business process that is used repeatedly, it will be easier to create and manage if it 
has its own template containing preconfigured settings. 

To create a new work plan from a work plan template:

 1.  Create a new project.

 2.  On the Project Overview page, click the Create work plan from a template link.

The Create Work Plan from Template dialog box opens.

 3.  Select the desired template from the Work Plan Template field.

 4.  Click Create.

A new work plan is created as defined by the work plan template.
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Note:  The project type may enforce a particular work plan template for a project. See "Work Plan" 
on page 33 for more details.

You can also create a work plan from an existing work plan from another project or import a work plan 
from another project into an existing work plan. Refer to "Creating a Work Plan from Another Project" 
on page 74 or "Importing a Work Plan" on page 83 for more information.

Setting up a Work Plan Template
Work plan templates are used in Project Management to create repeatable processes to be used as a 
model and basis for numerous projects.

Work plan templates speed up the process of setting up your work plans. A repeated set of tasks are 
bundled into a template and used to create a work plan while preserving its notifications, any resource 
assignments, and predecessors.

For example, a company with several different software products might use the same process for all 
development efforts. A work plan template could be used to create the work plan for each one, as 
opposed to creating them all individually every time a project is planned. Information for each individual 
project can then be modified by a particular project manager as needed.

A work plan template consists of an ordered hierarchy of tasks. The sequence of tasks can be edited in 
a manner nearly identical to the way work plans are manipulated in the Schedule view.

Figure 9-1. Defining a work plan template
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Creating and Managing Work Plan Templates

Work plan templates are created and managed from the menu bar.

 l To create a work plan template, click Create > Administrative > Work Plan Template. The 
Create Work Plan Template page opens, allowing you to create a work plan template.

 l To manage work plan templates, click Search > Administrative > Work Plan Templates. The 
Manage Work Plan Template page opens, listing all the work plan templates in the system. Click on 
a work plan template name to open the Template Details page.

Adding Tasks to a Work Plan Template

After you create a work plan template, the Work Plan Template page opens. The process of adding 
tasks to a work plan template is identical to adding tasks in the Schedule view. See "Adding Tasks to 
the Work Plan" on page 81 for details.

Note:  Some fields in work plan template tasks do not exist or cannot be updated.

Configuring Tasks in a Work Plan Template

Tasks and notifications in a work plan template can be configured the same way as they are in the 
Schedule view. See "Editing Task Information" on page 123 for details.

Note:  Some fields in work plan template tasks do not exist or cannot be updated.

You can mark a task in a work plan template as required. A required task cannot be renamed or 
removed from a work plan created using the template. To mark a task as required, select the Require 
this task on work plans created from this template checkbox on the Task Details page.

Configuring Access to a Work Plan Template

You can control who has the ability to use or edit a work plan template through the Configure Access 
page. Click Configure Access on the Template Details page to configure access for a work plan 
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template.

Creating a Work Plan Template from an Existing 

Work Plan

Project managers can create a new work plan template from an existing work plan. Project managers 
who want to convert their Microsoft Projects into Project Management work plan templates can first 
import their Microsoft Project into an Project Management project and then convert it into a template. 
See "Integrating Project Management with Microsoft Project" on page 194 for detailed instructions on 
converting a Microsoft Project file into a PPM Center project.

Note:  Only users with the Edit Work Plan Templates access grant can convert an existing work 
plan into a work plan template.

To create a work plan template from an existing work plan:

 1.  Open the project.

 2.  In the Schedule view, click Actions and select Convert Work Plan to Template.

The Convert a Work Plan to a Template dialog box opens.

Note:  In order to successfully convert a work plan to a template, you must be the only user 
editing the work plan. If other users are editing the work plan, a message will appear stating 
that the "Project is being edited by another user" and the conversion stops. 

 3.  Provide a new Template Name, Template Owner and Description for the new work plan 
template.

 4.  Select whether to include Notifications by selecting the associated checkbox.

See  "Work Plan to Work Plan Template Conversion Details" on the next page for a list of items 
copied from the work plan to the template.

 5.  Click Convert.

When the conversion is complete, a dialog box opens.

 6.  Click Edit Template to edit the new work plan template.

Note:  In the work plan to template conversion, not all work plan details are copied to the new 
template. The work plan's actuals information is discarded during the conversion, such as the 
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actual duration, efforts, start date and end date of the work plan and tasks.

Work Plan to Work Plan Template Conversion Details

When creating a work plan template from a work plan, the following items are copied or dropped:

 l Data that work plan templates do not carry is dropped. This includes:

 o External predecessors

 o Schedule dates

 o Constraints

 o Effort and cost actuals

 o Task status

 o Resource assignments and summary task owners

 o References

 o Notes

 o User data

 l Scheduled effort is copied as follows:

 o For automatically-calculated tasks, scheduled effort is recalculated.

 o For manually-input tasks, total task effort is retained in the Unassigned Effort field.

 l Everything else is copied into the work plan template.

Adding Tasks and Creating a Work Plan 
Hierarchy
Work plans are created on the Work Plan page. 

 l For a new project, the Work Plan page is reached by clicking the Create blank work plan, Create 
work plan from a template, or Create work plan from another project links.

 l For an existing project, the Work Plan page is reached by clicking Edit Work Plan.

Note:  The Work Plan page opens to the last view you were using when viewing the work plan. If 
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the work plan is new, or you have never opened the Work Plan page for this project before, the 
Quick view opens by default.

Figure 5-1. Work Plan page: Quick view

The top-level task is automatically created with the project name.

Adding Tasks to the Work Plan

 l "Adding Tasks in Quick View" below

 l "Adding Tasks in Other Views" on the next page

Adding Tasks in Quick View

In the Quick view of a work plan, you can add a new task below any existing task:

 1.  In the Quick view, select the task below which you want to add a task.

 2.  Click the + icon.

A new task is added below the selected task.

 3.  Edit the information of the new task.

You should fill in each task's Name, but in order for Project Management to schedule the project, 
you must also provide scheduling information. This information can be supplied on the Add Tasks 
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page. Click Change at the top of the page to select the combination of scheduling information you 
want to use.

Tasks can also be edited from the work plan page or through the Task Details page, which 
displays more detailed information on a task. The Task Details page is accessible from the Work 
Plan page.

 4.  Click the   icon to save your changes and add the task. Or click the   icon to cancel the 

adding.

Limitation: The   and   icons may hang over the fields of the new task. To avoid this issue, 

you can try dragging the horizontal bar or resizing the browser window or the columns.

 5.  (Optionally) Configure the task hierarchy.

Select the newly added task and click the Indent or Outdent icon to structure the task into a 
hierarchy of a summary tasks and subordinates. See "Useful Keyboard Shortcuts in the Work 
Plan Views" on page 90 for keyboard shortcuts that can help you save time.

Note:  If a task contains a user data field for which a default value has been set, the default value 
appears on the Work Plan page even before you save it.

Adding Tasks in Other Views

In other views, you can add a new task above any existing task in the work plan by selecting the task 
and clicking the Add Task icon, which opens the Add Tasks page. To add a task to the work plan:

 1.  Within the Schedule view, select the empty row at the bottom of the work plan and click the Add 
Task icon.

The Add Tasks page opens, with a new task above the current selection.

 2.  Click the Add Task Below icon to add a new task below the current selection.

 o You can also add a new task above the current selection by selecting the last item on the Add 
Tasks page and pressing Insert on your keyboard.

 o You can also add a new task below the current section by selecting the last item on the Add 
Tasks page and pressing Enter on your keyboard.

 3.  Edit the new task's information.
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You should fill in each task's Name, but in order for Project Management to schedule the project, 
you must also provide scheduling information. This information can be supplied on the Add Tasks 
page. Click Change at the top of the page to select the combination of scheduling information you 
want to use.

Tasks can also be edited from the work plan page or through the Task Details page, which 
displays more detailed information on a task. The Task Details page is accessible from the Work 
Plan page.

 a.  Select the new task and click the Task Details icon. The Task Details page opens.

 b.  Modify the information under each tab on the Task Details page as necessary (for details, see 
"Configuring Tasks" on page 116).

 4.  Configure the task hierarchy, if desired.

You can structure the newly-added tasks into a hierarchy of summary tasks and subordinates 
using the Indent and Outdent icons at the top of the Add Tasks page. See "Useful Keyboard 
Shortcuts in the Work Plan Views" on page 90 for keyboard shortcuts that can help you save time.

 5.  Add the new tasks to the work plan.

To add the tasks to the work plan, click Done.

Note:  If a task contains a user data field for which a default value has been set, the default value 
may not appear on the Work Plan page until the task is saved. Even though you cannot see the 
default value, the value has been set.

Importing a Work Plan

From the Work Plan page, Project Management allows users to import a work plan from another project 
into an existing work plan. To import a work plan:

 1.  Within the Schedule view, select a non-root task in the work plan.

Note:  The work plan is imported above the selected task.

 2.  Click Actions and select Import another Work Plan.

The Copy Work Plan from Another Project dialog opens.

 3.  In the Copy Work Plan from Another Project dialog, type the project name from which to copy the 
work plan (required) and select the information to be copied (by default, Notifications is selected). 
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See "Creating a Work Plan from Another Project" on page 74 for more details about the information 
to be copied.

 4.  Click Copy.

If the imported work plan is large, the selected task (in step 1) disappears from the Schedule view 
(you can scroll down to view the selected task).

Creating a Work Plan Hierarchy

Project Management allows users to add and structure tasks in any order, from either the Add Tasks 
page or the Work Plan page. Once tasks have been added, you may find that you need to rearrange 
them later. The Work Plan page also allows you to arrange and group tasks in a hierarchy. 

Note:  Changes made to the work plan in the Work Plan page are immediately saved.

Figure 5-2. Work Plan page

To move an item up or down in the hierarchy:

 l In the Quick view:

 a.  Select the task or collapsed summary task.

A four-headed arrow appears in the front of the task line.

 b.  Click and hold the arrow to drag the task to your selected line.

Note:  You cannot drag a task to the location of its leaf task.
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 c.  Release the arrow.

The task is located under the selected line.

 l In other views:

 a.  Select the task or collapsed summary task.

 b.  Click the Cut icon.

You can also simply copy a task using the Copy icon. Copied tasks can be pasted several 
times.

 c.  Select the task below your target area in the work plan hierarchy.

 d.  Click Paste icon.

The cut item is placed in the work plan above the selected task.

Large work plans may split up work plan information into pages. You can cut tasks from one 
page of the work plan and paste them into another. See "Viewing Large Work Plans" on 
page 110 for more information.

To indent an item:

 1.  Select the task or collapsed summary task.

 2.  Click the Indent icon.

The selected task or summary task moves one level deeper in the hierarchy.

 o If the item immediately above the selected item is a task, that task is converted to a summary 
task.

 o Acting on a summary task acts on its children. Indenting a summary task brings its children 
one level down in the hierarchy as well.

Note:  If the selected item is the first child of a summary task, you will not be able to indent it.

If a task is converted to a summary task, a warning message displays and you must select Yes to 
continue or No to cancel the operation.

To outdent an item:

 1.  Select the task or collapsed summary task.

 2.  Click the Outdent icon.

The selected task or summary task moves out one level in the hierarchy.
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 o Acting on a summary task acts on its children. Outdenting a summary task brings its children 
one level up in the hierarchy as well.

 o If the selected item was a child of a summary task, it becomes either a task or summary task 
on the same level as its former parent.

 o If the selected item was a summary task's only child, that summary task is converted into a 
task.

 o If the selected item was a task with other tasks of the same level beneath it, those tasks are 
converted to children of the selected item, which is now a summary task.

Note:  Tasks with actuals data cannot become summary tasks. This includes tasks that contain 
actuals from Time Management, or tasks that are referenced by time sheets.

If a task is converted to a summary task or leaf task, a warning message displays and you must 
select Yes to continue or No to cancel the operation.

You can act on multiple tasks simultaneously:

 l Use Shift + click to highlight a set of contiguous rows and act on all of them.

 l Use Ctrl + click to make multiple non-contiguous selections and act on all of them.

Setting Up Predecessors

Project Management allows you to create relationships between a task and other tasks in the current 
work plan, tasks in other work plans, or requests in Demand Management. These predecessor 
relationships are used by the scheduler to determine when the task will be scheduled.

For example: Manager Bob has a Training work plan for a new software module being installed on his 
group's computers. In order for his training activities to get started, the Software Upgrade project 
headed by Manager Steve must be finished first. Bob can create a finish-start predecessor relationship 
between the most relevant task in the Software Upgrade project and his own Training tasks.

These predecessor relationships are controlled from the Schedule tab of the Task Details page.
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Figure 5-3. Task Details page: Schedule tab

The types of predecessor relationships available are described in "Table 5-1. Possible predecessor 
relationships to a project or task" below.

A predecessor relationship for summary tasks or tasks can be configured from the Work Plan page. 
You cannot add external tasks or requests as predecessors from the Work Plan page.

Predecessor 
Type Description Possible Relationships

Summary 
Task or Task

A task in the 
current work 
plan

 l Finish-Start. The successor can start once its predecessor has 
completed.

 l Start-Finish. The successor cannot finish until the predecessor 
starts. Cannot be set for summary tasks.

 l Finish-Finish. The task can start anytime, but the successor 
will not be marked as complete until its predecessor finishes. 
Cannot be set for summary tasks.

 l Start-Start. The successor cannot start until the predecessor 
has started.

You can also define lag or lead time for predecessor relationships by 
typing a positive or negative number in the Lag (Days) field, if 
desired.

When adding a summary task as a predecessor, only relationships 
of the Finish-Start or Finish-Finish type are allowed.

Table 5-1. Possible predecessor relationships to a project or task
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Predecessor 
Type Description Possible Relationships

When adding a predecessor to a summary task, only relationships 
of the Finish-Start or Start-Start type are allowed.

External 
Task

A task from a 
separate 
project

Same as internal task.

Request A request in 
Demand 
Management

Request relationships are managed from the References tab of the 
Task Details page.

 l Related. Informational relationship only: No actual predecessor 
relationship exists. This is the only relationship allowed for 
summary tasks.

 l Successor (Blocked). No action is allowed on the request until 
the task is completed.

 l Predecessor (Blocking). No action is allowed on the task until 
the request is completed.

 l FF Predecessor (Finish Finish Predecessor). The task can 
start anytime, but cannot be marked as finished until the request 
is completed.

Table 5-1. Possible predecessor relationships to a project or task, continued

Setting an Internal Predecessor Task from the Task Details 

Page

To set an internal predecessor task for a task from the Task Details page:

 1.  Open the Task Details page of the task.

 2.  Click the Schedule tab.

 3.  Click Add a predecessor and select Add task by name.

An auto-complete window opens listing all tasks in alphabetical order. You can filter the list using 
the Task starts with filter field.

You can also add a predecessor directly by sequence number, if you know the predecessor's 
sequence number in the work plan.

 4.  Select a task.

The predecessor task is listed on the Schedule tab of the Task Details page.
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 5.  Select a relationship from the Relationship field.

 6.  Type a value in the Lag (Days) field, if desired.

This field allows you to specify a number of days to delay starting on a given task based on its 
predecessor's finish. Negative numbers can be used, which work as lead time.

 7.  Click Save.

Setting an Internal Predecessor Task from the Work Plan Page

To set an internal predecessor task for a task from the Work Plan page:

 1.  Open the Work Plan page of the task.

 2.  Select the task.

 3.  In the Predecessor field, type the sequence number of any task in the current work plan.

 4.  Click Save.

By default, the predecessor relationship is Finish-Start and the Lag is 0 (zero). You can change 
these settings from the Task Details page.

Setting an External Predecessor Task

To set an external predecessor task for a task:

 1.  Open the Task Details page of the task.

 2.  Click the Schedule tab.

 3.  Click Add a predecessor and select Add External Task.

An auto-complete window opens, allowing you to search for external tasks to add. You can filter 
the list using the Task starts with filter field.

 4.  Select a task.

The predecessor task is now listed on the Schedule tab of the Task Details page.

 5.  Select a relationship from the Relationship field.

 6.  Type a value in the Lag (Days) field, if desired.
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This field allows you to specify a number of days to delay starting on a given task based on its 
predecessor's finish.

 7.  Click Save.

Setting a Request as a Predecessor

You can add an existing request as a predecessor for a task through the References tab of the Task 
Details page. See "Adding Existing Requests" on page 135 for more detailed information. You can also 
add a new request as a predecessor for a task. See "Adding New Requests" on page 136 for more 
detailed information.

Useful Keyboard Shortcuts in the Work Plan Views

Tasks and summary tasks within the work plan views can be manipulated from the keyboard as well as 
the icons in the views. "Table 5-2. Keyboard shortcuts for defining work plans" below lists all available 
keyboard shortcuts.

Keystroke Action

Shift + Alt + Left Arrow Outdents a task in the hierarchy.

Shift + Alt + Right Arrow Indents a task in the hierarchy.

Enter Opens the Task Details page.

Shift + Ctrl + C Copies the selected task.

Shift + Ctrl + V Pastes a task or tasks.

Table 5-2. Keyboard shortcuts for defining work plans

Work Plan Statuses
To display the different stages in a work plan's life from planning to completion, a work plan can have 
various statuses associated with it. These statuses are In Planning, On Hold, Active, Complete 
and Cancelled. Project managers can move work plans into different statuses to facilitate the work 
associated with that stage of the project. "Table 7-1. Work plan statuses and descriptions" on the next 
page describes the various work plan statuses, their behaviors, and applications.
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Work Plan Status Behavior Application

In Planning Work plans and their tasks are not 
shown in the My Tasks portlet or the 
PPM Dashboard.

Notifications are not sent and 
exceptions are not triggered.

All work plans start in this status.

This status allows a project 
manager to develop and manipulate 
the work plan without having to 
notify participants or stakeholders.

Active Work plans and their tasks can be seen 
in My Tasks and in the PPM 
Dashboard.

Notifications are sent and exceptions 
are triggered.

Work plan structure can change.

This is the status of a work plan that 
is ready to be executed and is being 
actively managed.

On Hold Notifications are not sent and 
exceptions are not triggered.

Hierarchy can be modified.

This status is used when a portion of 
an active plan needs to be withheld 
from execution, perhaps because it 
needs replanning or because work is 
being temporarily suspended while a 
review takes place. It is possible to 
put an entire work plan in this status.

Complete Work plans and their tasks can be seen 
in the PPM Dashboard but not in My 
Tasks.

Notifications are not sent and 
exceptions are not triggered.

This is the status of a work plan that 
has been worked to completion. 
Tasks cannot be added to a section 
that is completed.

Cancelled Work plans and their tasks can be seen 
in the PPM Dashboard but not in the My 
Tasks portlet.

Notifications are not sent and 
exceptions are not triggered.

This status is used to indicate that 
the deliverables in this section of a 
work plan will not be completed, and 
are no longer required to be 
completed in order for the project to 
finish.

Table 7-1. Work plan statuses and descriptions

Project Management also features a set of task statuses. For a list of task statuses, see "Task 
Elements" on page 120.
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Changing Statuses

Project managers can change statuses for the entire work plan, summary tasks, or tasks at any time. 
Summary task owners can change statuses for summary tasks or tasks at any time from the Task 
Details page for tasks they own.

Note:  A work plan in the status Complete or Cancelled cannot be edited. The project must be re-
opened in order for the work plan to be edited.

To change the status of the project:

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 3.  Click the row at the top of the hierarchy and select Edit > Task Details.

The Task Details page opens.

 4.  Select a new Status in the Statistics section of the page.

 5.  Click Save.

To change the status of a task or summary task:

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 3.  Click the task or summary task whose status you want to change and select Edit > Task Details.

The Task Details page opens.

 4.  Select a new Status in the Statistics section of the page.

 5.  Click Save.
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Creating Milestones
Milestones are used to mark significant events in the execution of a project, often the completion of a 
deliverable or arrival of a deadline. 

As markers of other progress, milestones generally do not have duration or effort, although they can be 
configured to have both. Project managers can indicate that the milestone should automatically 
complete once its predecessors are complete, providing a means of reporting project progress without 
project manager intervention. In some cases, however, project managers may want control over 
whether the milestone has completed, regardless of whether the work leading up to it indicates it should 
be.

A work plan may contain many milestones that help the project manager gauge execution progress. 
Often, however, there is a smaller set of standard milestones that are used and reported on all projects 
within an organization, such as phase-completion milestones. If the project has been configured to 
allow them, the project manager can identify such milestones as major milestones which will be 
displayed on the Project Overview page, allowing for uniform high-level visibility while still allowing the 
project manager to define as many milestones as required to manage the detailed plan. See "Project 
Fields" on page 31 for information about enabling major milestones.

To create a milestone:

 1.  Select a task.

 2.  Double-click the task.

The Task Details page opens.

 3.  Select the Mark task as milestone checkbox.

If you want the milestone to mark itself as complete automatically when all predecessors are 
complete, select the Milestone automatically completes checkbox. When all predecessors are 
complete, the actual start and finish dates of the milestone are automatically set to the last 
predecessor's actual finish date. That is, if the predecessors finish on different dates, the 
predecessor actual finish date of the predecessor that finished last is used.

The Milestone automatically completes checkbox is only available for milestones whose 
duration is 0.

 4.  Modify any other information under each tab on the Task Details page as desired (for details, see 
"Editing Task Information" on page 123).

 5.  Click Save.
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Note:  When you set a task as a milestone, the schedule duration and schedule effort change to 0. 
After the Cost Rollup Service is run, the planned labor cost becomes 0, however, the EVM data 
still keep the old values.

A task will be automatically converted to a milestone if its duration is 0.

Once a milestone has been created, its duration is automatically set to 0, but you can alter its 
duration if necessary.

Scheduling the Work Plan
Project Management generates schedules for work plans, based on the configurations set in the 
project's Scheduling policy and the options provided in the Schedule Work Plan dialog box.

Generating the Schedule

When the work plan is scheduled, the entire work plan is considered, and changes are immediately 
saved. If you want to reschedule discrete sections of the work plan, you can place constraints on the 
relevant summary tasks to accomplish the move. See "Setting Scheduling Constraints" on page 128 
for more information about constraints.

To generate the schedule for a work plan:

 1.  Click the Schedule Work Plan icon   .

The Schedule Work Plan dialog box opens.
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 2.  In Schedule from date, specify a date from which to schedule the work plan.

This is usually set in the Scheduling policy individually for each project and generally does not 
change unless the entire project needs to shift dates. If you are collecting actuals in your work 
plan, changing the Schedule from date field and rescheduling the work plan can push remaining 
work into the future.

 3.  If desired, type a Critical Path Threshold.

For more details on the purpose of the critical path threshold, see "Critical Path Threshold" on 
page 39.

 4.  Click Schedule.

Note:  If scheduling errors occur, no schedule will be generated and a list of errors will appear. 
Take note of each error and its cause, and make the necessary adjustments within the work plan. 
See "Scheduling Errors" on the next page for more details.

If scheduling warnings occur, a schedule will be generated and a list of warnings will appear. Take 
note of each warning, as they can be important to the initiative's success. See "Scheduling 
Warnings" on page 97 for more details.
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Scheduling a Summary Task

When the summary task is scheduled, the summary task and its subtasks are considered, and 
changes are immediately saved. 

To generate the schedule for a summary task:

 1.  Click the Schedule Summary Task icon.

The Schedule Summary Task dialog box opens.

 2.  In Schedule from date, specify a date from which to schedule the summary task.

 3.  If desired, type a Critical Path Threshold.

For more details on the purpose of the critical path threshold, see "Critical Path Threshold" on 
page 39.

 4.  Click Schedule.

Note:  If scheduling errors occur, no schedule will be generated and a list of errors will appear. 
Take note of each error and its cause, and make the necessary adjustments within the work plan. 
See "Scheduling Errors" below for more details.

If scheduling warnings occur, a schedule will be generated and a list of warnings will appear. Take 
note of each warning, as they can be important to the initiative's success. See "Scheduling 
Warnings" on the next page for more details.

Scheduling Errors

It is possible for certain combinations of input to cause a schedule to be unworkable. If any of these 
errors are encountered, the schedule will not be created. "Table 5-3. Scheduling errors, causes, and 
possible solutions" below describes scheduling errors, their causes, and possible solutions.

Scheduling 
Error Cause Possible Solution

Circular 
dependency

The predecessors of a set of projects or tasks 
contains a cycle. This cannot be scheduled.

Break the cycle by removing 
or changing a predecessor. 

Table 5-3. Scheduling errors, causes, and possible solutions

Project Management User’s Guide
Chapter 5: Creating andManaging aWork Plan

HPE Project and Portfolio Management Center (9.40) Page 96 of 292



Scheduling 
Error Cause Possible Solution

Project Management detects circular 
dependencies while creating or editing the work 
plan.

No tasks to be 
scheduled

The work plan is complete or cancelled, so there 
are no tasks to be scheduled.

If tasks are missing, add them 
and then schedule.

Table 5-3. Scheduling errors, causes, and possible solutions, continued

Scheduling Warnings

It is possible that because of the specifics of the work plan, the scheduler cannot produce a consistent 
schedule. A schedule will be produced, but schedule warnings are generated that highlight the 
structural inconsistencies in the work plan. The Schedule Warning Rules enabled in the Schedule 
policy in the project's settings identify these problems. Warnings appear when the scheduler runs, and 
are evaluated when the work plan is saved. Warnings are also saved on the Warnings tab of each 
affected task's Task Details page, for later perusal. "Table 5-4. Scheduling warnings, causes, and 
possible solutions" below describes scheduling warnings, their causes, and possible solutions.

Scheduling 
Warning Cause Possible Solution

Project Date 
Conflicts

This warning occurs when the work 
plan dates extend beyond the 
project's Planned Start Period or 
Planned Finish Period. It also 
occurs when the constraint defined 
on the task is outside the project's 
Planned Start Period or Planned 
Finish Period.

Bring the plan within the project's dates 
by adjusting dependencies, duration, 
resources, or any combination thereof, 
and rescheduling.

In some cases, resolution may involve 
expanding project-level dates, which 
should be coordinated with the project 
financial summary and staffing profile.

Dependency 
Conflicts

These warnings occur when a 
predecessor dependency defined 
for the task could not be honored 
because other constraints or task 
information prevents it.

For example, a task may be 
expected to start on October 10th 
based on its predecessor 
relationships, but might have a 

Rework the plan to remove the conflicts.

Table 5-4. Scheduling warnings, causes, and possible solutions
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Scheduling 
Warning Cause Possible Solution

Start No Later Than constraint 
defined for October 1st. The task 
cannot meet both requirements.

Constraint 
Inheritance 
Conflicts

These warnings occur when there 
is a direct conflict between the 
constraints defined for a task and 
its parents, such that only one can 
be satisfied. Both related tasks are 
marked.

Rework the plan to remove the conflicts.

If both constraints are valid, you may 
need to file a project issue. See "Logging 
Issues" on page 156 for more 
information.

Resources Could 
Not Be Scheduled

The scheduler could not identify 
sufficient available working days 
for the assigned resources to 
schedule the task. This warning is 
evaluated only when the scheduler 
runs.

This usually occurs when the scheduler 
attempts to schedule a resource after the 
resource's end date or before the 
resource's start date. Check resource 
information, and if necessary, change 
the task resource or change task 
dependencies so that it can occur during 
the right dates.

Task Constraint 
Could Not Be Met

This warning occurs when the 
constraint defined on the task could 
not be honored because other 
conflicting information takes 
precedence.

This usually occurs when using actuals 
during scheduling and the task's actual 
start date conflicts with a constraint 
defined for the task. This may not require 
explicit resolution.

Table 5-4. Scheduling warnings, causes, and possible solutions, continued

Displaying Work Plan Information
Project Management includes several different ways to view work plan data, allowing you to focus on 
the specific task at hand.

 l "Level Expand/Collapse" on the next page allows you to immediately expand or collapse the work 
plan view to a specific hierarchy level, so you can quickly assess the plan without being overloaded 
with plan details.

 l "Work Plan Views" on the next page provide you with different ways of looking at the work plan 
based on the tasks you need to perform or the information you need from the plan.

 l "Filters" on page 108 allow you to filter data within a particular work plan view for a subset of 
information, enabling you to efficiently focus on the tasks that need your attention.
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 l The "Gantt View" on page 106 allows you to visualize tasks and their dependencies in a graphical 
format enhanced with color-coding and configurable labeling.

In general, Project Management keeps track of column width and position in each work plan view for 
you, so when you log out and return to a project later, your layout and position is the same as when you 
left it.

Level Expand/Collapse

Click Expand to: Level in Schedule view to expand or collapse your view of the work plan and its 
summary tasks to a specific hierarchy level from 2 to 7.

 l Level 2 displays only tasks and summary tasks directly below the root level of the work plan, 
collapsing everything below.

 l Level 7 displays tasks and summary tasks down to the seventh hierarchy level of the work plan, 
collapsing everything below.

Work Plan Views

Project Management includes several work plan views that give visibility into different categories of 
work plan information. These views are accessible from the View drop-down list at the top of the Work 
Plan page.

Project Management keeps track of work plan view in each work plan for you. If you open the work plan 
for the first time, it is opened in the Quick view. If you log out and return to the work plan later, it is 
opened in the view as when you left it.

Quick View

The Quick view is the default view on the Work Plan page. This view  provides you with a quick access 
to the combination of the following information:

 l Schedule-related information, such as Scheduled Start, Scheduled Finish, and Scheduled Duration

 l Information about the progress of the work plan, such as Actual Start, Actual Finish, and Percent 
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Complete

 l Gantt chart, a graphic display of schedule-related information, including task length and timing

Note:  All values for fields that track duration are in days, while all values for fields that track effort 
are in hours.

The Quick view displays the following task fields as columns:

 l Status

 l Scheduled Start

 l Scheduled Finish

 l Scheduled Duration

 l Scheduled Effort

 l Actual Start

 l Actual Finish

 l Percent Complete

 l Predecessors

 l Resources

 l Role

Note:  The Edit drop-down list and the Actions drop-down list are not available in the Quick view, 
therefore, if you want to perform actions through either of the two lists, you may have to switch to 
other work plan views.
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Viewing and Configuring Gantt Chart

You can view the Gantt chart of a work plan in both the Quick view and the Gantt view.

Clicking the left arrow on the right border of a work plan in the Quick view expands the Gantt chart. The 
horizontal bar in the gantt chart automatically moves to where the scheduled start date of the root task 
is located in the time scale.

Clicking the   icon to view the Gantt legend of a wok plan. The table below provides detailed 

information about items included in the Gantt legend.

Legend Item Description

Status of the task is ready.

Status of the task is in progress.

Status of the task is complete.

Status of the task is pending predecessor.

Status of the task is cancelled.

The task is on the critical path of a work plan.

The task is marked as a mile stone.

The task is a summary task. Its color indicates the schedule 
health of the task.
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In the Quick view, you can change the scheduled start date and scheduled finish date of a task by 
dragging the legend item. 

To do so,

 1.  Select the task in the work plan.

 2.  If you want to change the scheduled start date, put the cursor on the left side of the item, and drag 
it to your desired date.

If you want to change the scheduled finish date, put the cursor on the right side of the item, and 
drag it to your desired date.

 3.  Click Save.

The scheduled start dates and finish dates of the root task (and the summary task if any) are 
updated accordingly.

Schedule View

Use the Schedule view to adjust task hierarchy in the work plan view schedule-related information.

The Schedule view displays the following task fields as columns:

 l Task Status

 l Scheduled Duration

 l Scheduled Start

 l Scheduled Finish

 l Scheduled Effort

 l Predecessors

 l Resources

 l Role

 l Activity

 l Unassigned Effort
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Actuals View

The Actuals view focuses on information collected about the progress of the work plan, and displays 
the following task fields as columns (some columns only appear if selected in the Project Fields or Cost 
and Effort policy):

 l Task Status

 l Actual Effort

 l Percent Complete

 l Estimated Remaining Effort

 l Actual Start

 l Actual Finish

 l Actual Duration

 l Estimated Finish

 l Resources

 l Predecessors

 l Actuals As Of (date actuals were last updated)
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Figure 5-4. Work Plan page: Actuals view

Costing View

The Costing view displays the costing data for a project (the Costing view is only accessible if 
Financial Management has been enabled in the Cost and Effort policy). "Table 5-5. Available columns 
in the Costing work plan view" below describes the task fields displayed in the Costing view as 
columns. This view is only available to users who have viewing access to project cost data.

Column Name Description

Cost Health The cost health of the task.

Planned Labor The planned labor cost for the task.

Calculated as:

Scheduled effort * applicable cost rate

Applicable cost rates include:

 l Resource (if resource has no cost rate, resource region, role, and skill are 
considered next)

 l Task role

 l Task skill set

Planned Non-Labor The planned non-labor cost for the task. Manually entered.

Planned Cost The sum of planned labor and non-labor costs.

Actual Labor The actual labor cost for the task.

Calculations are the same as for planned labor, except with actual effort 
substituted for scheduled effort.

Table 5-5. Available columns in the Costing work plan view
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Column Name Description

Actual Non-Labor The actual non-labor cost for the task. Manually entered.

Actual Cost The sum of actual labor and non-labor costs.

Planned Capital 
Expense

The planned cost for a task associated with an activity marked as capitalized.

Planned Operating 
Expense

The planned cost for a task associated with an activity marked as operating.

Actual Capital 
Expense

The actual cost for a task associated with an activity marked as capitalized.

Actual Operating 
Expense

The actual cost for a task associated with an activity marked as operating.

Activity The activity associated with a task.

Table 5-5. Available columns in the Costing work plan view, continued

Figure 5-5. Work Plan page: Costing view

You can control the display of certain columns by adjusting the appropriate settings in the project's 
Cost and Effort policy. See "Adjusting Project Settings" on page 68 for details.

Earned Value View

The Earned Value view displays earned value (EV) analysis data for the project (the Earned Value 
view is only accessible if Financial Management has been enabled in the Cost and Effort policy). The 
following task fields are displayed as columns:

 l Planned Value

 l Earned Value
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 l Cost Variance

 l Schedule Variance

 l CPI

 l SPI

 l Actual Cost

This view is only available to users who have viewing access to project cost data, and is only useful if 
you have taken at least one baseline of the project. For more details on project baselines, see "Working 
with Baselines" on page 183.

Gantt View

The Gantt view includes a Gantt chart, a convenient graphic display of schedule-related information, 
including task length and timing. Summary tasks can be color-coded to indicate health. Colors and 
patterns serve to provide information on completion status. Optional task labels can provide additional 
details (see "Changing Gantt View Display" on the next page).

You can also change the time scale for the chart, as well as fit the entire project into the current Gantt 
view. "Figure 5-6. Work Plan page: Gantt view" below shows a typical project Gantt chart.

Figure 5-6. Work Plan page: Gantt view

To view the Gantt legend of a work plan, click the    icon next to the Edit drop-down list on the Work 

Plan page. The icon appears only when you select Gantt View for the View drop-down list.

To view the Gantt legend of a Project Gantt portlet, select the Show Legend checkbox in the Display 
Options section on the Edit Portlet Preferences page.

Table below provides detailed information about items included in the Gantt legend.
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Legend Item Description

Status of the task is ready.

Status of the task is in progress.

or
Status of the task is complete.

Status of the task is pending predecessor.

Status of the task is cancelled.

or 
The task is on the critical path of a work plan.

The task contains one or more exceptions.

The task is marked as a milestone.

The task is a summary task. Its color indicates the schedule health of the task. 

The pointed task has a predecessor. The arrow starts from the preceding task and 
points to the pending task. 

The pointed task has an external predecessor.

Changing Gantt View Display

You can make adjustments to the Gantt chart display by clicking Actions > Configure Gantt on the 
Work Plan page. The Configure Gantt dialog box contains settings for the Gantt chart's indicators and 
text labels.

Printing View

The Printing view provides the user with a view in which all of the fields in all the views are combined. 
The columns are arranged by view in the following order:

 l Schedule

 l Actuals

 l Cost

 l Earned Value
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Use this view to configure the order and sizing of columns for generating PDF printouts that include 
columns that cross the different views. For more information on exporting the work plan to a PDF file, 
see "Exporting to PDF Files" on page 187. For optimal system performance, use the other work plan 
views for targeted tasks.

Custom View

The Custom view provides the user with a view of fields the user has selected to display. A user can 
set and view one Custom view per work plan. The Custom view is not shared with other users. See 
"Add/Remove Columns" on page 112 for information about how to set the Custom view.

Filters

Project Management includes filters for work plan views other than the Quick view that allow you to 
filter the work plan for a certain set of tasks, enabling you to quickly focus on the data most relevant to 
your activity. Summary tasks that own the tasks selected by the filter are always displayed to provide 
context. "Table 5-6. Work plan view filters" below lists the filters for each work plan view.

Filter Name Description

Schedule and Tracking views

Tasks in progress Only shows tasks in the work plan that are in progress.

Tasks complete Only shows tasks in the work plan that are complete.

Tasks overdue Only shows tasks in the work plan that have passed their scheduled 
finish date but are not yet complete.

Tasks that are unassigned Only shows tasks in the work plan that have no resource assigned to 
them.

Tasks that are milestones Only shows tasks in the work plan that are milestones.

Tasks on the critical path Only shows tasks in the work plan that are on the critical path.

Tasks with external 
predecessors

Only shows tasks in the work plan that have external predecessors.

Tasks with contributions Only shows tasks in the work plan that have time logged against them 
in Time Management by non-assigned resources. This can help you 
identify unexpected time logged against your project.

Table 5-6. Work plan view filters
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Filter Name Description

Tasks with constraints Only shows tasks in the work plan that have constraints.

Tasks by resource Only shows tasks in the work plan that are assigned to a specified 
resource(s).

Tasks by role Only shows tasks in the work plan that are assigned to a specified 
role.

Tasks starting in Only shows tasks in the work plan scheduled to start within a 
specified date range.

Tasks completing in Only shows tasks in the work plan scheduled to complete within a 
specified date range.

Tasks occurring in Only shows tasks in the work plan scheduled to occur within a 
specified date range.

Tasks with actuals since Only shows tasks that have had actuals updated after a specified 
date.

For example, this is useful for finding tasks updated during the current 
week.

Table 5-6. Work plan view filters, continued

Filtering Mapped Tasks in Quick View

If some tasks in the work plan are mapped to Agile Manager projects or another project within PPM 
Center (waterfall projects), you can filter these tasks in the Quick view by the following instructions. 

 1.  Open the desired work plan in the Quick view.

Mapped tasks are indicated by the connector icons in front of the task names.

The tasks mapped to Agile Manager projects are indicated by the connector icon  , while the 
tasks mapped to waterfall projects are indicated by the connector icon  .

 2.  Click   .

Selecting the option Default only, all the unmapped tasks are listed.

Selecting the option  PPM only, all the tasks mapped to waterfall projects are listed.

Selecting the option  Agile Manager Connector 1.0 only, all the tasks mapped to Agile 
Manager projects using connector 1.0 are listed.
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Selecting the option  Agile Manager Connector 2.0 only, all the tasks mapped to Agile 
Manager projects using connector 2.0 are listed.

By default, all the options are selected.

 3.  Deselect the options to hide the tasks you do not want to show.

The mapped tasks you want to filter are listed in the work plan.

Editing Task Details

From the Work Plan page, certain fields can be edited and saved (see "Editing Task Details from the 
Work Plan Page" on page 123). Other fields can be edited from the Task Details page (see "Editing 
Task Information" on page 123) or updated simultaneously (see "Configuring and Editing Multiple 
Tasks Simultaneously" on page 130).

Viewing Large Work Plans

In work plan views other than the Quick view, Project Management allows you to control the number of 
tasks in your work plan that can be displayed at one time, allowing you to efficiently manage your work 
plan regardless of whether you are working on a fast local LAN or a distributed network. The set of 
tasks displayed at a time is referred to as a "page." You can navigate between pages in a large work 
plan in the following ways:

 l Click Prev and Next to navigate between adjacent pages.

 l Type the sequence number of a specific task in Seq # and click Go to navigate to that task. The 
task displays at the top of the page. This allows you to reorient the page to display the data in which 
you are interested.

 l Project Management shows you pages of displayed tasks. The collapsed children of summary 
tasks are not counted.

Note:  The Quick view displays all work plan data in a single page. It loads data as you scroll down 
the page.
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Adjusting Personal Page Size Preferences

You can adjust the number of rows per work plan page in the Project Work Plan Preferences section of 
the Edit My Profile page, accessed by selecting Open > Administration > Edit My Profile from the 
menu bar.

Select an option or type your own value for the number of tasks per page you wish to see and click 
Done. You can change this setting at any time, based on the connection speed at your location.

Note:  The preset and maximum page size values are determined by your PPM Center 
administrator. See the Project Management Configuration Guide or consult your system 
administrator for more details on work plan page size controls and their adjustment.

Resource Usage

The Resource Usage page displays assignment-level load data grouped by resource. Open the 
Resource Usage page by clicking Actions > Resource Usage on the Work Plan page. Fields on this 
page are not directly editable, though tasks can be opened and modified from this page or the Work 
Plan page. The Resource Usage page is optimized for use with the staffing profile for the project, which 
determines work plan capacity.

Note:  When the number of resources is greater than 1000 on the Resource Usage page, the 
performance is not desirable. In this case, you can use the Analyze Assignment Load portlet.

Column Name Description

(Indicator column) Indicates whether the resource has been over-allocated on any of the days 
displayed.

Name The name of the resource.

Role Indicates the role intended to be utilized.

 l The role appearing next to the resource name is specified in the project 
staffing profile, if one exists.

 l The role appearing next to the task name is specified in the work plan.

Effort (Load) The total amount of effort assigned to the resource. This column is broken 
down into sub-columns that track scheduled effort, actual effort, and the 

Table 5-7. Available columns in the Resource Usage work plan view
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Column Name Description

allocation for the resource.

Start The start date for the assigned task.

Finish The end date for the assigned task.

Status The status of the assigned task.

Table 5-7. Available columns in the Resource Usage work plan view, continued

Other features of the Resource Usage page include the following:

 l If an over-allocation has taken place, an indicator appears to the left of the resource name.

 l The Resource Usage page displays the amount of resource load coming from external sources. 
Clicking the External Load link below a resource name opens their resource load breakdown.

 l The Resource Usage page includes a table displaying the resource load details for the project, 
which highlights over-assignments in red. The table can be set to view a specific range of dates and 
broken down by different period types. To change the date range and time breakdown of the table, 
provide the desired values in the View data from and grouped by fields and click Apply.

Add/Remove Columns

The Add/Remove Columns action allows you to customize the columns displayed and their order on 
the Work Plan page. This action is enabled for the following views: Quick, Schedule, Actuals, Printing, 
and Custom.

 l "Add/Remove Columns in Quick View" below

 l "Add/Remove Columns in Other Views" on the next page

Add/Remove Columns in Quick View

 1.  Open the Work Plan page in the Quick view.

 2.  Click the   icon.

A list of available columns for the Quick view are displayed.

 3.  Select the columns that you want to add to the work plan. 
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Click the Check All checkbox to select all the columns. Click the up or down arrow to view more 
available columns.

By default, all the columns except the user data are selected. The columns are added or removed 
the moment you select or deselect them. 

 4.  Click anywhere out of the column list to close it.

Add/Remove Columns in Other Views

 1.  On the Work Plan page, click Actions > Add/Remove Columns.

The Add/Remove Columns dialog opens.

Field Description

Category Filters the column names that are displayed in the Available Columns and Selected 
Columns fields. You can show All, Schedule View, Costing View, Earned Value 
View, Actuals View, or User Data columns.

Contains Filters the column names that are displayed in the Available Columns and Selected 
Columns fields. Specify a string that each column name must contain.

Available 
Columns

The names of columns that can be displayed on the Work Plan page, but are 
currently not displayed.

Selected 
Columns

The names of the columns displayed on the Work Plan page and the order in which 
they are displayed.

Table 5-8. Field descriptions for Add/Remove Columns dialog

 2.  To add columns to the Work Plan page, move the column names to the Selected Columns field. 
Within the Selected Columns field, rearrange the column names in the order you want them 
displayed.

To remove columns from the Work Plan page, move the column names to the Available Columns 
field.

 3.  Click OK.

The Work Plan page displays the selected columns in the order shown in the Selected Columns 
field.
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Tip:  You can sort the columns in the work plan by dragging them to the desired location. To 
move a contiguous group of columns, go to the Add/Remove Columns dialog, select the 
contiguous group of columns from the Selected Columns field, then use the up/down arrows 
to position them.

Concurrent Work Plan Editing
While only project managers should be editing a work plan, a single project may have many project 
managers who are editing different parts of the work plan. Project Management allows you to edit and 
update separate parts of work plans simultaneously, allowing for more efficient representation of 
changes to a project.

Avoiding Conflicts

In general, two users cannot make edits to the same task simultaneously.

 l If two users are editing a task simultaneously, the only changes saved will be the first set. The 
second user will not be able to save any changes. This includes instances where a resource logs 
actuals for a task.

For example: Yukio is the manager for a project to which Bob is assigned.

 a.  Yukio opens a task and begins to make changes.

 b.  Bob updates the actuals for that task using the My Tasks portlet and clicks Save.

 c.  Yukio is unable to save her changes to the task.

 l An error message results if a user attempts to schedule the work plan while the work plan is being 
scheduled by another user.

It is recommended that project managers avoid making changes to the work plan during times when 
many resources will be entering actuals.

Calculating Actuals

When resources enter actuals through the My Tasks portlet or time sheets, the associated task 
information is saved, but the following calculations are deferred in order to allow resources to efficiently 
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enter and save actuals:

 l Roll-up of cost data to parent summary tasks

 l Calculation of exception

 l Calculation of health

The schedule health and Work Plan page of a project display messages indicating that outstanding 
calculations are pending. The interval at which these calculations are made is determined by scheduled 
services on the PPM Server, which can be configured by a system administrator. A parameter in the 
server.conf file makes it possible for a project manager to configure Project Management to perform 
roll-up calculations upon save. See the Project Management Configuration Guide for more detailed 
information on these scheduled services and server parameter.
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Chapter 6: Configuring Tasks
 l "Locating Tasks"

 l "Task Elements" on page 120

 l "Adding Tasks to Work Plans" on page 123

 l "Editing Task Information" on page 123

 l "Assigning Skills or Roles" on page 127

 l "Configuring Task Predecessors" on page 127

 l "Setting Scheduling Constraints" on page 128

 l "Configuring and Editing Multiple Tasks Simultaneously"

 l "Adding and Deleting References for Tasks" on page 135

 l "Associating Waterfall Projects to PPM Tasks"

 l "Changing the Task Status"

 l "Entering Cost Data" on page 147

 l "Adding Notes" on page 147

 l "Setting Up Notifications" on page 148

Locating Tasks
Project Management defines resources as users who work on tasks as part of a project team, but do 
not have the administrative responsibilities of a project manager.

Resources update their task status in Project Management. There are several different ways for 
participants to locate their tasks:

 l "Finding Tasks Using the My Tasks Portlet" on the next page

The My Tasks portlet makes users aware of the tasks they should be working on. It allows users to 
update actuals for multiple tasks at once, as well as providing links to individual task pages.

 l "Searching for Tasks and Projects" on the next page
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Resources can update notes or references for tasks by searching for the tasks directly, or by 
searching for projects in order to get to the tasks they want through the work plans that contain 
them.

 l "Finding Tasks Using Notifications" on page 119

Tasks can be reached from a notification simply by clicking on the link provided in the body of the 
email, or by copying and pasting it into any Web browser.

Finding Tasks Using the My Tasks Portlet

The My Tasks portlet is available to all users with an Project Management or Time Management 
license and the View Projects, Update Tasks, or Edit Projects access grant. This portlet is included on 
your PPM Dashboard by default. It shows a configurable list of the tasks currently assigned to the user.

Participants can update task actuals and fill in information that the project manager would like to collect 
for all tasks displayed. Task information that can be updated may differ from project to project, 
depending on the project type and whether the project is integrated with Time Management. In this way, 
the My Tasks portlet can save valuable time by providing a single point for multiple tasks to be updated 
at once. See "Using the My Tasks Portlet" on page 290 for detailed information on using the My Tasks 
portlet to update task information.

Searching for Tasks and Projects

Participants can search for tasks and projects that match certain criteria using the search box or Task 
Search and Project Search pages.

Locating Tasks

Project participants with an Project Management license and the View or Edit Projects access grant 
can search for tasks using the search box or Task Search page. Task notes and references can be 
updated in this manner.

Using the Search Box

The search box is used to locate and open tasks based on task names that begin with the specified 
text. Use the search box if you know the name of the task or want to search for one or more tasks that 
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start with a particular phrase or fragment of text in its name. The search box is located in the upper-right 
corner. 

To locate and open a task using the search box:

 1.  Log on to PPM Center.

 2.  In the search box, located on the right side of the menu bar, type @ followed by the text for which 
to search at the beginning of the task name. When you start typing the text, a submenu appears 
(the search is not case-sensitive).

 3.  Once you have finished typing your search text, select Search for tasks: <search_text>.

If the search text matches only one task name, the Task page for that task opens.

If the search text matches more than one task name, the Task Search page opens, displaying a 
list of tasks with matching names. Click the name of a task to open its Task page.

Using the Task Search Page

The Task Search page is used to locate and open tasks based on the search criteria you select. Use 
the Task Search page if you want to search for a task based on criteria such as resource, finished 
tasks, task status, scheduled start date, scheduled finish date, tasks with exceptions, milestones, 
project name, or project manager.

To locate tasks in Project Management using the Task Search page:

 1.  Log on to PPM Center.

 2.  From the menu bar, select Search > Tasks. The Task Search page opens.

 3.  Provide the search criteria for the desired task.

You can search for an existing task based on any of the fields located on the Task Search page. 
Limiting the maximum number of results in the Results Displayed Per Page field can yield 
quicker results.

 4.  Click Search.
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The Task Search page reloads, displaying the results matching your search criteria.

 5.  Click on the name of any task in the list to view its Task page. 

Locating Projects

While resources can locate and view projects, only participants with the Edit Projects access grant can 
edit tasks in the work plan. Participants can locate projects using the search box or Project Search 
page. See "Searching for Projects" on page 72 for more information.

Finding Tasks Using Notifications

Email notifications can be configured by project managers to include hyperlinks to tasks in Project 
Management. If you have received an email containing a link to a task, click on it, and it will open to that 
task's Details page in your Web browser. If your email client doesn't handle HTML links directly, copy 
and paste it into your Web browser.
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Task Elements
Work plans are repositories of information consisting of tasks, summary tasks, notes, and references. 
These elements model the work required to achieve specific business initiatives within an organization. 
Work plans are not static entities. They gather additional information and are modified as their tasks 
move through to completion. 

Tasks are the components of a work plan that must be completed in order for the work plan to complete 
successfully. Project managers gather information from tasks and make appropriate changes to the 
project during the project process. This means that tasks must be configured to deliver the kinds of 
specific information that project managers need. For example, project managers may need to be 
notified when tasks are completed or their statuses change.

Tasks also need to be modified during the project execution, such as extending task schedules or 
assigning additional resources to a task to make a deadline. Team members must update their 
individual statuses as they complete assigned tasks. 

Contributions

Non-assigned resources who log time against a task will be considered contributors of the task. 

 l Contributors of summary tasks are listed in the Contributions tab of the task details page. And this 
tab is available for summary tasks only.

 l Contributors of leaf tasks are listed in the Resources tab of the task details page.

 l Contributors of leaf tasks are not rolled up to the summary tasks.

Notifications

Project managers can set up notifications for tasks within a work plan. Project managers and summary 
task owners can edit these notifications from the Task Details page. Email messages can be sent to 
appropriate team members whenever a specific event occurs on a task. This would include such 
events as:
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 l The completion of a milestone.

 l The triggering of an exception rule by a task.

 l The approach of a task's start date.

References

Tasks can include additional references to other entities or points of information, allowing easy access 
and visibility to data related to the current task. Summary information for references is viewed as part of 
the task. 

There are several reference types defined for tasks: requests, packages, projects, releases, 
attachments, and URLs.

Project managers and summary task owners can edit references from the Task Details page.

Activities

Tasks can be characterized by the type of activity involved in accomplishing the task. For example, 
certain tasks could be categorized as design activity, while other tasks could be characterized as 
testing activity. Though they can be used for simple categorization, activities are usually used to 
identify capitalizable costs for SOP 98-1 compliance. For more information on activities and their use, 
see the Financial Management User’s Guide.

Task Statuses

On the Work Plan page, the task status is displayed in the Status column of the Schedule view. The 
available statuses for a task are defined in "Table 6-1. Task status definitions" below. "Table 6-2. 
Summary task status definitions" on the next page describes statuses for summary tasks.

Task Status Definition

Pending Predecessor A task that is holding for one or more predecessors to be completed.

Ready A task that is ready to be worked on by its resource.

Table 6-1. Task status definitions
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Task Status Definition

In Progress  A task that is moving through the actions necessary for its completion.

Completed A task that has been finished.

Cancelled A task that is not complete and will not be worked on, as it is no longer 
required for the completion of the project.

Complete (Pending 
Predecessor)

A task that has been finished but requires its predecessor to be complete 
before being truly done.

Pending Request A task that is holding for one or more request predecessors to be completed.

Complete (Pending 
Request)

A task that has been finished but requires one or more request predecessors 
to be completed.

Table 6-1. Task status definitions, continued

Task 
Status Definition

In 
Planning

This section of the work plan is still being developed and is not ready to execute.

Active This section of the plan is available to execute. Resources cannot report actuals 
against a work plan until it becomes Active.

On Hold This section of the plan has been put on hold. This may be because re-planning was 
needed, a future phase is still being planned, or work has been temporarily suspended.

Completed This section of the plan has completed execution. All of the tasks in this section are 
either completed or cancelled.

Cancelled This section of the plan has been cancelled and will never complete. All of the tasks in 
this section are cancelled.

Table 6-2. Summary task status definitions

Note:  Depending on their defined level of responsibility in a project, users may only change tasks 
between certain statuses. 

For example, project managers can change a task from Ready to In Progress to Cancelled, or 
from Cancelled back to Ready. Project participants cannot change the task status directly unless 
they are the summary task owner of the task. The task status is derived based on the actuals 
reported by resources.

Available task statuses can also depend on the status of the work plan.
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Adding Tasks to Work Plans
Tasks can be added to a work plan individually, in a pre-sequenced group, as defined in a work plan 
template, or imported from an existing work plan (see "Importing a Work Plan" on page 83 for more 
information). 

Tasks can also be quickly and easily organized in a hierarchical fashion. See "Adding Tasks and 
Creating a Work Plan Hierarchy" on page 80 for more information. 

Editing Task Information
Task information is edited on the Work Plan Page  or on the Task Details page, which can be reached 
from the Work Plan page or the Resource Usage page. 

 l  "Editing Task Details from the Work Plan Page" below

 l  "Editing Task Information from the Task Details Page" on page 126

Editing Task Details from the Work Plan Page

From the Work Plan page, certain fields can be edited and saved simultaneously for any set of tasks:

 l Name. Required names imported from a work plan template are not editable.

 l Scheduled Duration, Scheduled Start, Scheduled Finish. These fields are not editable in a 
summary or root task. Two of the three fields are editable while the third field is automatically 
calculated (from the two editable fields). To select which fields are editable, click Change at the top 
of the work plan. If the Scheduled Duration is set to zero, the task automatically becomes a 
milestone.

Note:  If you want to update a summary task's Scheduled Duration, Start, or Finish, you must 
update its individual tasks' values.

 l Scheduled Effort. This field is not editable in a summary or root task. This field is editable if it is set 
in the project's Cost and Effort policy (See "Scheduled Effort in the Work Plan" on page 45) or on 
the task's Task Details page (see "Associating Waterfall Projects to PPM Tasks" on page 141) to 
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be manually entered.

Note:  If you want to update a summary task's Scheduled Effort, you must update its individual 
tasks' values.

Scheduled effort that is manually entered is distributed evenly among resources assigned to 
the task.

 l Resources. This field is not editable in a root task. For a summary or root task, this field identifies 
the owner of the task.

 l Activity. This field is editable if it is enabled on the project. If set at the summary task level, this 
field is inherited by all child tasks that do not have an activity set.

 l Predecessors. External tasks cannot be added or edited from this page. However, external tasks 
added from the Task Details page are displayed and can be deleted. Requests are displayed but 
cannot be added, edited, or deleted from this page.

 l Role. This field is not editable in a summary or root task. This field is editable if it is enabled on the 
project. If a task has no role or assigned resources, when a resource is assigned to the task, the 
role defaults to the primary role of the assigned resource.

 l User Data. User data is the set of custom fields that can be defined for various Project 
Management entities. This field is editable if the validation component type of the user data is a text 
field, drop-down list, auto-complete list, or date field. Required user data is enforced when the Task 
Details page is opened or if the user data field is displayed in the work plan and a task is updated 
from the work plan. Security groups and field-level security configured for task user data is 
enforced. 

Note:  If a default value is set for a user data field, the default value may not appear on the 
Work Plan page until a task is saved. Even though you cannot see the default value, the value 
has been set.

Required user data is enforced when the user data field is selected on the Work Plan page. 
Field-level security configured for task user data is not enforced.

Some task fields are not editable on the Work Plan page (such as status, actuals, unassigned effort, 
and percent complete). Instead, these task fields are edited from the Task Details page. For more 
details on editing tasks using the Task Detail page, including navigating between tasks, see "Editing 
Task Information" on the previous page. Also, multiple tasks can be updated simultaneously. See 
"Configuring and Editing Multiple Tasks Simultaneously" on page 130 for more information.

To edit a task field from the Work Plan page:
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 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 3.  Select a task. Values that are editable appear in a text box in which you can enter data. The field 
may also contain an icon used to select specific data. Modify the data in the text box or click the 
icon to modify the data.

Note:  If an editable task field is required, you must enter a value in the field before you can 
modify additional tasks.

If there are a large amount of tasks on the Work Plan page, you can search for a task by keyword 
in the Quick view to quickly locate it.

To do so,

 a.  Type the keyword in the text field of the Name column.

 b.  The tasks whose names includes the keyword are filtered out.

Note:  

 l The search is case insensitive. For example, if the keyword is "a", the tasks whose 
names include "a" and "A" are all filtered out.

 l Space counts as a part of the keyword, instead of the string separator.

 l If the task you are searching for is a leaf task, besides the leaf task, the tasks in the 
hierarchy leading up to the root task are also displayed.

 4.  Follow the following according to your work plan views:

 a.  If the work plan is in the Quick View,

 l Click Save to save all your changes. Click Discard to cancel all your changes.

 l To save changes to only some tasks:

 i.  Click the red icon with a number in the upper right corner of the page.

A dialog box opens listing the tasks you edited.

 ii.  Select the tasks whose changes you want to discard, and then click Discard.

The dialog box closes.

 iii.  Click Save.
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The changes to the unselected tasks are saved. The changes to the selected tasks are 
discarded. 

 b.  If the work plan is not in the Quick View,

Click Save to save your changes and remain on the Work Plan page. Click Done to save your 
changes and return to the page from which you launched the work plan. Click Cancel to 
cancel your changes made on the Work Plan page and return to the Project Overview page.

Note:  Changes made to task details outside of the Work Plan page (for example, if you 
change the status of a task by selecting Edit > Set Status or you change the activity from the 
Task Details page) are saved and cancelled independently of the Work Plan page. That is, if 
you change the activity from the Task Details page, this change is already saved and cannot 
be cancelled from the Work Plan page.

Editing Task Information from the Task Details Page

 1.  Open the Work Plan page for the project you are editing.

 2.  Click the task to be edited and select Edit > Task Details.

The Task Details page opens.

 3.  Make whatever changes are necessary on the Task Details page.

 4.  Click Save.

Click     and     on the Task Details page to navigate from task to task, as they are displayed on the 

Work Plan page.

 l Task-to-task navigation takes into account the expand/collapse state of the Work Plan page. If a 

summary task is collapsed on the Work Plan page, clicking     will not navigate through the 

summary task's children.

 l Task-to-task navigation also takes into account any filters that have been applied to the Work Plan 

page. If a filter has been applied to the Work Plan page, clicking     navigates to the next task in 

the filtered set.

Summary tasks may be shown on the Work Plan page in grey italics to provide context to a filtered 
set. 
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Assigning Skills or Roles
When creating a work plan, you can assign a skill set or role to any task without specifying a resource. 
This allows you to create a work plan that identifies the roles or skills needed to complete its tasks 
without necessarily pinpointing the specific resources that will ultimately do the work. Additionally, 
capturing roles or skills required to complete tasks provides a more detailed estimate of the project 
cost; this helps make sure the forecasted cost is correct and the right resources are allocated.

To assign a role to an existing task:

 1.  Click the task to be assigned and select Edit > Task Details.

The Task Details page opens.

 2.  Click the Resources tab.

 3.  Select an Assigned Role for the task.

 4.  Click Save.

Note:  If you assign a resource to a task, the Assigned Role field will automatically populate with 
the resource's primary role, if one has been defined.

To assign a skill to an existing task:

 1.  Click the task to be assigned and select Edit > Task Details.

The Task Details page opens.

 2.  Click the Resources tab.

 3.  Click Add Skill to select a skill.

 4.  When the skill is added, select a proficiency from the Ideally column.

 5.  Click Save.

Configuring Task Predecessors
Task predecessors can be configured from the Work Plan or Task Details page. A predecessor is a 
task that has a defined relationship between its start or finish date, and the start or finish dates of the 
task that is dependent on it.
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 l See "Setting Up Predecessors" on page 86 for more detailed information on setting task 
predecessors.

 l Although tasks can only have predecessor relationships to other tasks, a task may have references 
defined that identify relationships to other entities (for example, an informational reference to a 
package used to roll out code developed as part of a task's completion). See "Adding and Deleting 
References for Tasks" on page 135 for more information on how to assign relationships between 
tasks and references.

Setting Scheduling Constraints
In addition to its relationship with other tasks in the work plan, a task may have other date-related 
constraints. For example, a project manager may want to specify that a task must start on a particular 
date, or finish no later than a particular date. These constraints provide valuable information about 
tasks, and are also used by Project Management to generate the work plan schedule.

Scheduling constraints are set on the Schedule tab of the Task Details page. Constraints can be 
defined for summary tasks or their children. If a constraint is defined for a summary task, it also applies 
to all of its child tasks. "Table 6-3. Scheduling constraints for tasks and summary tasks" below 
describes the constraints available for tasks and summary tasks.

Constraint Description
Summary Task 
Availability

As Soon As 
Possible

The task will be scheduled as early as the work plan 
structure and dependencies allow.

This is inferred if no constraint is defined.

Y

As Late As 
Possible

The task will be scheduled as late as the work plan structure 
and dependencies allow.

N

Start No 
Earlier Than

The task cannot start before the date specified. Y

Start No Later 
Than

The task should start on or before the date specified. N

Finish No 
Later Than

The task must finish by the date specified. Y

Must Start On The task must start on the date specified. N

Finish No  The task should not finish before the date specified. N

Table 6-3. Scheduling constraints for tasks and summary tasks
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Constraint Description
Summary Task 
Availability

Earlier Than

Must Finish 
On

The task must finish on the date specified. N

Table 6-3. Scheduling constraints for tasks and summary tasks, continued

Figure 6-2. Task Details page: Schedule tab

To set a task's scheduling constraints:

 1.  Click the task to be assigned and select Edit > Task Details.

The Task Details page opens.

 2.  Click the Schedule tab on the Task Details page.

 3.  Under Constraints, select the type of constraint you want to use from the Scheduling 
Constraint field.

 4.  Type a date in the Constraint date field.

 5.  Click Save.
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Configuring and Editing Multiple Tasks 
Simultaneously
You can select multiple tasks on the Work Plan page and perform simultaneous updates on them in the 
following ways:

 l Updating actuals for selected tasks

 l Changing resource assignments for selected tasks

 l Changing assigned roles for selected tasks

 l Shifting scheduled dates for selected tasks forward or backward

 l Linking selected tasks sequentially as predecessors

 l Setting status for selected tasks

Use either of the following methods to select multiple tasks simultaneously:

 l Use Shift + click to highlight a set of contiguous rows.

 l Use Ctrl + click to make multiple non-contiguous selections.

Note:  After a save, if more than one task has been updated and there is an error during the save, 
the task that caused the error is highlighted in the work plan.

Editing Actuals for Multiple Tasks Simultaneously

Actuals data can be edited simultaneously for any set of tasks.

Note:  If Time Management has been enabled for a project, you may not be able to provide Actual 
Effort values for resources whose actuals are expected to be provided through Time Management 
time sheets. These tasks are marked with an icon resembling a clock.

To edit actuals for a set of tasks simultaneously:

 1.  Open the project to modify.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.
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 2.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 3.  Select multiple tasks using Shift + click or Ctrl + click.

 4.  Click Edit and select Actuals.

The Enter Actuals page opens.

Note:  If the work plan is filtered by resource, the Enter Actuals page only displays the 
assignments of the filtered resource.

 5.  Make the desired updates to the set of tasks.

 6.  Click Save.

The changes are saved.

When actuals are entered into Project Management, certain calculations are deferred. See "Calculating 
Actuals" on page 114 for more details.

Editing Resource Assignments for Multiple Tasks 

Simultaneously

Resource assignments can be edited simultaneously for any set of tasks in the following ways:

 l A particular resource or set of resources can be assigned to all selected tasks.

 l A particular resource or set of resources can be removed from all selected tasks.

Resources whose assignments have actuals cannot be removed from a task.

 l A particular resource on all selected tasks can be swapped with another resource.

Assignments that have already started are not swapped. If task scheduled effort is being managed 
manually, the new resource inherits the old resource's scheduled effort.

 l Resource assignments on all selected tasks can be removed without affecting tasks that have 
already started.

Tasks with actuals are not changed.

 l All resource assignments on all selected tasks can be replaced with another resource or set of 
resources.
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Tasks with actuals are not changed. If task scheduled effort is being managed manually, the new 
resource's scheduled effort is set to zero.

To edit resource assignments for a set of tasks simultaneously:

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 3.  Select multiple tasks using Shift + click or Ctrl + click.

 4.  Click Edit and select Assignments.

The Resource Assignments dialog opens.

 5.  Make the desired changes to the resource assignments for the selected tasks.

 6.  Click OK.

The changes are saved immediately.

Editing Assigned Roles for Multiple Tasks 

Simultaneously

The assigned role can be edited simultaneously for any set of tasks. The new role takes the place of 
any previous role assignments for all the tasks in the set.

To edit assigned roles for a set of tasks simultaneously:

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 3.  Select multiple tasks using Shift + click or Ctrl + click.

 4.  Click Edit and select Set Role.

The Set Role dialog opens.
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 5.  Select the desired role for the selected tasks.

 6.  Click OK.

The changes are saved immediately.

Shifting Scheduled Dates for Multiple Tasks 

Simultaneously

You can shift the scheduled dates for any set of tasks forward or backward by any number of days. All 
of the selected tasks will shift the same number of days in the same direction.

Note:  This feature should only be used if you are not using the Project Management scheduler 
(accessed by clicking the Schedule Project icon) as described in "Scheduling the Work Plan" on 
page 94. If you have been using the scheduler, continuing to do so is the recommended method for 
scheduling your work plan.

To shift the scheduled dates for a set of tasks simultaneously:

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 3.  Select multiple tasks using Shift + click or Ctrl + click.

 4.  Click Edit and select Shift Schedule.

The Shift Task Schedule dialog opens.

 5.  Specify the number of days by which to shift the schedule and select Forward or Backward.

 6.  Click OK.

The changes are saved immediately.
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Quickly Linking Multiple Tasks as Predecessors

You can select a set of tasks and quickly link them sequentially as predecessors. The tasks will be 
assigned predecessor relationships based on their sequential order as defined by the work plan.

To change resource assignments for a set of tasks simultaneously:

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 3.  Select multiple tasks using Shift + click or Ctrl + click.

 4.  Click Edit and select Link Tasks.

The Link Tasks dialog opens.

 5.  Click Link Tasks.

The changes are saved immediately.

Setting Status for Multiple Tasks Simultaneously

Task status can be edited simultaneously for any set of tasks.

To change resource assignments for a set of tasks simultaneously:

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 3.  Select multiple tasks using Shift + click or Ctrl + click.

 4.  Click Edit and select Set Status.

The Set Status dialog opens.

Project Management User’s Guide
Chapter 6: Configuring Tasks

HPE Project and Portfolio Management Center (9.40) Page 134 of 292



 5.  Select the desired status for the selected tasks.

 6.  Click Change Status.

The changes are saved immediately.

Adding and Deleting References for Tasks
Project Management features a number of methods for capturing additional information, or references, 
related to your projects. References are added from the References tab of the Task Details page.

Figure 6-5. Task Details page: References tab

To add references to a task:

 1.  Click the task and select Edit > Task Details.

The Task Details page opens.

 2.  Click the References tab.

 3.  Add the reference.

 4.  Click Save.

Adding Existing Requests

To add an existing request to a task:
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 1.  Click the task to be assigned and select Edit > Task Details.

The Task Details page opens.

 2.  Click the References tab.

 3.  Select Request (Existing) from the New Reference field.

 4.  Click Add.

The Add Reference: Request window opens.

 5.  Search for the request you want to add to the task.

 6.  Select the checkbox next to the desired request, the desired relationship to the request, and click 
Add.

See "Setting Up Predecessors" on page 86 for more detailed information on predecessor 
relationships between requests and tasks.

You return to the References tab on the Task Details page. The new added request displays as a 
reference.

 7.  Click Save.

Adding New Requests

A new request can be created from the References tab and immediately added to a task. This saves 
time from having to create a new request in Demand Management, searching for it, and adding it to the 
task.

To add a new request to a task:

 1.  Click the task to be assigned and select Edit > Task Details.

The Task Details page opens.

 2.  Click the References tab.

 3.  Select Request (New) from the New Reference field.

 4.  Click Add.

The Create New Request window opens.

 5.  Select the desired relationship to the new request.
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See "Setting Up Predecessors" on page 86 for more detailed information on predecessor 
relationships between requests and tasks.

 6.  Select a request type from the Request Type field.

 7.  Click Create.

The standard interface opens with the request type loaded.

 8.  Provide any necessary information in the request's fields.

 9.  Click Submit.

The request is submitted. You return to the References tab on the Task Details page. The new 
added request displays as a reference.

 10.  Click Save.

Adding Existing Packages

To add a package to a task:

 1.  Click the task to be assigned and select Edit > Task Details.

The Task Details page opens.

 2.  Click the References tab.

 3.  Select Package from the New Reference field.

 4.  Click Add.

The Add Reference: Package window opens.

 5.  Search for the package you want to add to the task.

 6.  Select the checkbox next to the desired package and click Add.

You return to the References tab on the Task Details page. The new added package displays as a 
reference.

 7.  Click Save.

Project Management User’s Guide
Chapter 6: Configuring Tasks

HPE Project and Portfolio Management Center (9.40) Page 137 of 292



Adding New Packages

A new package can be created from the References tab and immediately added to a task. This saves 
time from having to create a new package in Deployment Management, searching for it, and adding it to 
the task.

To add a new package to a task:

 1.  Open the Task Details page.

 2.  Click the References tab.

 3.  Select Package (New) from the New Reference field.

 4.  Click Add.

The Create New Package window opens.

 5.  Click Create.

The Package window opens.

 6.  Provide any necessary information in the package's fields.

 7.  Click Save.

The package is submitted. You return to the References tab on the Task Details page. The new 
added package displays as a reference.

 8.  Click Save.

Adding Tasks

To add a task to a task:

 1.  Click the task to be assigned and select Edit > Task Details.

The Task Details page opens.

 2.  Click the References tab.

 3.  Select Task from the New Reference field.

 4.  Click Add.
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The Search Tasks window opens.

 5.  Search for the task you want to add to the task.

 6.  Select the checkbox next to the desired task and click Add.

You return to the References tab on the Task Details page. The new added task displays as a 
reference.

 7.  Click Save.

Adding Releases

To add a release to a task:

 1.  Click the task to be assigned and select Edit > Task Details.

The Task Details page opens.

 2.  Click the References tab.

 3.  Select Release from the New Reference field.

 4.  Click Add.

The Add Reference: Release window opens.

 5.  Select a release to add.

 6.  Click Add.

You return to the References tab on the Task Details page. The new added release displays as a 
reference.

 7.  Click Save.

Adding Documents

To add a document to a task:

 1.  Click the task to be assigned and select Edit > Task Details.

The Task Details page opens.
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 2.  Click the References tab.

 3.  Select Attachment from the New Reference field.

 4.  Click Add.

The Add Document window opens.

 5.  To select a document for an attachment, click the Browse icon.

Open the drive and directory where the file you want to add is located and select it. The name of 
the document displays in the Attachment field.

 6.  Type a description in the Description field.

 7.  Click Add.

You return to the References tab on the Task Details page. The new added document displays as 
a reference.

 8.  Click Save.

Adding URLs

To add a URL to a task:

 1.  Click the task to be assigned and select Edit > Task Details.

The Task Details page opens.

 2.  Click the References tab.

 3.  Select URL from the New Reference field.

 4.  Click Add.

The Create New Reference URL window opens.

 5.  Type the name of the URL in the URL field.

 6.  Type a description in the Description field.

 7.  Click Add.

You return to the References tab on the Task Details page. The new added URL displays as a 
reference.

 8.  Click Save.
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Deleting References

If you have permission to edit the task, you can delete the task's references. 

To delete a task reference:

 1.  Navigate to the Task page and go to the References tab.

 2.  Click the Delete icon to the left of the reference.

A message will appear asking you to confirm the deletion. 

 3.  Click Yes.

The reference is removed from the task.

Associating Waterfall Projects to PPM Tasks
Waterfall projects refer to the traditional IT projects that are developed and managed with PPM using 
the waterfall methodology. Project managers can associate waterfall projects as subprojects to tasks 
of a PPM project. That is to say, project managers can manage multiple subprojects from within a 
master project.

With the integration between PPM tasks and Agile Manager available, project managers can manage 
hybrid IT projects comprised of both waterfall subprojects and agile subprojects centrally from a PPM 
project.

Starting from version 9.30, the same as the integration between PPM Center and Agile Manager, the 
association of waterfall projects to PPM Center tasks is realized by using the solution Agile Open SDK. 
For more information about this solution and its workflow, see Solution Integrations Guide.

Mapping Rules

When mapping a task to a waterfall project, make sure that the task meets the following criteria:

 l The task is a leaf task.

 l The task is neither a milestone nor a summary task.
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Note: If a task was changed from a milestone or a summary task to a leaf task, then it is 
qualified for mapping to a waterfall project. That is to say, only current status of the task 
matters.

 l The task has no actuals rolled up from PPM.

For example, if you set a task status to In Process, then it would have actual start date, so it 
cannot be mapped to any waterfall project.

 l The task is not synchronized from an integrated product.

 l The task is not mapped to any waterfall project or agile project.

 l Microsoft Project-related tasks

When a project is already integrated with Microsoft Project, the work plan should be fully controlled 
by PPM (under PPM-controlled mode) if you want to associate a task with another PPM project.

When you already set a project as a hybrid project, the work plan can only be under PPM-controlled 
mode if you want to integrate the project with Microsoft Project. The other two modes are disabled.

 l RFC tasks

If a task is already mapped to an RFC in Service Manager, it is not available for mapping to a 
project.

If a task does not satisfy the above criteria, a warning message is displayed on the Hybrid Project 
tab, indicating that the task cannot be mapped to a waterfall project as well as the reasons why it 
cannot be mapped.

Important Notes about Mapping

When mapping a task to a waterfall project, also consider the following:

 l For imported and mapped tasks, you cannot use time sheet to track their time.

Configuring Project Settings

If you want to associate a waterfall project to a task, the project to which the task belong should be set 
as a hybrid project.

To do so,
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 1.  Log on to PPM.

 2.  From the menu bar, select Search > Projects.

The Search Projects page opens.

 3.  Locate and open the desired project.

 4.  Click Settings in the upper-right corner of the Project Overview page.

 5.  Click the Hybrid Project tab in the left pane.

 6.  Select the option Set the current project as a hybrid project.

 7.  Click Done to save the setting and return back to the Project Overview page.

Important Notes about Configuring Project Settings

Note the following about setting a project as a hybrid project:

 l If you set a project as a hybrid project, and you still want use time management to track actuals 
against the project, time can only be tracked at task level.

 l If you set a project as a hybrid project, and a task in the project is mapped to a waterfall project or an 
agile project, you cannot configure the Hybrid Project policy setting for the project type of that 
project.

Only when the mapping relationships in the tasks of all the projects of a project type are deleted, 
can you configure the Hybrid Project policy setting for the project type.

Associating a Waterfall Project to a PPM Task

To associate a waterfall project as a subproject to a PPM task,

 1.  On the Project Summary tab of the Project Overview page, click Edit Work Plan in the Work Plan 
portlet.
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The Work Plan for <Project_Name> page opens.

 2.  Open the Task Details page for the desired task that you want to associate to, and go to the 
Hybrid Project tab.

 3.  Click Start Mapping.

The mapping process begins with Step 1: Select Instance.

 4.  From the Select Instance drop-down list, select Local PPM Instance.

 5.  Click Next.

The mapping process moves to Step 2: User Configuration.

 6.  From the Project drop-down list, select the waterfall project you want to associate to the task.

The drop-down list displays available waterfall projects that meet the following criteria:

 o Not the master project itself.

 o The project status is not Canceled or Completed.

 o The project is not mapped to any other task.

 o The project timeline falls between the start date and finish date of the master project where the 
task belongs.

 o The project can be viewed or edited by the current user. That is, the current user must have one 
of the following Project Management access grants:

 l Edit All Projects

 l Edit Projects

 l View All Projects

 l View Projects

 7.  (Optional) From the Work Plan Hierarchy Level to Display, select the work plan hierarchy level of 
the waterfall project to be imported to the task.

If the level is not specified, waterfall project work plan is imported to the task at the depth of level 
2.

 8.  (Optional) Select the option  Include Project Summary Task if you want the waterfall project 
summary task to be imported.

 9.  Click Next.

The mapping process moves to Step 3: Confirmation. The instance and the waterfall project to 
associated to the task are displayed for your confirmation.
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 10.  Click Submit.

The one-one mapping relationship is established, with the mapping information displayed right 
away.

And the HPE logo will be displayed in the Hybrid Project field in project header, indicating that the 
project has tasks associated with another PPM project.

Deleting a Mapping from the Task Details Page

To delete a mapping from the Hybrid Project tab of the Task Details page, 

 1.  Log on to PPM.

 2.  From the menu bar, select Search > Projects.

The Search Projects page opens.

 3.  Locate and open the desired project.

 4.  Go to the Task Details page for the desired task that you want to remove the mapping you already 
established for it, and go to the Hybrid Project tab.

 5.  Click Unlink.

A prompt dialog pops up.

 6.  Click OK.  

The mapping is removed, and the Hybrid Project tab returns to its initial state. 

You can click Start Mapping  to map the task to another waterfall project as needed.

Viewing Waterfall Project

 l "Viewing Waterfall Project Tasks from Work Plan" on the next page

 l " Viewing Waterfall Project Details from the Hybrid Project Tab" on the next page
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Viewing Waterfall Project Tasks from Work Plan

After External Work Plan Sync Service is completed, you can view waterfall project task details from 
the mater project work plan.

In the Quick view of the work plan, the tasks mapped with waterfall projects have the icon   in front 

of the task names.

You can quickly filter waterfall project-mapped tasks by clicking  . For details, see "Filtering Mapped 

Tasks in Quick View" on page 109.

Note:  Every time the External Work Plan Sync Service runs, it removes previous synchronized 
tasks and re-adds them. If a task is indented or outdented to become the leaf task of a mapped 
task, the task is deleted after synchronization. HPE recommends that you do not indent or outdent 
unmapped tasks to make them become the leaf tasks of the mapped tasks.

 Viewing Waterfall Project Details from the Hybrid 

Project Tab

To view waterfall project details from the Hybrid Project tab:

 1.  Log on to PPM.

 2.  From the menu bar, select Search > Projects.
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 3.  Provide search criteria in desired fields and click Search.

 4.  Locate your project and open it. 

 5.  On the Project Summary tab, click Edit Work Plan in the Work Plan portlet.

 6.  Locate your task and open it. 

The Task Details page displays.

 7.  Go to the Hybrid Project tab.

 8.  Click Go to Subproject.

The Project Overview page of the associated waterfall project is opened in a new window.

Changing the Task Status
A task's status can be changed from the Task Details page. See  "Task Elements" on page 120for 
detailed discussion of task statuses.

To change a task's status from its Task Details page

 1.  Click the task to be assigned and select Edit > Task Details.

The Task Details page opens.

 2.  Select the new task status from the Status field in the Statistics section of the page.

 3.  Click Save.

Entering Cost Data
If the Financial Management capability of Project Management has been enabled for this project, you 
can track and enter actual cost data on the Cost tab of the Task Details page. See the Financial 
Management User’s Guide for more detailed information.

Adding Notes
Users can type free-form text on the Notes tab of the Task Details page. Saved entries are marked 
with a timestamp.
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Figure 6-3. Task Details page: Notes tab

To add notes to a task:

 1.  Click the task to be assigned and select Edit > Task Details.

The Task Details page opens.

 2.  Click the Notes tab.

 3.  Type any notes into the Notes field.

 4.  Click Save.

On the Work Plan page, a checkmark in the Notes column indicates that a note has been added to 
the task.

Note:  The Notes tab can contain up to 32K of information per work plan. 

Setting Up Notifications
You can set up email notifications on the Task Details page to be sent to users when certain events 
occur during project execution. Notifications that are defined for a summary task apply automatically to 
all of the summary task's children, though notifications that have been defined directly for a child task 
override any notifications set by the parent. "Table 6-4. Possible email notifications for tasks" on the 
next page describes the possible notifications.
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Figure 6-4. Task Details page: Notifications tab

Notification Description

Notify resources before 
their task(s) begin

Notifies a resource before their tasks begin. You can set the number of 
days in advance of the start date from which to send the notification.

Notify resources if their 
task(s) are running late

Notifies a resource that their tasks are running late. You can specify the 
frequency with which this notification is sent.

Notify if task(s) are 
running late

Notifies a wider range of users of tasks in the work plan that are running 
late. You can specify:

 l The number of late days required to trigger the notification

 l The frequency with which the notification is sent

 l Sets of users to send the notification to

Notify when a milestone 
is reached

Notifies a set of users when the task has been reached, if it is a 
milestone. You can specify sets of users to send the notification to.

Notify when an 
exception occurs

Notifies a set of users when the task has triggered an exception. You can 
specify sets of users to send the notification to.

Table 6-4. Possible email notifications for tasks
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To set up a notification for a task:

 1.  Click the task to be assigned and select Edit > Task Details.

The Task Details page opens.

 2.  Click the Notifications tab. 

 3.  Select the checkboxes next to the appropriate notifications.

 4.  Click Save.
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Chapter 7: Viewing and Monitoring Project 
Metrics
As a project executes, project managers can view important project metrics from the Project Overview 
page, such as project health, issues, risks and milestones. These metrics help project managers to 
monitor  the project  and take corresponding actions if it is not on track.

 

Viewing the Project Health
The indicators for project health, including project overall health, issue health, schedule health, and 
cost and earned value health, are shown in the project header of the Project Overview page.

Figure 7-5. Project health indicators

For  information on how the project health is calculated and configured, see "Project Health" on page 54, 
"Issue Health" on page 56, and "Cost and Earned Value Health" on page 49.

Overriding Project Overall Health

You may wish to override the health color for any number of reasons, including:

 l Project resources have fallen behind in reporting their actuals information, causing Project 
Management to reflect an out-of-date situation.
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 l An input error by a manager on a summary task has resulted in inaccurate project health 
calculations.

You can override project overall health only when 

 1.  In the project header, click the triangle in the project overall health indicator. The Override Health 
dialog box opens.

 2.  Select the desired indicator color or choose to use the calculated color.

 3.  Type the date until which the override will last.

Note:  In order to successfully override the project health, you must type a date at least one 
day later than the current date.

 4.  If desired, provide a reason for the override in the Override Description text box.

 5.  Click Done.

Viewing Milestones
The Summary tab on the Project Overview page contains two sections that display milestones:

 l The Milestones section lists the milestones in a work plan.

If the project's Project Fields policy has been set to track major milestones, the Milestones 
section will only list major milestones. If major milestones have not been specified, all milestones 
are displayed.

Figure 7-6. Summary tab: Milestone Summary section

 l The Work Plan section shows part of the work plan's Gantt chart, including top-level tasks and 
milestones.

Milestones are visible on the Work Plan page Gantt view or Quick view as black diamonds in the Gantt 
chart.
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Figure 7-7. Work Plan page: Gantt view

Viewing Project Staffing
You can view project staffing information in the following two locations on the Project Overview page:

 l The Staffing section of the Summary tab

 l The Staffing tab

Staffing Section

The Staffing section of the Summary tab on the Project Overview page lists the staffing profiles 
associated with the project and their status.

Figure 7-9. Summary tab: Staffing section
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To open the staffing profile, click the staffing profile name. 

The pie chart shows the classification of the staffing profile positions by the position status (fulfilled and 
not fulfilled). To open the positions in a specific status, click the number link behind the status, and you 
are brought to the Staffing tab.

You can create a new staffing profile from the Staffing section by clicking Create a Blank Staffing 
Profile.

Staffing Tab

Note:  This tab is by default available unless the parameter HIDE_STAFFING_TAB_ON_ PROJECT_
PAGE is set to true.

The Staffing tab on the Project Overview page displays the staffing profile associated with the project 
in details. You can view and edit the staffing profile information in the Staffing tab as you do in the 
Staffing Profile page. 
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The Change Header and More buttons above the Statistics section are specific to staffing profile. From 
the More button, you can configure access, configure notifications, delete staffing profile, and view 
staffing profile audit trail.

For more detailed information about staffing profile, see the Resource Management User’s Guide.

Viewing Project Control Items
The Summary tab on the Project Overview page can display sections devoted to listing and logging 
project control items such as issues, risks, or scope changes.

For example, the Issues section of the Summary tab on the Project Overview page summarizes the 
issues logged for a project. Issues associated with the project appear in the following order:

 1.  Escalated open issues (ordered by priority)

 2.  Other open issues (ordered by priority)

 3.  Closed issues (ordered by priority)

Figure 7-8. Summary tab: Issues section

You can take the following actions from the Issues section:

 l Click Log Issue to log another issue. See "Logging Issues" on the next page for more detailed 
information on logging project issues.

 l Click Show Full List to show the full list of issues logged for the project.

For more detailed information on these sections, see "Submitting Project Control Entities" below.

Submitting Project Control Entities
Project Management allows you to log issues, risks, and scope changes against a particular project. 
These entities can be tracked and logged from their own sections of the Summary tab on the Project 
Overview page.

Note:  If the Request Types policy in the project type does not specify a request type for a project 
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control entity, the Log <Project Control Item> button in the corresponding section on the Project 
Overview page does not appear.

Logging Issues

Project issues can be submitted against a particular project to raise issues that require attention. Once 
submitted, project issues follow their own workflow to resolution.

You can log an issue for a project from the following locations:

 l The Log Issue button in the Issues section of the Summary tab on the Project Overview page.

 l The menu bar option Open > Project Management > Project Controls > Submit Project Issue.

To log an issue for a project:

 1.  Open a project and click Log Issue or select Open > Project Management > Project Controls 
> Submit Project Issue at any time.
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The Create New Project Issue page opens.

 2.  Fill in all required fields and any desired optional fields.

 3.  Click Submit.

The issue is submitted and begins processing along its workflow.
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Logging Risks

Risks can be submitted against a particular project to raise serious issues that require attention. Once 
submitted, risks follow their own workflow to resolution.

You can log a risk for a project from the following locations:

 l The Log Risk button in the Risks section of the Summary tab on the Project Overview page.

 l The menu bar option Open > Project Management > Project Controls > Submit Risk.

To log a risk for a project:

 1.  Open a project and click Log Risk or select Open > Project Management > Project Controls > 
Submit Risk from the menu bar at any time.

The Create New Project Risk page opens.
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 2.  Fill in all required fields and any desired optional fields.

 3.  Click Submit.

The risk is submitted and begins processing along its workflow.

Logging Scope Changes

Scope changes can be submitted against a particular project to raise possible changes in project scope 
that require attention. Once submitted, scope changes follow their own workflow to resolution.

You can log a risk for a project from the following locations:
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 l The Log Scope Change button in the Scope Changes section of the Summary tab on the Project 
Overview page.

 l The menu bar option Open > Project Management > Project Controls > Submit Scope 
Change.

To log a scope change for a project:

 1.  Open a project and click Log Scope Change or select Open > Project Management > Project 
Controls > Submit Scope Change from the menu bar at any time.
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The Create New Project Scope Change Request page opens.

 2.  Fill in all required fields and any desired optional fields.

 3.  Click Submit.

The scope change is submitted and begins processing along its workflow.
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Viewing Project Cost Data
You can view project cost data in the following two locations on the Project Overview page:

 l The Project Cost section of the Summary tab. See Project Cost Section.

 l The Cost tab. See Cost Tab.

Project Cost Section

The Project Cost section of the Project Summary tab on the Project Overview page displays cost 
data for the project.

Figure 7-11. Project Summary tab: Project Cost section

Field Name Description

Total Forecast Forecast of the project for the project plan period (from the project's planned 
start period to the planned end period).

Forecast To End 
Of Current Month

Forecast for the project from the planned start period to the end of the current 
month (or to the planned end period, whichever comes first).

Actual Total Actuals for the project for the project plan period.

Table 7-3. Data displayed in Project Cost section

You can take the following actions from the Project Cost section:

 l Click Cost Details to open the Cost Details page for the project, which shows more detailed project 
cost information including financial summary information.

 l Click View Financial Summary to open the Financial Summary page for the project.
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Cost Tab

Note:  This tab is by default available unless the parameter HIDE_COST_TAB_ON_ PROJECT_PAGE is 
set to true.

By consolidating different views of project costs and financials, the Cost tab on the Project Overview 
page is introduced to provide project managers a comprehensive and centralized view on the project 
budget, costs, and financials from resource, schedule, earned value, and billing perspectives. 

The visibility into accurate finance information from the project level allows project managers to monitor 
project cost status along with other aspects of a project in order to deliver the project on time and within 
budget.

The Cost tab contains four views as described in the table below:

View name Description

Financial Summary Gives project managers an overview of progress information on 
forecast cost, projected cost, budget as well as actual cost. 

The Financial Summary chart has no data if no financial summary 
is created for the project.

Resource Forecast Cost Displays staffing profile related resource forecast cost data for the 
project. 

The Resource Forecast Cost chart is only available when a staffing 
profile is created for the project.

Work Plan Cost Displays work plan related cost data for the project. 

The Work Plan Cost chart is only available when the project is 
integrated with Time Management.

Earned Value Analysis This view allows project managers to perform earned value 
analysis based on the work plan related cost data. 

The Earned Value Analysis chart is only available when the project 
is integrated with Time Management. 

Project managers can also leverage the optimization tool available 
on this view to model the impact on budget and schedule by 
adjusting project scope and even comparing different scenarios.
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Financial Summary view

The Financial Summary view gives project managers an overview of progress information on forecast 
cost, projected cost, budget as well as actual cost. 

The Financial Summary view displays the following overall financial summary information for the entire 
project timeline:

 l Summary for financial summary.  

Project managers can click the help button ( ) to view the details of these terms and see how the 

system calculates the data.

Field Description

Total Budget Total approved budget over the entity's entire range of periods.

Total Actual Cost Total actual costs over the entity's entire range of periods.

Total Actual Benefit Total actual benefits over the entity's entire range of periods.

Projected Cost For each previous month, actual cost is used wherever it has been 
reported, that is, wherever the value is not blank or zero. Otherwise, 
forecast cost is used. 

For the current month, the higher of forecast and actual costs is used.

For each future month, forecast costs is used.

.

Nominal Return Nominal Return represents the total nominal return over the entity's 
entire range of periods.

The Total Nominal Return is calculated over the entire time range.

Total Nominal Return = Total Benefits - Total Costs

To determine total costs and total benefits over the entire time range, 
monthly contributions are based on values for each individual month, as 
follows:

 o For each previous month, actual cost is used wherever it has been 
reported, that is, wherever the value is not blank or zero, otherwise 
forecast cost is used. Similarly, actual benefit is used wherever it has 
been reported, otherwise forecast benefit is used.

 o For the current month, the higher of forecast and actual costs is used. 
Similarly, the higher of forecast and actual benefits is used.

 o For each future month, forecast costs and forecast benefits are used.
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Field Description

Net present value 
(NPV)

Net present value (NPV) is total nominal return, discounted to its current 
value, based on a specified discount rate and the time allowed for the 
nominal return to be realized. PPM Center computes and reports total 
NPV, which is the sum of these values for all months—previous, 
current, and future—using each month's particular Nominal Return. NPV 
for past and current months is meaningful for projects that are underway. 
Only future months are discounted. Previous and current months use 
their Nominal Return values in calculating the sum.

NPV is calculated using actual and forecast costs and benefits from all 
the months of the financial summary.

For any particular future month:

NPV = (Nominal Return) / (1 + i/12) n

n represents the number of periods (months) from the current month.

i represents the annual discount rate. For example, if the Discount Rate 
field (which by default is disabled) is specified as 6 to represent a 6% 
annual rate, the formula uses 0.06 for the value of i, then divides that by 
12 to reflect the 12 months in a year.

 l Financial trend chart for the entire project timeline. This chart shows the trend for budget, 
projected cost, actual cost, and forecast cost. Project managers can easily understand whether the 
project will be over budget soon. You can also click the left and right arrow buttons to view the 
statistics from previous or next months.

 l Summary of financial summary by cost category. This section displays a table with the 
forecast and actual costs of the project. Project managers can also drill down into details by clicking 
View Financial Summary to open the Financial Summary page for the project.

Below is an example of the Financial Summary view on the Cost tab of the Project Overview page.
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From the Financial Summary view, you can click View Financial Summary to open the Financial 
Summary page for the project.

Resource Forecast Cost view

Note: This tab is available only when there is a staffing profile created for the project.

The Resource Forecast Cost view helps you to understand the forecast cost that will be spent on 
different positions and resources, giving you an insight into what will be cost by the resource planned. 
The forecast cost is calculated based on the data from the project staffing profile. 

Field Description

Total Forecast Cost Total Forecast Cost represents the forecast cost of a staffing profile equals 
to the total sum of forecast labor costs of all positions in this staffing profile.

The forecast cost of a specific position is calculated as follows:

Forecast Cost of a Position = Sum (Forecast Labor Cost of Assignment / 
Promise of the Position) + (Unmet Demand * Cost Rate of the Position)

Forecast Labor Cost of Assignment = Total committed effort of the 
assigned resource * Cost rate of the resource

Forecast Labor Cost of Promise = Total promised effort of the assignment * 
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Field Description

Cost rate of the position. The cost rate of a position/resource is determined 
by the cost rule.

Forecast Cost to Date  Forecast Cost to Date represents the forecast cost to date of a staffing 
profile.

As a project manager, you can compare the resource forecast cost against the baselines in the chart. 
The chart will display the monthly total resource cost in the staffing profile baseline as well as the 
monthly total resource cost in active staffing profile. This helps project managers to have a 
understanding of the cost variance on the resources.

You can also expand the plus sign in front of a position to view the cost per resource per month. The 
table displays detailed information on the total resource cost presented in the staffing profile. 

Below is an example of the Resource Forecast Cost view on the Cost tab of the Project Overview 
page.

Note:  The Resource Forecast Cost chart may not display any forecast or baseline data until any 
changes made to the staffing profile for the project trigger the Staffing Profile Financial Summary 
Sync Service.

Work Plan Cost view

The Work Plan Cost view allows project managers to track their schedules and actual cost for their 
projects.
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Field Description

Baseline Total Baseline Total represents the active baseline total cost of a project.

Baseline Total Cost = Baseline Labor Cost + Baseline Non-Labor Cost

Baseline To Date  Baseline To Date represents the active baseline cost to date of a project.

Planned Total Planned Total represents the total planned cost for a project.

Planned Total Cost = Planned Labor Cost + Planned Non-Labor Cost

Planned To Date Planned To Date represents the total planned cost to date for a project.

Actual Cost Actual Cost represents the total cost incurred in completing a project.

Actual Cost = Actual Labor Cost + Actual Non-Labor Cost

The Work Plan Cost chart gives project managers a straightforward view of the trend on the actual 
costs.

Note: The Work Plan Cost chart is only available when the project is integrated with Time 
Management.

Below is an example of the Work Plan Cost view on the Cost tab of the Project Overview page.
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Earned Value Analysis view

As a project progresses, project managers may leverage the Earned Value Analysis view to analyze 
project progress and cost status. The Earned Value Analysis view leverages the Earned Value 
Management (EVM) method, which is a project management technique for measuring project 
performance and progress. This method has the ability to combine measurements of the scope, 
schedule, and costs of the project management.

Project teams may develop a forecast for the Estimate at Completion (EAC) based on project 
performance. EAC differs from the Budget at Completion (BAC). If it becomes obvious that BACs are 
no longer feasible, project managers should consider the forecasted EACs. Forecasting EAC involves 
making projections of conditions and events in the project’s future based on current performance 
information and other knowledge available at the time of the forecast. Forecasts are generated, 
updated, and reissued based on work performance data  that is provided as the project is executed. The 
work performance information covers the project’s past performance and any information that could 
impact the project in the future.

EACs are typically based on the actual costs incurred for work completed, plus an estimate to 
complete (ETC) the remaining work. It is incumbent on the project team to predict what it may 
encounter to perform the ETC, based on its experience to date. The EVM method works well in 
conjunction with manual forecasts of the required EAC costs. The most common EAC forecasting 
approach is a manual, bottom-up summation by the project manager and project team.

The project manager’s bottom-up EAC method builds upon the actual costs and experience incurred for 
the work completed, and requires a new estimate to complete the remaining project work. Equation: 
EAC = Actual Cost (AC) + Bottom-up ETC.

The project manager’s manual EAC is quickly compared with a range of calculated EACs representing 
various risk scenarios. When calculating EAC values, the cumulative CPI and SPI values are typically 
used. While EVM data quickly provide many statistical EACs, only three of the more common methods 
are described as follows:

 l EAC=AC+(BAC-EV)/(SPI*CPI)

Select this formula if EAC forecast for ETC work considers both SPI and CPI factors.

 l EAC=AC+(BAC-EV)

Select this formula if EAC forecast for ETC work is performed at the budgeted rate.

 l EAC=BAC/CPI

Select this formula if EAC forecast for ETC work is performed at the present CPI.
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Project managers can specify which method to use to calculate the Estimate At Completion (EAC) 
values for this project on the Project Formula policy page of the Project Settings page.

The table below describes cost data items available  and their associated formulas for earned value 
analysis purpose.

Field Description

Planned Value (PV) Planned Value can be calculated in one of two ways, depending on how the 
PV_USE_ACTIVE_BASELINE_DATES server.conf parameter is set. If 
necessary, contact your PPM Center system administrator to verify this 
setting.

By default, the PV_USE_ACTIVE_BASELINE_DATES parameter is set to 
false. Therefore, by default, Planned Value is calculated by the portion of 
the Baseline Cost planned to be spent between the project's start date and 
the current date.

PV = Baseline Cost * [(Today's Date - Start Date) / (Finish Date - Start 
Date)]

If the PV_USE_ACTIVE_BASELINE_DATES parameter is set to true, 
Planned Value is calculated using a project's active baseline dates instead 
of its scheduled dates.

Note: When the Project Planned Value Update service runs for the first 
time after PV_USE_ACTIVE_BASELINE_DATES is enabled, projects 
with scheduled dates and active baseline dates that are both 
completely in the past are not calculated.

PV = Baseline Cost * [MIN (Today's Date, Baseline Finish Date) - Baseline 
Start Date] / (Baseline Finish Date - Baseline Start Date)

Earned Value (EV) Earned Value can be calculated one of two ways, depending on how the 
EV_ALLOW_PRORATING server.conf parameter is set. If necessary, 
contact your PPM Center system administrator to verify this setting.

By default, the EV_ALLOW_PRORATING server.conf parameter is set to 
true. Therefore, by default, Earned Value is calculated by the portion of the 
Baseline Cost for the entire project that has theoretically been spent by the 
current date, measured as a function of the amount of work performed thus 
far.

EV = Baseline Cost * % Complete

If the EV_ALLOW_PRORATING server.conf parameter is set to false, 
Earned Value is only acknowledged when a task or project is 100% 
complete. That is, if the task or project is less than 100% complete, the EV 
calculation is 0. When the task or project is 100% complete, the EV 
calculation is equal to the Baseline Cost of the task or project.

If % Complete < 100, EV = 0
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Field Description

If % Complete = 100, EV = Baseline Cost

Cost Performance 
Index (CPI)

Cost efficiency ratio of Earned Value (EV) to Actual Cost (AC). CPI is used 
to calculate Projected Actual Cost for a project and predict the size of 
possible cost overrun.

CPI = EV / AC

Schedule 
Performance Index 
(SPI)

Schedule efficiency ratio of Earned Value to Planned Value. SPI describes 
what portion of the work plan or planned schedule has been accomplished in 
terms of its cost.

SPI = EV / PV

Schedule Variance 
(SV)

Difference between the earned value and the planned value of the project or 
task. Planned value compared with earned value measures the dollar 
volume of work planned against the equivalent dollar volume of work 
accomplished. Any difference is called a schedule variance.

SV = EV - PV

Cost Variance (CV) Difference between the earned value and the actual cost for the project or 
task. Earned value compared with the actual cost incurred for the work 
performed provides an objective measure of planned and actual cost. Any 
difference is called a cost variance.

CV = EV - AC

Budget At Completion 
(BAC)

Total anticipated and budgeted spending for the project based on the project 
estimates and assumptions. In PPM Center, the total planned cost of an 
active baseline is taken as the BAC for the project.

BAC = Baseline Cost

Estimation At 
Completion (EAC)

The estimated cost of the project at the end of the project.

There are three methods to calculate EAC:

Variances are Typical - This method is used when the variances at the 
current stage are typical and are not expected to occur in the future.

Past Estimating Assumptions are not valid - This method is used when the 
past estimating assumptions are not valid and fresh estimates are applied to 
the project.

Variances will be present in the future - This method is used when the 
assumption is that the current variances will continue to be present in the 
future.

The calculation formulas for the three methods are as given below. You can 
select a desired formula in Project Settings to determine how the project 
calculates the EAC.
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Field Description

EAC = AC + ( BAC - EV )/(SPI * CPI )

EAC = AC + ( BAC - EV )

EAC = BAC / CPI

To Complete 
Performance Index 
(TCPI)

To Complete Performance Index is an index showing the efficiency at which 
the resources on the project should be utilized for the remainder of the 
project. This can be calculated using the following formula:

TCPI = (BAC - EV) / (BAC - AC)

BACT The finish month of the baseline.

EACT The calculated finish month of EAC. 

EACT = Work plan start month + EAC/Original BAC/Duration (in months) of 
the baseline

Below is an example of the Earned Value Analysis view on the Cost tab of the Project Overview page.

Note: When the structure of a work plan has been changed, the values for Planned Value, Earned 
Value, CPI, and SPI become 0 after the Cost Rollup Service runs. To obtain these values for 
earned value analysis purpose, after any work plan structure change, recreate a new baseline for 
your project.
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Project managers can also leverage the optimization tool available on this view to model the impact on 
budget and schedule by adjusting project scope, and saving and comparing different scenarios.

To compare different scenarios by using the optimization tool:

 1.  Drag the slider to change the scope. This determines how BAC changes.

For example, if you drag the slider to -50%, the new BAC = the original BAC * (1-50%); if you drag 
the slider to 50%, the new BAC = the original BAC * (1+50%).

The Earned Value Analysis chart and the values of EAC, EAC(T), and TCPI are changed as the 
baseline cost is adjusted.

 2.  Click Save the scenario as.

 3.  Provide a name for the scenario in the Save As dialog box.

 4.  Click Confirm.

 5.  Repeat from step 1 to step 4 to create other scenarios.

Note:  By changing the scope to create different scenarios, you can have a direct visual 
perspective about the impact of BAC changes, therefore, PPM does not save the scenarios 
you created. 

You can create up to three scenarios at a time. These scenarios are wiped out when you 
leave the Cost tab. 

 6.  Click Compare scenarios.

The Compare Scenarios window opens displaying Earned Value Analysis view in different 
scenarios.

Viewing Exceptions and Warnings
Exceptions and warnings indicate that a rule that has been defined in the project has been violated for a 
particular task. For example, resources have not been assigned to a task that is due to begin soon, or a 
task is being completed a certain number of days late. Exception rules are configurable; for more 
detailed information, see "Schedule Health" on page 40.

Tasks that have triggered exceptions can be viewed from the Exceptions tab on the Project Overview 
page or the Schedule view on the Work Plan page.

Figure 7-12. Project Overview page: Exceptions tab
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Viewing Exceptions from the Project Overview Page

The Exceptions tab lists all the tasks in a particular project that have triggered exceptions.

To get to the Exceptions tab for a project:

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click the Exceptions tab. The Exceptions tab opens.

 3.  Drill down to any tasks that merit attention.

Viewing Exceptions in the Schedule View

Exceptions that have been triggered display as a red exclamation mark in the first column on the left in 
the Schedule view on the Work Plan page.

To view a particular triggered exception for a task:

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.
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The Work Plan page opens.

 3.  Click a task in the Schedule view and select Edit > Task Details.

The Task Details page opens.

Note:  Depending on whether you have the proper access grant to edit the task, you may not 
be able to edit the task's fields. Users who can only view a task include project participants 
who have not been assigned to that particular task, as well as project managers who are not 
managing the project within which that particular task is contained.

 4.  Click the Exceptions/Warnings tab.

The Exceptions/Warnings tab lists the exception and schedule warning rules for the project that 
the task is violating.

Clearing Schedule Warning Indicators in the 

Schedule View

Warning indicators associated with a task are cleared when the task is rescheduled. You can also 
manually clear specific warnings (partial schedule warnings for dependent tasks and schedule change 
warnings for parents and ancestors) from the Task Details page.

To clear a warning indicator for a task:

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.
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The Work Plan page opens.

 3.  Click a task in the Schedule view and select Edit > Task Details.

The Task Details page opens.

 4.  Click the Exceptions/Warnings tab.

The Exceptions/Warnings tab lists the exception and schedule warning rules for the project that 
the task is violating.

 5.  Click the Clear Indicator icon next to the warning that you want to clear.

Viewing Exceptions/Warnings from the Task Details 

Page

The Exceptions/Warnings tab on the Task Details page shows an exception indicating that some 
resources on a task have not entered % Complete if both of the following conditions are met:

 l Require resources to enter % Complete along with actual effort option is selected on the 
project's Cost and Effort policy. 

 l A user logs and saves time on a time sheet (or elsewhere) for the task but leaves % Complete as 
0.

Note:  The exception appears on the Task Details page only after the Exception Rule Service 
runs. For this type of exception, the service runs according to the setting of the EXCEPTION_
ENGINE_WAKE_UP_TIME server.conf parameter (once a day at 1:00 a.m. by default). For more 
information, see the Installation and Administration Guide.

Viewing the Project Critical Path
A work plan's critical path is composed of all of the tasks in a work plan that determine its duration. 
There are two ways to make the critical path visible:

 l The Highlight Critical Path checkbox allows you to display the critical path in the project Gantt 
chart. Tasks that are part of the critical path are outlined in orange.
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 l The Mark Tasks on Critical Path checkbox allows you to mark tasks on the critical path with an 
orange flag present in all work plan views.

Note:  The critical path is calculated after scheduling the work plan. If you have made changes to 
the work plan, you should reschedule it in order to obtain an accurate critical path.

Figure 7-2. Work Plan page: Gantt view displaying critical path

To see a work plan's critical path on the Gantt chart:

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 3.  Click Actions and select Configure Gantt.
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The Configure Gantt View dialog box opens.

 4.  Select the Highlight Critical Path checkbox.

 5.  Click OK.

The Gantt chart displays the project's critical path.

To mark tasks on a work plan's critical path on the Gantt chart:

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 3.  Click Actions and select Configure Indicator Columns.
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The Configure Indicator Columns dialog box opens.

 4.  Select the Mark Tasks on Critical Path checkbox.

 5.  Click OK.

Viewing Project References
The Project Overview page's References tab displays all entities linked to the project as references. 
References (requests, packages, tasks, other projects, releases, attachments, and URLs) are listed 
with details including:

 l Reference Type

 l Description

 l Referenced By

Note:  You can still add references for closed projects.
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Using the PPM Dashboard to View Progress
Project managers can also view projects using the PPM Dashboard. This interface comes with a 
configurable set of application windows, known as portlets, through which common Project 
Management queries and actions can be performed.

Viewing Program Associations
The Program Associations section of the Summary tab on the Project Overview page lists the 
programs to which a project is associated.

Note:  The Program Associations section only appears if you have purchased and installed 
Program Management.

Figure 7-10. Summary tab: Program Associations section

Program Management provides a way for managers to link multiple projects together as programs, and 
to submit and track requests against them.

Organizations implement a Program Management Office in order to:

 l Ensure alignment of IT projects with business objectives

 l Eliminate duplicate and non-priority efforts

 l Improve operational efficiency

 l Leverage resources

 l Ensure on-time and on-budget delivery

Programs can be tracked and analyzed with the same kind of familiar cost metrics as projects.

For more detailed information on Program Management, see the Program Management User’s Guide.
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Viewing Project Earned Value (EV) Analysis
The EV Analysis Summary section of the Project Summary tab on the Project Overview page 
provides an earned value (EV) analysis for the project based on the latest data.

Click Analyze to open the Analyze Cumulative Cost Metrics page for the project.

For detailed information on analyzing cumulative cost metrics for a project, see the Financial 
Management User’s Guide.

Viewing the Work Plan
The Work Plan section of the Summary tab on the Project Overview page displays the top level tasks 
in the project work plan.

Figure 7-3. Summary tab: Work Plan section

You can take the following actions from the Work Plan section:

 l Click Edit Work Plan to open the Quick view and edit the work plan. See "Creating and Managing 
a Work Plan" on page 74 and  for more details on editing the work plan.

 l Click View Baselines to open the View Baselines page and manipulate project baselines. See 
"Working with Baselines" on page 183 for more details on working with baselines.
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Approving Project Time
Time Management can be used in conjunction with Project Management for detailed entry of time and 
effort actuals using time sheets. Time sheets have their own sets of approvers and approval 
processes, and can be used for more granular cost reporting. The Approve Project Time section of 
the Project Summary tab on the Project Overview page displays data for time sheets with lines 
pertaining to the project, and allows you to approve or reject them directly.

To approve or reject the time sheets listed in the Approve Project Time section, select the 
checkboxes next to the desired time sheets and click Approve or Reject.

Controlling Project Dates
The following entities relevant to projects have effective start and end dates associated with them:

 l Projects. The Details tab on the Project Overview page contains the project's Planned Start and 
Finish Period.

 l Work plans. The work plan for a project represents the scheduled start and end dates of major 
deliverables for the project.

 l Staffing profiles. The staffing profile for a project has a Start and End Period.

 l Financial Summaries. The financial summary for a project has a Start and End Period.

Note the following when working with dates:

 l The Planned Start and Finish Period for a project take precedence over the other dates.

 l Planned Start for a project cannot be deleted.

 l Planned Start for a project can be modified. However, the new Planned Start must be later than 
the original Planned Start and no actuals can exist in the financial summary after the original 
Planned Start. When the Planned Start is modified:

 o Forecast (planned) costs that are entered manually move from the original start period to the new 
start period.

 o Forecast effort for the staffing profile move from the original start period to the new start period 
and then the lines in the financial summary affected by the staffing profile are recalculated.

 o Actuals that exist before the original Planned Start are not moved.
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 l If the work plan's Scheduled Start or Finish Date falls outside the project's existing date range, a 
scheduling warning is triggered when the work plan is scheduled.

 l Start Period values for staffing profiles associated with a project are automatically synchronized 
with the values specified in the Project Details tab. The Start Period for the project's financial 
benefit are also synchronized with the project, but is offset from the actual Start Period.

Working with Baselines
A baseline is a snapshot of the approved work plan. As scope changes happen, the baseline is updated 
to reflect those changes as part of the approved plan. A project manager uses baselines to 
continuously monitor the health of their project in terms of schedule and cost by comparing the current 
work plan to the baseline plan. Only users with the appropriate access grants can view and manipulate 
baselines.

Taking a Baseline

You can take a baseline starting from the Project Overview page or from the Work Plan page.

To take a baseline from the Project Overview page:

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click View Baselines.

The View Baselines page opens.

 3.  Click Create Baseline.

The Create Baseline dialog box opens.

 4.  Type a Name and optional Description for the baseline.

A default name for the baseline is suggested, though you can change it.
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 5.  Click Create.

The baseline has been taken.

To take a baseline from the Work Plan page:

 1.  Open the work plan.

 2.  On the Work Plan page, select Actions > Create a Baseline.

The Create Baseline dialog box opens.

 3.  Type a Name and optional Description for the baseline.

A default name for the baseline is suggested, though you can change it.

 4.  Click Create. The baseline has been taken.

Managing Baselines

Multiple baselines can be taken for a single work plan. You can update the names and descriptions of 
baselines, specify which is the active project baseline, or delete baselines at any time.

Note:  To take a baseline for a project, you must have a license for Project Management, be a 
manager for the project, and have the Manage Work Plan Baselines access grant. Users with the 
Manage All Work Plan Baselines access grant can take baselines for any project.

To manage project baselines:

 1.  Open the project you have taken baselines of.

 2.  On the Project Overview page, click View Baselines.

The View Baselines page opens.

 3.  Select the option next to the baseline you want to be active for the project.

 4.  (Optional) Click the Delete icon next to a baseline you wish to delete.

 a.  A dialog box will open asking if you are sure you want to delete the baseline.

 b.  Click Delete to delete the baseline.

 5.  Click Done.
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Comparing Baselines

You can compare baselines to each other, or a baseline to the current work plan. On the View 
Baselines page, click Compare Baselines to open and run the report that allows you to compare a 
baseline to another baseline, or to the current work plan.

Viewing Baseline Data in the Work Plan

You can view active baseline data in the work plan by adding baseline-specific columns to the work 
plan. Active baseline data that can be viewed from the work plan includes: scheduled start, scheduled 
finish, scheduled effort, actual start, actual finish, and actual effort. See "Add/Remove Columns" on 
page 112 for more information about adding columns to the work plan.

Tracking and Analyzing Project Costs
Financial Management allows you to track and analyze project costs in ways including the following:

 l Capturing and comparing financial data in financial summaries including roll-ups from work plans 

 l Using Time Management to track task costs

 l Performing analysis of project cost data in graph and portlet form, including earned value analysis

 l Enabling SOP 98-1 compliance at the work plan level with activities

 l Enabling the use of different currencies depending on project participants' locations

See the Financial Management User’s Guide for more detailed information on cost data, currencies, 
exchange rates, and SOP 98-1 compliance.

Viewing and Monitoring Project Quality Data
The View Project Quality integration solution  allows you to track and analyze project quality KPI data 
retrieved from ALM Releases. The retrieved KPI data are displayed in the four newly introduced default 
portlets on the Project Overview page.
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New Portlet Description

Requirement 
Trends

Displays requirement statuses trend in the last 10 days. The requirement status 
includes requirement coverage.

Open Defect 
Trends

Displays open defects trend in the last 10 days. The open defects include open 
defects number and total defects number.

Priority 
Defects 
Trends

Displays trend of defects of higher severity in the last 10 days. The higher severity 
defects include defects of priority S1 and S2.

Project 
Quality 
Scorecard

Displays ALM release scorecard information. Only when the ALM scorecard 
information is configured in the project request field of the Project Planning and 
Tracking (PPT) module in ALM, the scorecard portlet is displayed.

For detailed information about the View Project Quality integration solution, how to configure the 
integration, and how to use the integration solution to view and monitor project quality KPI data, see the 
Solution Integrations Guide.

Viewing and Managing Agile Development 
Projects with the Agile Integration Solution
The integration between PPM Center and Agile Manager allows project managers, program managers, 
portfolio managers, and other project stakeholders to have:

 l Visibility into real-time status and progress of agile development projects from within PPM Center, 
without having to log on to Agile Manager for details

 l A consolidated view of their tasks and agile development initiatives

The integration allows project managers to map a task under a project to a specific release managed in 
Agile Manager. Each PPM Center task is associated with a single release in Agile Manager throughout 
the task life cycle. This is a one-way one-to-one mapping relationship. 

After the mapping relationship is established, the project managers are able to view real-time agile 
development related charts retrieved from Agile Manager. In addition, project managers can also view 
the actual and schedule agile release information from within PPM Center projects work plans.

For detailed information about Agile Integration Solution, see the Solution Integrations Guide.

Project Management User’s Guide
Chapter 7: Viewing andMonitoring Project Metrics

HPE Project and Portfolio Management Center (9.40) Page 186 of 292



Exporting and Printing a Work Plan
A work plan can be exported as a PDF file or a Microsoft Excel file for use in presentations.

Note:  When exporting a work plan to both PDF and Excel files, if the work plan has a task with a 
name that contains double-byte numbers, the exported PDF file differs from the exported Excel 
file. In the exported PDF file, the task name does not contain the double-byte numbers.

Exporting to PDF Files

You can export work plan to PDF in all work plan views except Quick view.

 1.  Open the project to export.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 3.  Adjust the work plan display.

You can adjust the set of displayed tasks by reordering or resizing columns, expanding or 
collapsing summary tasks, or filtering the work plan in order to display the tasks you want.

 4.  Click the Export Wrok Plan to PDF icon.

The PDF Export Options dialog box opens.

 5.  Select the desired options for the display of the project Gantt chart, the included columns, and 
paper size.

 6.  Click Export.

A new window opens, refreshing at a set interval until the system completes the export.

When the export completes, select the link to open the file in the browser, where it can be viewed 
and saved.
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Exporting to Microsoft Excel Files

To export a work plan to a Microsoft Excel file:

 1.  If you are using Microsoft Internet Explorer version 7, verify that the Internet options are configured 
properly. See Getting Started for more information.

 2.  Open the project to export.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 3.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 4.  Click the Microsoft Excel icon.

A new window opens, refreshing at a set interval until the system completes the export.

When the export completes, select the link to open the file in the browser, where it can be viewed 
and saved.

Tracking Work Plan Audit History
Project Management maintains an audit trail for projects, work plans, and tasks.

Note:  The audit trail event description is limited to 4,000 characters. Descriptions longer than 
4,000 characters are truncated.

View the audit trail for a particular project

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  In the upper-right corner of the Project Overview page, click ... > Project Audit Trail.

The Project Audit Trail dialog box opens.

Click     or     to navigate between pages of information. You can also click the Export to 
Excel link to export the dialog box's contents to a Microsoft Excel file.
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 3.  Click the X icon in the upper-right corner to close the dialog box.

View the audit trail for a particular work plan

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 3.  Click the Work Plan Audit Trail link on the Work Plan page, or the or View Audit Trail link if you 
are in Quick view.

The Work Plan Audit Trail dialog box opens.
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Click     or     to navigate between pages of information. You can also click the Export to 
Excel link to export the dialog box's contents to a Microsoft Excel file.

 4.  Click the X icon in the upper-right corner to close the dialog box.

View the audit trail for a task

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

 3.  In the Schedule view, click the task to update and select Edit > Task Details.

The Task Details page opens.

 4.  Click More > View Task Audit Trail in the upper-right corner.

The Task Audit Trail dialog box opens.

Click     or     to navigate between pages of information. You can also click the Export to 
Excel link to export the dialog box's contents to a Microsoft Excel file.

Note:  For resource-related tasks, the list of unchanged resources is summarized as a count 
(the number of resources) rather than individually listing each resource. Resources that are 
changed (added or removed) are individually listed.

 5.  Click the X icon in the upper-right corner to close the dialog box.

Completing, Cancelling, and Deleting Projects
All projects must reach an endpoint. The project can either be brought to completion, or reach a point 
where no more work can be done. Work plan statuses provide distinct ways of differentiating between 
work plans that have been Completed or Cancelled. For more detailed information on work plan 
statuses, see "Work Plan Statuses" on page 90. Projects can also be deleted by users with the proper 
level of access.
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Completing Work Plans

Project managers can set the work plan status to Completed. For more information, see "Changing 
Statuses" on page 92.

If a work plan is manually set to Completed:

 l Any incomplete tasks are set to Completed.

 l Any incomplete summary tasks are set to Completed.

Cancelling Work Plans

Occasionally, all work on a particular business initiative can be stopped. The endeavor might have 
been found to be unprofitable, it might not be feasible given current resource limitations or there might 
be another business reason. Tasks can have their statuses changed to Cancelled to reflect this 
circumstance. 

 l If a work plan is manually set to Cancelled, any incomplete tasks under it are set to Cancelled.

 l From Cancelled, a work plan can be moved back to On Hold.

 l Once the work plan is moved into an Active summary task status:

 o Task statuses will be recalculated.

 o Tasks previously In Progress will not regain the task status of In Progress.

Deleting a Project

Sometimes projects are created in error. Project managers can delete projects from the Project 
Overview page. In the upper-right corner of the Project Overview page, click ... > Delete Project to 
delete a project.

Note:  Once deleted, a project cannot be recovered. Use caution when considering projects for 
deletion.
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"Table 7-4. Access requirements for project deletion" below describes the conditions that must be met 
in order for you to be able to delete a project or projects.

Item to Delete Access Requirements

A single project  l Project manager for the project

 l Access grant: Delete Projects

 l Access grant: Edit Projects

A single project with actuals  l Project manager for the project

 l Access grant: Delete Projects

 l Access grant: Delete Projects with Actuals

 l Access grant: Edit Projects

Table 7-4. Access requirements for project deletion

When a project is deleted, its financial summary is also deleted, including snapshots, actuals, and 
manually entered data. Time sheet data and staffing profiles are not deleted. If the project is associated 
with a program, the project is deleted from that program. 

You cannot delete a project if:

 l the project has more than one parent

 l the project was created from a proposal (because both the project and proposal share the same 
financial summary)

Exporting the Project Overview Page to PDF
You can create a simple, unified version of the Project Overview page suitable for exporting to a PDF 
file.

To create an exportable view of the Project Overview page:

 1.  Open the project to edit.

For more details on searching for and opening projects, see "Searching for Projects" on page 72.

 2.  In the upper-right corner of the Project Overview page, click More > Export to PDF.

The PDF Settings window opens.

 3.  Select the project overview data (portlets) you want to print. The layout of the portlets is configured 
in the Project Settings, Project Overview Layout (refer to "Project Overview Layout" on page 59 for 
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more information).

 4.  In the Paper section, select the desired options for the display.

 5.  Click Export.

If the Open PDF document in browser window checkbox is selected, the PDF file opens in a 
separate browser window.

If the Open PDF document in browser window checkbox is not selected, you can choose to 
open the file in a PDF reader or save the file.
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Chapter 8: Integrating Project Management 
with Microsoft Project

Overview of Integrating Project Management 
with Microsoft Project
The integration between Microsoft Project and Project Management allows the organization to have 
visibility into projects even when their schedules are planned in Microsoft Project. The integration 
allows project managers to import project information from Microsoft Project to a new Project 
Management project. Project information can also be exported from Project Management to Microsoft 
Project, creating a new project in Microsoft Project. Projects that have been imported or exported can 
be synchronized. Any information that is shared between projects in both applications is updated during 
synchronization.

Each Project Management project is associated with a single Microsoft Project file throughout the 
project life cycle. This is a one-to-one relationship where the Project Management project is associated 
to a specific Microsoft Project file in a specific location. This association begins when one project is 
used to create the other project: when project information is imported from Microsoft Project to a new 
Project Management project or when project information is exported from Project Management to a new 
project in Microsoft Project. The project manager synchronizes the projects to keep the association up-
to-date.

Getting Started

Depending on your project management strategy, you can use each application to accomplish different 
vital tasks. A general outline of the most common way to use the integration follows below.

Step 1: Configure Microsoft Project integration options.                 

Before you can use the integration, your system administrator needs to verify or adjust some key 
settings to conform to your organization's business needs. You should not use the Microsoft Project 
integration until this has been completed.
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For more detailed information, see the Project Management Configuration Guide.

Step 2: Decide how to manage your plan by selecting a synchronization mode.         

For details on the different synchronization modes offered by the integration, see "Synchronization 
Modes" on page 202.

Step 3: Decide how to create the work plan.         

For details on different ways to create and maintain a work plan, see "Project Management Strategies" 
on page 230.

Step 4: Configure the Microsoft Project Integration policy.         

For details on configuring the project-level settings for the Microsoft Project Integration policy, 
including the synchronization model, see "Project-Level Settings for Integration" on page 232.

Step 5: Create and manage the work plan.         

If your work plan is Project Management-controlled, you will create the work plan in Project 
Management and occasionally open it in Microsoft Project. See  for more detailed information.

If your work plan is Microsoft Project-controlled, you will create the work plan in Microsoft Project and 
occasionally open it in Project Management. Mapping of resource information between applications 
occurs automatically when sending a Microsoft Profile file to Project Management, but you can make 
manual adjustments during the process. See "Sending a Microsoft Project Work Plan to Project 
Management" on page 263 for more detailed information.

If control is shared, you will manage the work plan in Microsoft Project and collect actuals using Project 
Management. See  and "Retrieving Actuals from Project Management (Shared Control Mode)" on 
page 266 for more detailed information.

Installing and Upgrading the Plug-in for PPM
To integrate Microsoft Project and Project Management, you must download and install the Plug-in for 
PPM from the menu bar. This is a one-time action that does not need to be repeated every time you use 
Microsoft Project or Project Management. The Plug-in for PPM user, not the system administrator 
(unless they are the same user), should install the Plug-in for PPM on the system.

Note:  If more than one user will use the Plug-in for PPM on the system, each user must install his 
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own instance of the Plug-in for PPM (each instance should be installed in a different destination 
folder).

If you downgrade Microsoft Project (from 2010 to 2007) or upgrade Microsoft Project (from 2007 to 
2010) after installing the Plug-in for PPM, you must remove and then re-install the Plug-in for PPM. 

If you upgrade PPM Center, you may need to upgrade the Plug-in for PPM. See "Upgrading the Plug-in 
for PPM" on page 201 for more information about upgrading the Plug-in for PPM.

Note:  If the Plug-in for PPM has not been installed on your system and you cannot see the 
download option in the menu bar, contact your PPM Center administrator for access.

Requirements for the Plug-in for PPM

The following are the Project Management and Microsoft Project requirements that should be met 
before installing the Plug-in for PPM.

Server-Side Requirements

In order to install and use Plug-in for PPM, users need the following:

 l Project Management license

 l Synchronize Work Plans access grant (this access grant is part of the PPM Project Manager 
security group included with Project Management)

 l Microsoft Project integration options enabled (required only if you want to enable specific features of 
the Plug-in for PPM, such as launching Microsoft Project from an Project Management work plan); 
see the Program Management User’s Guide for more information.

Client-Side Requirements

The following software is required on the client:

 l Microsoft Project

 l Microsoft .NET Framework version 3.5 or later

 l Visual Studio Tools for Office (VSTO) (must be installed by a system administrator)
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 o Version 3.0 for Microsoft Project 2007 and 2010

 o Version 4.0 for Microsoft Project 2013 

 l Microsoft Office Primary Interop Assemblies (PIA) for Microsoft Project (must be installed by a 
system administrator)

 o Version 2007 for Microsoft Project 2007

 o Version 2010 for Microsoft Project 2010

 o Version 2013 for Microsoft Project 2013

 l For information about supported versions of Microsoft Project, see the System Requirements and 
Compatibility Matrix.

Installation Instructions

To integrate PPM Center with Microsoft Project, the Plug-in for PPM must be installed. The user of the 
Plug-in for PPM must install the Plug-in for PPM, not the administrator. This section provides the steps 
you perform to install the Plug-in for PPM.

To install the Plug-in for PPM:

 1.  If Microsoft Project is open, exit Microsoft Project.

 2.  After you install and configure PPM Center, log on to PPM Center.

 3.  From the menu bar, select Open > Administration > Download Microsoft Project Plug-in.

The File Download dialog box opens and prompts you to indicate whether you want to run or save 
the setup.exe file. 

 4.  Click Run. 

 5.  Select a setup language and click OK.

The Plug-in for PPM InstallShield wizard starts up.

Note:  Content of some windows may not display correctly depending on the language you 
select. If you do not select the English language, select a language that can display non-
Unicode content on a Windows system.
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If Microsoft Project or Microsoft .NET Framework is not installed, you or your system 
administrator must install this software before installing the Plug-in for PPM. The installer 
exits so that you can install this software.

If Visual Studio Tools for Office (VSTO) is not installed and you do not have the ability to 
install software on the system, the installer exits. Log in to the system as a user who can 
install this software and re-run the installer or ask the administrator to install this software.

If Visual Studio Tools for Office (VSTO) is not installed and you do have the ability to install 
software on the system, the installer asks you to install VSTO. Follow the prompts to install 
the software. You must accept the end user license agreement to install VSTO.

If you are running Windows Vista or Windows 7 and are having problems installing VSTO, see 
"Installing Visual Studio Tools for Office (VSTO) on Windows Vista or Windows 7" on 
page 282 for additional information on how to install VSTO.

The Welcome page and then the Destination Folder page opens. The Destination Folder page 
shows the default directory for the Plug-in for PPM installation.

 6.  From the Destination Folder page, either install the Plug-in for PPM in the default directory or 
select a directory for installation.

Note:  If more than one user will use the Plug-in for PPM on the system, each user must 
install his own instance of the Plug-in for PPM and each instance of the Plug-in for PPM 
should be installed in a different destination folder.

To accept the default directory, click Install. Otherwise, change the installation directory, as 
follows:

 a.  Click Change.

The Change Current Destination Folder page opens.

 b.  Browse to, and then select a destination installation folder.

Note:  You must have write access to the installation folder.

The path to the installation folder must contain only alphanumeric characters.

 c.  Click OK.

The installation of the Plug-in for PPM begins.

 7.  After installation is completed, on the InstallShield Wizard Completed page, click Finish.
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Silent Installation

You can perform the installation of the Plug-in for PPM without opening the InstallShield wizard. 

Caution:  You must meet all the client-side requirements before you run the silent installation (see 
"Client-Side Requirements" on page 196). The silent installation does not check for these 
requirements.

Note:  If more than one user will use the Plug-in for PPM on the system, each user must install his 
own instance of the Plug-in for PPM and each instance of the Plug-in for PPM should be installed 
in a different destination folder. In order to install an instance in a different destination folder, you 
cannot run the silent installation but must run the installation using the InstallShield wizard (see 
"Installation Instructions" on page 197).

To install the Plug-in for PPM silently:

 1.  If Microsoft Project is open, exit Microsoft Project.

 2.  After you install and configure PPM Center, log on to PPM Center.

 3.  From the menu bar, select Open > Administration > Download Microsoft Project Plug-in.

The File Download dialog box opens and prompts you to indicate whether you want to run or save 
the setup.exe file. 

 4.  Click Save. 

 5.  From your system, run the setup.exe installer by typing the following:

setup.exe  /s  /v"/qn"

Parameters for Silent Installation

You can use parameters to specify whether the plug-in is installed for all users or only for the current 
user on a Windows-based computer. Table "Table 10-1. Parameters for silent installation" below 
describes the details of these parameters.

Parameter Description Valid and Default Values

INSTALLDIR Specifies installation  When "ALLUSERS" on the next page is null, the 
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Parameter Description Valid and Default Values

directory of the plug-
in.

installation directory is set to:

%USERPROFILE%\Application Data\Hewlett-
Packard\HP PPM Center Add In for MS Project\

When "ALLUSERS" below is 1, the installation directory is 
set to the common program files folder, for example, 
C:\Program Files\Hewlett-Packard\HP PPM Center 
Add In for MS Project\

ALLUSERS Determines whether 
the plug-in is installed 
for all users or for the 
current user.

Setting to 1 enables 
all users to use the 
plug-in.

Valid values: 1, or null

Default:

Null, meaning that only the current user can use the plug-
in.

Table 10-1. Parameters for silent installation, continued

To start the silent installation of the plug-in, run the following command together with the parameters in 
a command-line prompt:

setup.exe /s /v"/qn <parameter1> <parameter2>" 

Caution:  If you have to change the default installation directory when the "ALLUSERS" above 
parameter is set to 1, you must set the INSTALLDIR parameter to a directory that all users can 
access, for example, C:\Program Files.

Examples

 l The following command enables all users to use the plug-in:

setup.exe /s /v"/qn  ALLUSERS=1"

This command does not specify the installation directory, meaning that the plug-in is installed to the 
common program files folder, for example: 
C:\Program Files\Hewlett-Packard\HP PPM Center Add In for MS Project\

 l The following command enables all users to use the plug-in. Also, the command specifies the 
installation directory to C:\PPMCenter. (Make sure that all users can access the C:\PPMCenter 
directory.)

setup.exe /s /v"/qn INSTALLDIR=\"C:\PPMCenter\" ALLUSERS=1"

 l The following command installs the plug-in to the C:\APPSYS\PPMProject\ folder. Only the current 
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user can use the plug-in.

setup.exe /s /v"/qn INSTALLDIR=\"C:\APPSYS\PPMProject\""

 l The following command installs the plug-in to the default installation directory. Only the current user 
can use the plug-in.

setup.exe /s /v"/qn"

Upgrading the Plug-in for PPM

After installing the Plug-in for PPM, if you downgrade Microsoft Project (from 2013 to 2010 or 2007) or 
upgrade Microsoft Project (from 2007 or 2010 to 2013), you must remove and then re-install the Plug-in 
for PPM. See "Removing the Plug-in for PPM" on the next page for more information about removing 
the Plug-in for PPM.

If you upgrade PPM Center, you must upgrade the Plug-in for PPM. If you have problems upgrading the 
Plug-in for PPM, try removing then re-installing the Plug-in for PPM. You may need administrator 
privileges to remove the older version of the Plug-in for PPM.

If you have installed the Plug-in for PPM from PPM Center version 9.40 or later, when you log in to 
PPM Center from the Plug-in for PPM, the Plug-in for PPM determines if an upgrade is needed. A dialog 
displays a message if an upgrade to the Plug-in for PPM is suggested or required. If an upgrade is 
suggested, you may continue to use the existing version of the Plug-in for PPM or you may upgrade it. 
If an upgrade is required, you will not be able to use the Plug-in for PPM until the upgrade is completed.

To upgrade the Plug-in for PPM:

 1.  If Microsoft Project is open, exit Microsoft Project.

 2.  Log on to PPM Center.

 3.  From the menu bar, select Open > Administration > Download Microsoft Project Plug-in.

The File Download dialog box opens and prompts you to indicate whether you want to run or save 
the setup.exe file. 

 4.  Click Run. 

Note:  If the upgrade requires you to have administrator privileges (to remove the Plug-in for 
PPM) and you do not have these privileges, the installer exits. You must have an 
administrator remove the older version of the Plug-in for PPM and then you can install the 
Plug-in for PPM.
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If you are upgrading the Plug-in for PPM that was installed from PPM Center version 9.40 or 
later, you do not need administrator privileges to upgrade the Plug-in for PPM.

 5.  Select a setup language and click OK.

The InstallShield wizard starts up.

 6.  On the Welcome page, click Next.

 7.  In the next dialog, select Yes to update to the newer version.

If you are downgrading to an older version of the Plug-in for PPM, you must first remove the 
current version. Click OK and then Finish to exit the installer.

If you are installing the same version of the Plug-in for PPM, you are given the option to repair or 
remove the Plug-in for PPM.

If the version of the installed Plug-in for PPM cannot be determined, click Next to remove the 
existing Plug-in for PPM and install the listed version of the Plug-in for PPM. Or, click Cancel to 
exit the installer.

 8.  Click Next.

The Ready to Install the Program page opens.

 9.  Click Install.

 10.  After installation is completed, on the InstallShield Wizard Completed page, click Finish.

Removing the Plug-in for PPM
You can remove the Plug-in for PPM using your workstation's standard Add/Remove Programs utility. 
Microsoft Project should be closed during this operation.

If you are removing a version that was installed from PPM Center version 8.00 or earlier, you must have 
administrator privileges to remove it.

Synchronization Modes
By synchronizing information between Project Management and Microsoft Project, you have the 
advantage of using the best of both possible worlds. Depending on your project management strategy, 
you can use one application to perform all planning and tracking activities, and then use the other for 
publishing project information to managers, participants and stakeholders, or use both to share control 
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of different aspects of the project. See "Project Management Strategies" on page 230 for more 
information about different project management strategies.

The project manager can select from three synchronization modes for updating information between 
Project Management and Microsoft Project:

 l "Project Management-Controlled" below

 l "Microsoft Project-Controlled" below

 l "Shared Control" on the next page

Each mode offers a different strategy for communication between the two applications and has its own 
set of advantages.

The synchronization mode for the project should be configured based on your preferences. See 
"Project-Level Settings for Integration" on page 232 and "Setting a Synchronization Mode for Project 
Management and Microsoft Project" on page 234 for more information.

Project Management-Controlled

The project manager initially creates a work plan in Project Management to perform planning and 
tracking activities. These activities include defining the project, scheduling tasks, and tracking actuals. 
The first time the project is synchronized, Project Management creates a new project file on the project 
manager's desktop computer. For each subsequent synchronization, all of the information in the 
Microsoft Project file is replaced with the current information in Project Management.

Even if you want to manage your work plan using Project Management, you can create it initially in 
Microsoft Project.

After synchronization, the project manager can distribute the Microsoft Project file or use it to run 
reports for managers and other people in the organization. 

Microsoft Project-Controlled

The project manager creates a project in Microsoft Project to perform project planning and tracking 
activities. Information unique to PPM Center can be added within Project Management, such as 
notifications, task notes, or references to related entities within PPM Center. These references can 
provide information back to the project manager.
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For all subsequent synchronizations, information in Project Management is updated with current 
information from Microsoft Project. Information added in Project Management, such as notification 
configurations or activity or role associations, is retained.

Shared Control

The project manager plans and schedules the project in Microsoft Project while using Project 
Management to track actuals. Participants in the project directly report actuals data using the My 
Tasks portlet or a time sheet. Each subsequent synchronization updates the Microsoft Project file with 
actuals data from Project Management. The Project Management work plan is updated with changes to 
its structure or schedule from Microsoft Project.

Synchronizing Project Management and Microsoft 

Project

How information is synchronized between Project Management and Microsoft Project is based on the 
type of information and the synchronization mode. There are two types of information involved in the 
integration: 

 l Application-specific information. This is information that is unique to either Project Management 
or Microsoft Project. Information is recognized by one application but there is no equivalent 
information in the other application. 

For example, Project Management can reference requests and packages, but there is no equivalent 
type of information in Microsoft Project. Therefore, requests and packages are not synchronized. 
Likewise, Microsoft Project references resource cost rates but how this information is defined and 
used is different than cost rates in Project Management. Therefore, Microsoft Project resource cost 
rates and Project Management cost rates are not synchronized.

Application-specific information is neither updated nor deleted during synchronization.

Note:  If a task is deleted during synchronization, all information specifically associated with 
the task is deleted.

 l Shared information. This is information that can be tracked by both applications such as planned 
and actuals information. 

Project Management User’s Guide
Chapter 8: Integrating Project Management with Microsoft Project

HPE Project and Portfolio Management Center (9.40) Page 204 of 292



Planned information is the information determined before work begins on a task. This type of 
information includes task names, task sequence, work breakdown structure, assigned resources, 
scheduled start and finish dates, scheduling constraints, scheduled duration, and scheduled effort.

Actuals information is the collection of metrics detailing how much time and effort are actually 
required to complete tasks. This type of information includes actual start and finish dates, actual 
durations of tasks, actual effort, estimated totals, estimated remaining, percent complete, 
estimated finish date, and estimated effort remaining.

"Table 10-2. How information is synchronized, by information type and synchronization mode" below 
and "Figure 10-1. How information is synchronized" on the next page show the type of information and 
how it is synchronized based on the synchronization mode.

 
Project Management-
Controlled Shared Control

Microsoft Project-
Controlled

Information 
Specific to 
PPM 
Center

Work plan information in 
Project Management is 
not altered

Work plan information in 
Project Management is not 
altered, PPM Center 
dependencies on external 
tasks are not preserved 
with synchronization

Work plan information in 
Project Management is not 
altered, PPM Center 
dependencies on external 
tasks are not preserved with 
synchronization

Information 
Specific to 
Microsoft 
Project

Project information in 
Microsoft Project is not 
altered

Project information in 
Microsoft Project is not 
altered

Project information in 
Microsoft Project is not 
altered

Shared 
Planned 
information 

Project Management 
work plan planned 
information is used to 
update Microsoft Project

Microsoft Project planned 
information is used to 
update the Project 
Management work plan

Microsoft Project planned 
information is used to 
update the Project 
Management work plan

Shared 
Actuals 
information 

Project Management 
work plan actuals 
information is used to 
update Microsoft Project; 
actuals for contributors 
are not synchronized

Project Management work 
plan actuals information is 
used to update Microsoft 
Project; actuals for 
contributors are not 
synchronized

Microsoft Project actuals 
information is used to 
update the Project 
Management work plan

Table 10-2. How information is synchronized, by information type and synchronization mode
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Figure 10-1. How information is synchronized

 

Fields Mapped Between Applications

The following fields are mapped between Project Management and Microsoft Project, grouped by 
information type (planned and actuals information). All fields are task-level fields unless otherwise 
noted. See "Impact of Microsoft Project Rules on Fields" on page 208, "How Information is 
Synchronized" on page 210, and "Conditional Editing Allowed in Project Management" on page 274 for 
additional considerations about mapping fields.

Project Management 
Field

Microsoft 
Project Field Additional Information

Planned information

Milestone Milestone Milestones retrieved from Microsoft Project must be 
manually set to 100% complete in Project Management. 
Milestones retrieved from Project Management do not 
require updates. See "Planned Information" on page 210 
also .

Predecessor Predecessor See "Planned Information" on page 210, "Planned 
Information" on page 210, "Planned Information" on 
page 210, and "Planned Information" on page 210.

Priority Priority See "Planned Information" on page 210.

Resources Resources See "Planned Information" on page 210.

Scheduled Duration Duration Microsoft Project recalculates duration so that Start, 
Finish, and Duration are valid. However, if a task is of a 
fixed duration, only Start and Finish are recalculated. 

Table 10-3. Fields mapped between PPM Project Management and Microsoft Project
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Project Management 
Field

Microsoft 
Project Field Additional Information

See also "Planned Information" on page 210.

Scheduled Effort Work Scheduled Effort (measured in days) is converted to 
Work (measured in hours) using the calendar option 
Hours per day in Microsoft Project.

Scheduled Effort 
(resource-level)

Work 
(resource-level)

For tasks with more than one assigned resource, the 
amount of Scheduled Effort/Work assigned to each 
resource is synchronized.

Scheduled Start Date Start See "Scheduled Start and Scheduled Finish Dates" on 
page 214, "Planned Information" on page 210, "Planned 
Information" on page 210, and "Planned Information" on 
page 210.

Scheduled Finish Date Finish See "Scheduled Start and Scheduled Finish Dates" on 
page 214, "Planned Information" on page 210, "Planned 
Information" on page 210, and "Planned Information" on 
page 210.

Scheduling 
Constraint/Constraint 
Date

Constraint 
Type/Date

See "Planned Information" on page 210 and "Planned 
Information" on page 210.

Task Name Task Name See "Planned Information" on page 210 and "Planned 
Information" on page 210.

Actuals information

% Complete Percent 
Complete

See "Percent Complete and Percent Work Complete" on 
page 218, "% Complete When Initializing an Project 
Management Work Plan from an Existing Microsoft 
Project Work Plan" on page 218, and "% Complete for 
Tasks that are Cancelled or On Hold (Bypassed)" on 
page 218.

Activity Custom See "Project Management Activity Synchronization" on 
page 243.

Actual Duration Actual Duration See  "Actual Duration for Tasks" on page 219and "Actual 
Duration for Summary Tasks/Task Groups" on 
page 219.

Actual Effort Actual Work If any type of effort is tracked in PPM Center, the link in 
Microsoft Project between Percent Complete and 
Percent Work Complete is disabled. See also  "Actual 

Table 10-3. Fields mapped between PPM Project Management and Microsoft Project, con-
tinued
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Project Management 
Field

Microsoft 
Project Field Additional Information

Effort/Actual Work and Resource Units" on page 220 
and "Actual Effort and Time Management Integration" on 
page 220.

Actual Start Actual Start When this date exists, Microsoft Project defaults Start 
to this date. See also "Actual Start and Actual Finish" on 
page 221 and "Actual Start of a Task Group" on 
page 221.

Actual Finish Actual Finish When this date exists, Microsoft Project defaults Finish 
to this date. See also "Actual Start and Actual Finish" on 
page 221.

Estimated Finish Date Finish See "Estimated Finish Date" on page 221.

Estimated Remaining 
Effort

Remaining 
Work

 

Task Description and 
Notes

Notes (for 
tasks)

See "Microsoft Notes Synchronization" on page 241.

User-defined Custom See "Microsoft Field Mapping" on page 238.

Table 10-3. Fields mapped between PPM Project Management and Microsoft Project, con-
tinued

Impact of Microsoft Project Rules on Fields

Microsoft Project maintains internal rules that determine the way field values are calculated in planning 
and actuals fields. These rules affect the synchronization processes between Microsoft Project and 
Project Management because calculations that work in one application do not necessarily carry over to 
the other application.

For example, Project Management allows you to retain actuals information that is completely separate 
from your schedule information. In Microsoft Project, this is not allowed, and making updates to one 
actuals field may trigger automatic revisions to other planning and actuals fields.

The most common Microsoft Project rules for planning and actuals fields are listed below.

Planning Fields

 l Start + Duration = Finish

 l Effort = Duration * (sum of resources * units)

Actuals Fields
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 l Start = Actual Start (if known)

 l Finish = Actual Finish (if known)

 l Duration = Actual Duration + Remaining Duration

 l % Complete = Actual Duration / Duration

 l Remaining Duration is zero when task is 100% Complete

 l Effort = Actual Effort + Remaining Effort

 l % Work Complete = Actual Effort / Effort

When Project Management information is passed to Microsoft Project, Microsoft Project will always 
apply its standard rules. This will lead to situations where the data in each application does not match 
exactly.

Solutions for Project Managers

In order to give consistent behavior during synchronization, PPM Center project managers must:

 l Pay attention to fields that have changed. The integration provides a custom Microsoft Project table 
view that shows the user which fields have changed as a result of a synchronization, whether 
directly through the synchronization process, or indirectly as a result of Microsoft Project's 
automatic calculations.

 l Synchronize the fields that are most important to your plan management by selecting the 
appropriate actuals integration option as described in "Transferring PPM Center Information to 
Microsoft" on page 236.

The integration ignores Project Management default values that are not enabled.

Custom Microsoft Project Filters and Tables

After synchronizing project information between applications, you can select from the following custom 
Microsoft Project items provided by the integration:

 l A filter named PPM: Changed Actuals, found in the View tab and by selecting the Filter drop-
down menu

 l A filter named PPM: Dates Impacted by Changed Actuals

 l A data view table named PPM: Changed Actuals, found in the View tab and by selecting the 
Tables drop-down menu
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These items enable you to quickly view the following:

 l Fields that have scheduled date changes as a result of the actual synchronization. These field 
values appear red by default.

 l Fields that have changed as a result of automatic calculations performed by Microsoft Project 
based on synchronized fields. These field values appear blue by default. This is useful for 
identifying any cascading impacts of a change in actuals.

How Information is Synchronized

When you synchronize Microsoft Project with Project Management, you are updating information in 
Microsoft Project with information from Project Management. The information that is updated depends 
on the synchronization mode. In Project Management-controlled mode, both planned and actuals 
information in Microsoft Project is updated with information from Project Management. In shared 
control mode, only actuals information in Microsoft Project is updated with information from Project 
Management.

When you synchronize Project Management with Microsoft Project, you are updating information in 
Project Management with information from Microsoft Project. The information that is updated depends 
on the synchronization mode. In Microsoft Project-controlled mode, both planned and actuals 
information in Project Management is updated with information from Microsoft Project. In shared 
control mode, only planning information in Project Management is updated with information from 
Microsoft Project.

In some cases, fields in Project Management are not mapped exactly to fields in Microsoft Project or 
vice versa. The following sections, broken down by information type (planned or actuals), provide 
additional considerations about the mapped fields during synchronization.

Planned Information

In Project Management-controlled mode, planned information in Microsoft Project is updated with that 
in Project Management. In Microsoft Project-controlled mode and shared control mode, planned 
information in Project Management is updated with that in Microsoft Project.

Major Milestones

In Project Management, you can create major milestones. Microsoft Project does not have this ability. 
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In Project Management-controlled mode, major milestones are synchronized as standard milestones in 
Microsoft Project.

Predecessor Relationships Between Tasks

All predecessor relationships between tasks are synchronized. Both Project Management and 
Microsoft Project support Finish-Start, Start-Finish, Start-Start, and Finish-Finish predecessor 
relationships between tasks. 

A Microsoft Project predecessor relationship may have a lag or lead (a positive or negative offset to the 
normal predecessor relationship). Microsoft Project adjusts the start and finish dates of the successor 
task accordingly. Project Management supports the lag and lead offsets. 

In Microsoft Project-controlled mode and shared control mode, the adjusted start and finish dates are 
synchronized. to the Project Management scheduled start and scheduled finish dates.

In Project Management-controlled mode, scheduled start and finish dates are synchronized from 
Project Management to Microsoft Project but may be adjusted by Microsoft Project.

Note:  A project in Project Management is considered task 1 while the root task grouping in 
Microsoft Project is task 0. Because the two applications start tasks from a different number, the 
task numbers in Microsoft Project are off by one compared to the task numbers in Project 
Management. While the task numbering is off by one, the predecessor relationships between 
tasks are identical.

Predecessor Relationships with External Tasks (or Separate Projects)

Project Management supports predecessor relationships with dependencies on external tasks (for 
example, a task from a separate project) while Microsoft Project does not. 

In Project Management-controlled mode, the task with the dependency on an external task is 
synchronized, but the dependency on the external task is not synchronized.(Microsoft Project ignores 
the dependency).

In Microsoft Project-controlled mode and shared control mode, if dependencies are added between 
projects in Project Management, these dependencies are lost during synchronization.

If the synchronization mode is changed from Project Management-controlled mode to Microsoft 
Project-controlled or shared control mode, the dependency on the external task is lost. The task with 
the dependency is recognized by Microsoft Project, but the dependency is not.
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Predecessor (Blocking) Relationships with Requests

Microsoft Project cannot add dependencies on requests. In Project Management-controlled mode and 
shared control mode, predecessors on requests in Project Management are synchronized but ignored 
by Microsoft Project.

Incomplete Finish-Finish Predecessor Relationships with Requests

When an Project Management task has a Finish-Finish predecessor relationship with an open Demand 
Management request, the task can be 100% complete but not fully finished. Referenced tasks of this 
open request acquire a Complete (Pending Request) status in Project Management until the request 
is completed. Microsoft Project does not support Finish-Finish predecessor relationships with 
requests.

In Project Management-controlled mode and shared control mode, when synchronizing tasks in this 
condition, Microsoft Project reports the task percent complete as 100%. Finish-Finish predecessor 
relationships on requests in Project Management are synchronized but ignored by Microsoft Project 
because Microsoft Project cannot add dependencies on requests.

Priority

If the Priority field for a task in Project Management is set to greater than 1,000, when the work plan 
information is sent to Microsoft Project, the priority is set to 1,000. Neither Project Management nor 
Microsoft Project allow a task priority to be greater than 1,000.

Resources 

In project planning, the concept of resources can have multiple definitions. A resource can be a team 
member, time on a mainframe computer, or construction materials. A resource in Project Management 
is an Project Management user capable of performing tasks. Resources are chosen from the staffing 
profile associated with the project, from the resource pools managed by the project manager, or from 
any resource pool when the RM_OVERRIDE_ASSIGNMENT_CONTROLS parameter is set to TRUE. Microsoft 
Project supports tracking and costing of both human and material resources. Project Management 
supports only human resources.

A project can contain resources that have not been assigned. In Microsoft Project, unassigned 
resources appear in some resource-centric project views but have little functional significance. In 
Project Management, unassigned resources are Project Management users listed in the staffing profile 
who have no task assignments.
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In Project Management-controlled mode, resource mapping is determined by the Microsoft Project 
Integration policy settings. See "Transferring PPM Center Information to Microsoft" on page 236 for 
more information.

In Microsoft Project-controlled mode and shared control mode, during synchronization, all assigned 
human resources in Microsoft Project are mapped automatically to defined users in Project 
Management. Automatic resource mapping is based on the following factors, in order of precedence:

 l A match between the Microsoft Project resource name and the Project Management username.

 l A match between the Microsoft Project resource name and the concatenation of the Project 
Management user's first and last name.

 l A match between the Microsoft Project resource name and the concatenation of the Project 
Management user's last and first name.

Note:  The order of precedence determines the mapping and the mapping process for a resource 
stops when a match is found. For example, when a resource name matches an Project 
Management user by username, the mapping process for that specific resource is stopped (no 
comparison is done by first/last or last/first names). The mapping process continues for the next 
resource name.

In general, the following should be taken into consideration:

 l PPM Center does not automatically create users for unmatched resources. The project manager 
should note the list of unmatched resources and work with his system administrator to create these 
users.

 l In Project Management, the mapping does not guarantee that all assigned resources are part of the 
staffing profile. If the staffing profile needs to be maintained, then this must be done manually.

 l Material resources are not passed to Project Management.

 l Microsoft Project does not allow commas in resource names.

 l Automatic resource mapping is not always 100% successful. The integration allows you to 
manually map resources across applications, or intentionally unmap resources that are irrelevant or 
have been erroneously mapped. This manual adjustment occurs as part of the synchronization 
process or can be run from the PPM Center menu (see "Manually Mapping Resources Between 
Applications (Shared Control Mode and Microsoft Project-Controlled Mode)" on page 269 and 
"Manually Mapping Enterprise Resources Between Applications " on page 272 for more 
information). 
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Resources: Summary Task Owner

In PPM Center, a resource called a summary task owner is a person named on summary tasks who 
has oversight over that section of the work plan.

In Microsoft Project, while there is no specific field named summary task owner, the concept of a 
summary task owner exists. That is, in Microsoft Project, a Microsoft Project resource assigned as the 
owner of a summary task can be considered a summary task owner.

Therefore, when resources are synchronized, a summary task owner in PPM Center may be mapped to 
a resource in Microsoft Project or a resource in Microsoft Project may be mapped to a summary task 
owner in PPM Center.

Scheduled Duration for Tasks

Project Management and Microsoft Project calculate scheduled duration differently. Both calculations 
are based on scheduled start and scheduled finish dates (in Microsoft Project, if a task has a fixed 
duration, the start and finish dates are recalculated). Each calculation can also be affected by resource 
calendars and how hours per day in the work schedule is defined. 

Because Project Management and Microsoft Project do not synchronize resource calendars, you may 
see discrepancies in a task's scheduled duration. See "Other Synchronization Considerations" on 
page 222 for more information.

Project Management uses a 10 hour/day work schedule. Most Microsoft Project plans are built using an 
8 hour/day work schedule. In general, Project Management considers a Microsoft Project task to have 
ended two hours before the end of the work day. (Although the Microsoft Project interface does not 
display the start and finish times, this information is tracked in order to allow tasks with durations less 
than one whole day.) Tasks in Microsoft Project are shown in Project Management as .2 days shorter.

When rescheduling the project in Project Management, the .2 days (or two hour) difference can have an 
impact. The Project Management scheduling algorithm attempts to compact your plan to use up all 
available time, including the apparently unused two hours at the end of tasks. To prevent this, the 
project manager should make the durations whole numbers only, for the portions on the project plan that 
are rescheduled using Project Management.

Scheduled Start and Scheduled Finish Dates

In Project Management, a task can have actual start and actual finish dates that are earlier or later than 
the scheduled start and scheduled finish dates. In Microsoft Project, if a task has an actual start or 
finish date earlier or later than the scheduled dates (start/finish), the scheduled dates are automatically 
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overridden. For example, if a task was scheduled to start on May 1st but is reported to have actually 
started on May 2nd, Microsoft Project automatically changes the task scheduled start date to May 2nd.

In Project Management-controlled mode, both the actual and scheduled dates are updated in Microsoft 
Project. After synchronization, Microsoft project adjusts the scheduled dates according to its rules. 
After this adjustment, the scheduled dates in Microsoft Project may not match the scheduled dates in 
Project Management.

In shared control mode, Actual dates are updated in Microsoft Project and scheduled dates are updated 
in Project Management. After synchronization, Microsoft project adjusts the scheduled dates according 
to its rules. After this adjustment, the scheduled dates in Microsoft Project may not match the 
scheduled dates in Project Management.

In Microsoft Project-controlled mode, both the actual and scheduled dates are updated in Project 
Management. Because Project Management does not automatically adjust dates, the scheduled dates 
in Project Management match the scheduled dates in Microsoft Project.

Resource Leveling: Split Tasks

A split task is work on a task in Microsoft Project that is scheduled to start and stop multiple times 
(multiple start and finish dates) because a resource has been overallocated. Project Management 
tracks a task with a single start and finish date.

Tasks may be split automatically (instead of resource units being adjusted) based on settings in the 
Microsoft Project resource leveling feature. Therefore, in Project Management-controlled mode, a split 
task may automatically be generated in Microsoft Project during synchronization.

In Project Management-controlled mode, if a split task is generated, the scheduled start date is 
synchronized to the earliest Microsoft Project split start date. Likewise, the scheduled finish date is 
synchronized to the latest Microsoft Project split finish date. Scheduled duration is recalculated 
according to these dates.

In Microsoft Project-controlled mode and shared control mode, the earliest split start date is 
synchronized to the Project Management scheduled start date. And, the latest split finish date is 
synchronized to the Project Management scheduled finish date. The Project Management scheduled 
duration is synchronized to the Microsoft Project duration.

In Microsoft Project-controlled mode and shared control mode, the earliest split start date is 
synchronized to the Project Management scheduled start date. And, the latest split finish date is 
synchronized to the Project Management scheduled finish date. The Project Management scheduled 
duration is synchronized to the Microsoft Project duration.
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Resource Leveling: Delayed Tasks

A delayed task is work on a task in Microsoft Project that is scheduled to start at a later time because a 
resource has been overallocated and cannot start the task until this time. Project Management tracks a 
task's scheduled start date and actual start date.

Tasks may be delayed automatically based on settings in the Microsoft Project resource leveling 
feature. Therefore, in Project Management-controlled mode, a delayed task may automatically be 
generated in Microsoft Project during synchronization.

In Project Management-controlled mode and shared control mode, if a delayed task is generated, the 
scheduled start date is synchronized to the Microsoft Project delayed start date. Likewise, the 
scheduled finish date is synchronized to the Microsoft Project delayed finish date.

In Microsoft Project-controlled mode, the delayed start date is synchronized to the Project 
Management scheduled start date and the delayed finish date is synchronized to the Project 
Management scheduled finish date.

Microsoft Project Work Contours

A Microsoft Project work contour controls the work schedule of a resource.  Project Management does 
not include a similar feature. 

In Microsoft Project-controlled mode and shared control mode, the start and finish dates of a schedule 
with a work contour are simply synchronized to the Project Management scheduled start and 
scheduled finish dates.

Alternatively, a project manager can create a similar project plan without a work contour by dividing the 
task into several subtasks that have distinct non-contoured assignments. This gives better visibility 
from project views and is easier to explain to resources.

Scheduling Constraints

Both Project Management and Microsoft Project define a scheduling constraint by a constraint type and 
a constraint date. Some constraint types (for example, as soon as possible) do not require a 
constraint date. 

In Project Management-controlled mode and shared control mode, all     Project Management 
scheduling constraints are synchronized in Microsoft Project.

In Microsoft Project-controlled mode, all Microsoft Project scheduling constraints are synchronized in 
Project Management.
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Scheduling Constraints and Unscheduled Project Management Projects

Project Management evaluates scheduling constraints selectively when the project manager chooses 
to schedule all or part of the project. The project manager may choose to leave the project dates out of 
compliance with a defined scheduling constraint instead of adjusting the project plan definition to 
comply with a constraint. However, Microsoft Project (in automatic calculation mode) automatically 
shifts a task to comply with a scheduling constraint. 

During synchronization, and only when the synchronization mode is Project Management-controlled, 
Microsoft Project is placed in manual calculation mode. In manual calculation mode, Microsoft Project 
does not force the project dates to meet its scheduling rules for task relationships.

To change the calculation mode in Microsoft Project, click Tools > Options and select the 
Calculation tab.

Task Names for Cancelled or On Hold (Bypassed) Tasks

While Microsoft Project includes tasks with statuses, Microsoft Project does not have as many distinct 
statuses as Project Management. For example, in Microsoft Project, all unstarted tasks share a 
common state and there are no task statuses to recognize tasks that have been cancelled or 
bypassed. Also, Microsoft Project does not distinguish between tasks that are pending predecessors, 
tasks that are ready, and tasks in progress where no percent complete has been reported.

In Project Management-controlled mode and shared control mode, when a cancelled or bypassed 
Project Management task is synchronized, the word Cancelled or Bypassed is prepended to the task 
name in Microsoft Project to indicate the task status.

See  "% Complete for Tasks that are Cancelled or On Hold (Bypassed)" on the next page for information 
on how % complete is calculated for cancelled and bypassed tasks in Microsoft Project.

Unnamed Tasks

Microsoft Project allows unnamed tasks while Project Management does not. 

In Microsoft Project-controlled mode and shared control mode, during synchronization, tasks that do 
not have names in Microsoft Project are assigned default names such as MS Blank Task #1. The 
project manager should review and update these names. After synchronization, unnamed tasks appear 
in the Warnings tab of the Show Info dialog (from Microsoft Project, click Show Info).
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Actuals Information

In Project Management-controlled mode and shared control mode, actuals information in Microsoft 
Project is updated with that in Project Management. In  Microsoft Project-controlled mode, actuals 
information in Project Management  is updated with that in Microsoft Project.

Percent Complete and Percent Work Complete

In Microsoft Project, if work is not tracked, percent work complete defaults to percent complete (they 
are the same value). If work is tracked (for example, the task has a work contour), percent complete 
and percent work complete are calculated differently. For information about the difference, see "Impact 
of Microsoft Project Rules on Fields" on page 208.

% Complete When Initializing an Project Management Work Plan from an Existing 

Microsoft Project Work Plan

If you are converting an existing Microsoft Project work plan to Project Management or creating a new 
Project Management work plan based on an existing Microsoft Project work plan (that is, you have an 
existing Microsoft Project work plan with actuals that you want to use to create an Project 
Management-controlled or shared control work plan), you may see different values for percent complete 
between Project Management and Microsoft Project.

At the summary task level, during synchronization, Project Management recalculates roll-up 
information such as duration of each task and percent complete. Duration is based on the base and 
resource calendars. If these calendars differ between the two applications, the durations will also differ 
resulting in different percent complete values.

At the task level, if work is not being tracked in Microsoft Project, Project Management synchronizes 
percent complete with Microsoft Project's percent work complete. If work is being tracked in Microsoft 
Project, Project Management synchronizes percent complete with Microsoft Project's percent 
complete (see "Percent Complete and Percent Work Complete" above).

At the resource level, Project Management synchronizes percent complete with Microsoft Project's 
percent work complete.

% Complete for Tasks that are Cancelled or On Hold (Bypassed)

While Microsoft Project includes tasks with statuses, Microsoft Project does not have as many distinct 
statuses as Project Management. For example, in Microsoft Project, all unstarted tasks share a 
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common state and there are no task statuses to recognize tasks that have been cancelled or 
bypassed. Also, Microsoft Project does not distinguish between tasks that are pending predecessors, 
tasks that are ready, and tasks in progress where no percent complete has been reported.

In Project Management-controlled mode and shared control mode, bypassed tasks are synchronized 
as 100% complete. If any actuals are reported, this information is also synchronized. The bypassed 
status indicates that some effort may have been spent, but that work was discontinued.

In Project Management-controlled mode and shared control mode, cancelled tasks are synchronized as 
100% complete and with zero duration. Microsoft Project automatically omits these tasks from the 
Gantt Chart view.

Actual Duration for Tasks

Both Project Management and Microsoft Project calculate actual duration for tasks based on actual 
start and actual finish dates. But, because Project Management and Microsoft Project do not 
synchronize resource calendars, you may see discrepancies in a task's actual duration. See "Other 
Synchronization Considerations" on page 222 for more information.

Actual Duration for Summary Tasks/Task Groups

Project Management and Microsoft Project do not have the same functionality for the actual durations 
of summary tasks or task groups that are still in progress. Project Management calculates actual 
duration from the rolled-up values for actual start and actual finish dates. Microsoft Project presents the 
actual duration to date as a tentative value. Therefore, actual durations of some Microsoft Project task 
groups are not synchronized with actual durations of summary tasks in Project Management.

In Project Management-controlled mode, when a project is initially opened, the status of the project is 
In Planning. Roll-up values are not calculated when the project's status is In Planning. Roll-up 
values are calculated when the project's status changes to Active and is saved. When the project's 
status changes to Active and is saved, Project Management has the same actual duration value as 
Microsoft Project.

In Microsoft Project-controlled mode and shared control mode, Project Management waits until the 
entire summary task is complete before calculating rolled-up values (to take into account any tasks that 
may have been added or deleted before the summary task completes). When the task grouping is 
completed in Microsoft Project, Project Management has the same actual duration value as Microsoft 
Project.
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Actual Effort/Actual Work and Resource Units

In Project Management, each resource on a task may be assigned different hours of effort for that task. 
The total effort for the task is the sum of the scheduled effort values for each resource. For example, if 
Fred is assigned to work 12 hours on a task, and Barbara is assigned to work 8 hours on the same task, 
then the total task effort would be (12 + 8 =) 20 hours.

Microsoft Project uses resource units to calculate actual work. Following the same example, if both 
Fred and Barbara are full-time resources in Microsoft Project, then they might have 60 and 40 resource 
units assigned on the task, respectively (depending on the task's duration). But if Barbara is only a half-
time resource in Microsoft Project, her resource units on the task would double (to 80), representing the 
same amount of work, which now takes a larger percentage of her capacity.

In Project Management-controlled mode and shared control mode, during synchronization, the hours of 
effort for each assigned resource on an Project Management task is automatically converted by 
Microsoft Project into the appropriate resource units for the assignment. If the resources involved are 
full-time resources in Microsoft Project, then their respective resource units for each task is 
proportional to their respective assigned effort values on the corresponding Project Management task.

In Microsoft Project-controlled mode, during synchronization, the resource units for each task 
assignment are automatically converted by Microsoft Project into hours of effort for the assigned 
resource on an Project Management task.

Actual Effort and Time Management Integration

In PPM Time Management, resources can enter actual effort for summary tasks and they can enter 
actual effort for tasks to which they are not assigned.

Actual effort that is entered in Time Management by a resource that is not assigned to the task is not 
synchronized to Microsoft Project. Microsoft Project recalculates effort roll-ups and these values do 
match those in PPM Center.

When effort is collected in Time Management at the summary task level, the actual effort at the leaf 
task level remains zero while the percent complete varies. The estimated remaining effort at the leaf 
task level remains at its full value until the task completes. If this data is transferred to Microsoft 
Project, the percent complete is zero until the task completes.

In Project Management-controlled mode or shared control mode, when actual effort is rolled up to the 
work plan from Time Management, if the actual effort has not been modified (no new time has been 
logged using a time sheet), the corresponding actual effort in the work plan is not updated. If the actual 
effort has been modified (new time has been logged using a time sheet), the corresponding actual effort 
in the work plan is updated.
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When a Microsoft Project work plan is sent to Project Management, both planned information and 
actuals are sent. If you create an Actual Time Summary report from PPM Center, the actuals in the 
report differ from the actuals displayed in the Project Management work plan (Actuals View).

Actual Start and Actual Finish

Synchronizing actual start and actual finish dates may affect Microsoft Project start and finish dates. 
See  "Scheduled Start and Scheduled Finish Dates" on page 214 for more information.

Actual Start of a Task Group

In Project Management, a task can have actual start and finish dates that are earlier or later than the 
scheduled dates. In Microsoft Project, if a task has an actual start or finish date earlier or later than the 
scheduled dates, the scheduled dates are automatically overridden. For example, if a task was 
scheduled to start on May 1st but is reported to have actually started on May 2nd, Microsoft Project 
automatically changes the task scheduled start date to May 2nd.

In Project Management-controlled mode, the start date of a task group in Microsoft Project may be later 
than some of its tasks. In Microsoft Project-controlled mode and shared control mode, the start date of 
a task group matches the earliest start date of its tasks.

In Project Management-controlled mode, during synchronization, Microsoft Project is placed in manual 
calculation mode. In manual calculation mode, Microsoft Project does not force the project dates to 
meet its scheduling rules for task relationships (Microsoft Project does not automatically roll up dates 
to task groups). Therefore, if the Project Management schedule start date for the summary task is later 
than the actual start dates of some tasks (because some tasks were started early), Microsoft Project 
updates the scheduled start dates of the tasks but not of the task group.

In Microsoft Project-controlled mode and shared control mode, during synchronization, Microsoft 
Project remains in automatic calculation mode. Microsoft Project automatically updates the scheduled 
start dates of the tasks and the task group.

Estimated Finish Date

While there is an estimated finish date in Project Management, there is no corresponding field in 
Microsoft Project. The estimated finish date in            Project Management is synchronized with the 
finish date in Microsoft Project since, in Microsoft Project, the start and finish dates are automatically 
updated to reflect actual dates and estimates as they become available. You can use the baseline 
feature to capture the original finish date for variance reporting.
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In Project Management-controlled mode, synchronizing the estimated finish date creates a constraint 
in Microsoft Project. When a specific value is entered as the finish date in Microsoft Project, the 
application assumes that the task should also be constrained to finish exactly on that date. When the 
finish date of a Microsoft Project task is synchronized to an Project Management estimated finish date, 
Microsoft Project implicitly creates a finish-no-earlier-than constraint with this same date.

In Microsoft Project-controlled mode and shared control mode, the Project Management estimated 
finish date is synchronized with the Microsoft Project finish date.

Other Synchronization Considerations

Cutting and Pasting Tasks

Cutting and pasting a task in Microsoft Project is the same as deleting a task and adding a new task 
with the same attributes. While the tasks may appear the same, the synchronization process does not 
recognize the pasted task to be the same as the cut task.

To verify the effects of editing a task (for example, cutting, pasting, or moving), display the Unique ID 
column in Microsoft Project. If, after editing the task, the Unique ID remains the same, the 
synchronization process recognizes the task as the same task. If the Unique ID changes, the 
synchronization process does not recognize the task as the same task.

Baseline Dates

Baseline information is not synchronized. The project baseline can be captured and maintained in either 
product, as the project manager prefers.

Blank Lines

During the synchronization, all blank lines are deleted from the Microsoft Project file. Notifications and 
warnings are not displayed nor logged when the blank lines are removed.

Calendars

The project regional calendar is exported to Microsoft Project in Project Management-controlled mode 
or any time an Project Management work plan is used to create a new plan in Microsoft Project. 
Calendar hours-per-day and work days per week are exported, but calendar exceptions are not.
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Resource calendars are not synchronized between the two applications. Since both duration and effort 
are a function of both start/finish dates and resource calendars, the duration values in Project 
Management and Microsoft Project might not match. (For example, a task spans five days. For that 
span of five days, the Project Management resource calendar is configured to have two of the days as 
non-working time. In Microsoft Project, this information is not configured in the resource calendar. 
Therefore, in Project Management, the actual duration is three days while in Microsoft Project, the 
actual duration is five days.) Since tasks in Microsoft Project are created as fixed duration in these 
cases, the total effort will match Project Management data. You do not need to maintain resource 
calendars in both applications.

Cost Roll-up and Health Calculations

When sending information from Microsoft Project to Project Management, roll-up of cost and health 
calculations is deferred in order to keep the synchronization process as efficient as possible.

Macros, VB Scripts, and Other Extensions

Macros, VB scripts, and other extensions should not be affected by the synchronization. However, it 
may be necessary to disable some extensions during synchronization (because the changes made 
using the Microsoft Project COM interface can trigger these extensions).

References

Microsoft Project does not support references therefore Project Management references are not 
synchronized to Microsoft Project.

Shared Resource Pools

A Microsoft Project work plan can be scheduled using a shared resource pool and synchronized with 
Project Management.

During synchronization, if the shared resource pool is not open, the synchronization may pause. A 
Microsoft Project dialog appears, asking if you would like to open the shared resource pool. To proceed 
with the synchronization, respond to the Microsoft Project dialog.

Units

Units are also referred to as resource load percentages. In Microsoft Project, each resource can be 
assigned to a task with a different load percentage (from zero percent to one hundred percent.) For 
example, the same resource could be assigned to two different tasks and have a resource load 

Project Management User’s Guide
Chapter 8: Integrating Project Management with Microsoft Project

HPE Project and Portfolio Management Center (9.40) Page 223 of 292



percentage of fifty percent for each one.

Since Project Management does not track assignment units, the load percentage of any resource 
imported into Project Management will not be recognized.

Conditional Editing Allowed in Project Management

"Table 10-4. Conditional editing allowed in Project Management" below summarizes the allowed or 
restricted conditional editing in Project Management for each of the three synchronization modes. Any 
function in Project Management that could change information controlled by Microsoft Project 
(including keyboard shortcuts) is disabled. See "Conditional Editing Allowed in Project Management" 
on page 274 for more information.

Fields in Project 
Management

Project Management-
controlled 

Microsoft Project- 
controlled 

Shared Control 
Mode

Work Plan page

Add/Delete Task icon Yes No No

Indent/Outdent Task 
icon

Yes No No

Move up/Move down 
Task icon

Yes No No

Schedule Project icon Yes No No

Task Details page

Planning fields Yes No No

Actuals fields Yes No Yes

Structure fields Yes No No

Other non-shared fields Yes Yes Yes

Status field Yes No Yes

Rollup

Schedule fields Yes No No

Actuals fields Yes No Yes

My Tasks portlet

Actuals fields Yes No Yes

Table 10-4. Conditional editing allowed in Project Management
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Choosing the Right Synchronization Mode

Each project manager can choose from one of three different synchronization modes for each project. A 
project manager may choose to use one, two, or all three synchronization modes for the projects he 
owns.

In general, HPE recommends using the Project Management-controlled mode, where Project 
Management is used for project planning and tracking actuals.

If you prefer to plan the project in Microsoft Project, Microsoft Project-controlled mode or shared control 
mode is recommended.

If you prefer to use Microsoft Project but actuals are tracked using PPM Time Management, shared 
control mode is recommended.

An organization may benefit from standardizing the use of a single synchronization mode. For example, 
if all projects are synchronized with Microsoft Project in the same manner, external stakeholders can 
have the same expectations about the timeliness of the project information presented in the PPM 
Dashboard.

The following examples show how the Plug-in for PPM can be used in different situations. For higher-
level scenarios, see "Project Management Strategies" on page 230.

Create a New Project Management Project Based on an 

Existing Microsoft Project Plan

A project manager planning a new project may want to create the new plan using Project Management 
but use an existing Microsoft Project plan as the starting point.

Because planning will be done in Project Management, the project manager should open the existing 
Microsoft Project plan in Project Management and select Project Management-controlled mode.

If the project manager wants to see or present the Project Management project in Microsoft Project 
views, the modified Project Management work plan can be synchronized to Microsoft Project.
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Display Existing Microsoft Project Plans in Project 

Management

If the stakeholders and participants are not familiar with Project Management, a gradual transition from 
active Microsoft Project projects to  Project Management projects is recommended. Planning and 
tracking actuals are done in Microsoft Project, but the project is viewed from the PPM Dashboard.

The project manager should open the existing Microsoft Project plan in Project Management and select 
Microsoft Project-controlled mode.

If any errors occur during the initial synchronization, a dialog displays these errors. To enable full 
information tracing for synchronization, see "Enabling Synchronization Logs" on page 253.

Convert Existing Microsoft Project Plans to Project 

Management Projects

If stakeholders and participants are familiar with Project Management, the project manager can choose 
to transition only tracking actuals or both planning and tracking actuals to Project Management.

If stakeholders and participants are only tracking actuals in Project Management, the project manager 
should open the existing Microsoft Project plan in Project Management and select shared control mode.

If stakeholders and participants are both planning and tracking actuals in Project Management, the 
project manager should open the existing Microsoft Project plan in Project Management and select 
Project Management-controlled mode.

Update a Microsoft Project Work Plan Hierarchy 

Integrated with Project Management

If a Microsoft Project work plan is integrated with Project Management, in shared control mode, 
Microsoft Project controls the work plan. However, some changes to the work plan hierarchy that are 
allowed in a Microsoft Project are not allowed in Project Management. 

If you convert a leaf task with actuals to a summary task in Microsoft Project, in shared control mode, 
integration with the Project Management work plan fails. Converting a leaf task with actuals to a 
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summary task is not allowed in Project Management as it may result in invalid data in Time 
Management.

If you experience an integration error related to the modification of the work plan hierarchy, use an 
existing backup copy as a starting point from which to reapply your most recent edits. See  "Backing Up 
Microsoft Project Files" on page 252 for more information about backups.

Augment Microsoft Project with Project Management 

Publishing

Similar to displaying existing Microsoft Project plans in Project Management, project managers can 
augment their Microsoft Project plans by publishing project information in Project Management to 
stakeholders and participants. In this situation, the project manager does not wish to transition from 
Microsoft Project to Project Management. However, the project manager would like to take advantage 
of the publishing capabilities of Project Management (for example, displaying project overviews and 
task assignments from the PPM Dashboard).

If stakeholders and participants plan and track actuals in Microsoft Project, the project manager should 
open the existing Microsoft Project plan in Microsoft Project-controlled mode.

If the project manager prefers to enter the actuals of participants (for example, the project manager 
collects actuals verbally or through email) in Microsoft Project, the project manager should open the 
existing Microsoft Project plan in Microsoft Project-controlled mode.

In this situation, the project manager should set stakeholders' expectations about project information in 
Project Management. Unlike projects controlled by Project Management, the project status information 
presented in Project Management may not always be current. For example, if the project manager 
collects and enters project actuals into Microsoft Project on a weekly basis, the project information 
presented in Project Management may be up to a week out of date. Project managers should 
communicate this to stakeholders.

Augment Microsoft Project by Collecting Actuals with 

Project Management

If a project manager wants to use advanced Microsoft Project functionality (for example, resource 
leveling with a shared resource pool) while providing up-to-date information to stakeholders and 
collecting actuals directly from participants using Project Management, the project manager should 
open a project in shared control mode.
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If the participants are not familiar with Project Management, the project manager should keep the 
collecting of actuals as simple as possible. The project manager should enable only a few actuals fields 
to be collected through Project Management. For example, a participant may be asked to update the 
status of his tasks by selecting from Ready,In Progress, or Complete. If early or late starts and 
finishes are common, the project manager can enable these actual fields to allow participants to 
directly communicate when work actually occurred. If these are uncommon events, the project 
manager may track these exceptions personally by changing the start and finish dates in Microsoft 
Project, avoiding the possibility of participants entering incorrect dates.

Although a Project Manager is used to thinking about tasks in terms of the time or duration worked, 
percent complete, remaining work, and so forth, most participants are not familiar with these concepts. 
The project manager should carefully plan how many and how quickly these concepts are introduced to 
participants.

Once participants become familiar with Project Management concepts, the project manager can collect 
a richer set of actuals. Many actuals, such as actual work performed, are a key to understanding 
performance and making progressive improvement.

Microsoft Project offers a wide range of actuals fields, which are tightly interrelated by automatic data 
integrity rules. Most project managers do not learn all of these automatic data integrity rules. Instead, 
they learn how to track the information that matters to them by making entries into only a few fields. 
When tracking actuals through Project Management, these are the fields that the project manager 
should enable in the PPM Dashboard.

Improved Search Result in Microsoft Project

In Microsoft Project, the project search result is presented in a more user-friendly manner where only 
projects for which you are the project manager are returned. Therefore, all the projects returned in the 
search result are accessible, meaning that you can open these projects from PPM Center, and send 
them to PPM Center.

Note:  To search projects in Microsoft Project, you must have the following access grants:

 l Project Mgmt: Edit Projects

 l Project Mgmt: Synchronize Work Plans
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Data Loss When Changing the Synchronization 

Mode

HPE strongly recommends that you do not change the synchronization mode of a project as it may 
result in the loss of data. Carefully consider the synchronization mode of a project before creating it.

Data can be lost when changing the synchronization mode in the following ways:

 l Active Loss occurs when data that was synchronized in the previous mode is not synchronized in 
the new mode. This data could be lost or overwritten. Tracking information is most susceptible to 
active loss. 

 l Passive Loss occurs when synchronization does not happen immediately before a synchronization 
mode change occurs. In this case, data that was entered since the last synchronization may be 
overwritten or discarded during synchronization in the new mode.

To change the synchronization mode, update the Integration Mode section in the project-level settings.

For additional information, see "Changing Synchronization Modes and the Project Calendar" on 
page 236.

Synchronizing Microsoft Project Information Stored 

in an SQL Server Database

If a project is stored in an ODBC source such as SQL Server database, do the following to synchronize 
the project to Project Management:

 1.  Open the project in Microsoft Project.

 2.  Select Save As to save the project to your local system.

 3.  Synchronize the saved Microsoft Project file to Project Management.

Note:  In order to synchronize a project to Project Management, the project must be in a file format. 
The binary MPP file format is recommended.
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Project Management Strategies
The following scenarios demonstrate how project managers can use different project management 
strategies offered by the integration. For additional scenarios, see "Choosing the Right Synchronization 
Mode" on page 225.

Publishing a Project Management Work Plan 

through Microsoft Project

A project manager who uses Project Management to manage projects can use the integration to publish 
the projects. Publishing can simply mean distributing the Microsoft Project file to external audiences 
(such as a Program Management Office group). Publishing could also mean synchronizing the 
Microsoft Project file with Project Management, and then running Microsoft Project reports for 
distribution. The projects can be published on a regular basis (weekly or quarterly) or at defined 
milestones (such as design completion).

To publish an Project Management work plan through Microsoft Project:

 1.  Open a blank file in Microsoft Project.

 2.  Open the Project Management work plan in Microsoft Project. (See  for detailed instructions.)

 3.  Save the project and run reports as usual.

After the first export, you may choose to synchronize the Project Management work plan with the 
Microsoft Project file in Project Management-controlled mode. This will effectively regenerate the 
Microsoft Project file.

This can also be used to recover a lost Microsoft Project file from a previously-synchronized Project 
Management work plan.
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Publishing a Microsoft Project File through Project 

Management

A project manager who uses Microsoft Project to manage projects can publish those projects using 
Project Management. You can create a work plan in Project Management from a work plan template 
and subsequently open it in Microsoft Project for further editing. This allows you to take advantage of 
any standards enforced by a PMO. Publishing means loading the project data into the Project 
Management repository, which has the following benefits:

 l The project status appears in the PPM Dashboard. Project Management calculates exceptions and 
health status (red/yellow/green) based on the project's policy settings.

 l Project participants and external audiences can see the project in various interfaces such as the My 
Tasks portlet and search pages. Although these participants cannot use Project Management to 
update project status, this is an effective way to increase visibility of project information.

 l Project Management users can create references from other PPM Center entities (such as requests 
and packages) to tasks in the synchronized project. These references could be used to monitor the 
state of a particular task.

To publish a Microsoft Project file through Project Management:

 1.  Create a project in Project Management without a work plan.

 2.  Ensure that the project's integration mode is set to Microsoft Project control.

 3.  Send the Microsoft Project file to Project Management. (See "Sending a Microsoft Project Work 
Plan to Project Management" on page 263 for detailed instructions.)

The project manager is likely to publish the project to Project Management on a regular basis. This can 
be done by selecting PPM Center > Update Associated Work Plan in Microsoft Project. Information 
in Project Management is updated based on the information in the Microsoft Project file, and 
information unique to Project Management is retained.
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Using Both Applications to Track Different Project 

Data

A project manager who uses Microsoft Project to plan and manage projects can use Project 
Management to collect actuals from participants. In addition to the benefits described previously in 
"Publishing a Microsoft Project File through Project Management" on the previous page, this integration 
shifts some of the effort of collecting and entering actuals information from the project manager to the 
participants. The project manager will need to synchronize the projects periodically, either to publish a 
re-planned work plan to Project Management or to collect new actuals updates into Microsoft Project.

To use Project Management to track actuals from Microsoft Project:

 1.  Create the work plan.

 o You can create the work plan initially in Microsoft Project and subsequently send it to Project 
Management in order to establish the work plan integration. All work plan editing should still be 
done in Microsoft Project.

 o You can also create the work plan initially in Project Management using a work plan template 
and subsequently edit it in Microsoft Project. This allows standards to be enforced even when 
using Microsoft Project for work plan management.

 2.  In Microsoft Project, select PPM Center > Update associated work plan.

The Update Associated Work Plans dialog box opens.

 3.  Select Send work plan information from MSP to PPM or Retrieve actuals from PPM to 
MSP and click OK.

See "Setting a Synchronization Mode for Project Management and Microsoft Project" on page 234 for 
more detailed information.

Project-Level Settings for Integration
There are a number of settings for projects in Project Management which are determined by project 
policies. Project policies are inherited from the project type used to create a particular project. For more 
information on project types and policies, see "Configuring Project Types" on page 28. The settings 
that pertain to Microsoft Project integration are set by the Microsoft Project Integration policy.

Figure 10-2. Microsoft Project Integration policy
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To view or modify project settings for a project, click Settings from the Project Overview page.

Note:  Changes to the Microsoft Project Integration policy at the project type level do not 
propagate to projects of that type.

Integration Mode

This setting determines which application has control over project information when synchronizing 
between Project Management and Microsoft Project.

 l If PPM controls all shared work plan information (Project Management-controlled mode), then any 
changes made in Microsoft Project are automatically discarded when project information is 
synchronized, as described in "Publishing a Project Management Work Plan through Microsoft 
Project" on page 230.

 l If Microsoft Project controls all shared work plan information (Microsoft Project-controlled mode), 
then work plan fields in Project Management are not editable, as described in "Publishing a 
Microsoft Project File through Project Management" on page 231.

 l If control is shared (shared control mode), then work plan information is determined by Microsoft 
Project, while actuals data is gathered by Project Management, as described in "Using Both 
Applications to Track Different Project Data" on page 232.

Note:  While it is possible to switch modes during project execution, it is not recommended unless 
you are moving to Project Management control.

Setting a Synchronization Mode for Project Management 

and Microsoft Project

Control of projects that have been created in one application and opened in the other can be 
subsequently shared between Microsoft Project and Project Management using one of three modes 
defined by Project Management. These control modes are established on the Project Management 
side, in the Microsoft Project Integration policy in the project settings. See "Project-Level Settings 
for Integration" on page 232 for details on its settings.

 l Project Management-controlled. Selecting PPM Center > Update associated work plan in 
Microsoft Project completely refreshes the plan information in Microsoft Project with the work plan 
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from Project Management.

 l Microsoft Project-controlled. Selecting PPM Center > Update associated work plan in Microsoft 
Project completely refreshes the plan information in Project Management with the work plan from 
Microsoft Project. Any additional edits made in Project Management are retained (see "Conditional 
Editing Allowed in Project Management" on page 274 for details). If the Microsoft Project work plan 
includes resources that cannot be mapped to resources in PPM Center, you will be asked to map 
these resources. See  "Planned Information" on page 210for more details.

By default, whenever you send a Microsoft Project file to Project Management, a backup copy of 
the .mpp file is automatically saved to the same directory in which the original file is stored, with the 
extension .bak.

If you originally created the work plan in Project Management using a work plan template, tasks 
marked as required by the template cannot be deleted in Microsoft Project. 

 l Shared control. Selecting PPM Center > Update associated work plan in Microsoft Project 
allows you to choose between the following options:

 o Sending updated schedule information from Microsoft Project to       Project Management. If this 
option is chosen, the integration refreshes the work plan schedule information in the associated 
work plan in Project Management based on the data in Microsoft Project. Any additional edits 
made in Project Management are retained (see "Conditional Editing Allowed in Project 
Management" on page 274 for details). For more details on updating work plan information, see . 
If the Microsoft Project work plan includes resources that cannot be mapped to resources in 
PPM Center, you will be asked to map these resources. See  "Planned Information" on 
page 210for more details.

By default, whenever you send a Microsoft Project file to Project Management, a backup copy of 
the .mpp file is automatically saved to the same directory in which the original file is stored, with 
the extension .bak.

If you originally created the work plan in Project Management using a work plan template, tasks 
marked as required by the template cannot be deleted in Microsoft Project. Tasks that have 
actuals logged against them in Project Management cannot be removed from the Microsoft 
Project file. You must first remove the actuals if you intend to remove the tasks.

 o Retrieving actuals information from Project Management based on the settings described in 
"Project-Level Settings for Integration" on page 232. If this option is chosen, the integration 
retrieves actuals data from Project Management for your review and optional application. For 
more details on obtaining actuals from Project Management, see "Retrieving Actuals from 
Project Management (Shared Control Mode)" on page 266.
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Changing Synchronization Modes and the Project 

Calendar

Project Management and Microsoft Project use a separate calendaring system for their projects. If the 
synchronization mode is Project Management-controlled, the Project Management calendar is used. If 
the synchronization mode is Microsoft Project-controlled or shared control, the Microsoft Project 
calendar is used. 

If the synchronization mode of a project is changed from Microsoft Project-controlled or shared control 
to Project Management-controlled, the Project Management calendar is used. However, if the 
synchronization mode of a project is changed from Project Management-controlled to Microsoft 
Project-controlled or shared control, the Project Management calendar is still used. If you want to use 
the Microsoft Project calendaring system, you must manually change to the Microsoft Project 
calendaring system.

Transferring PPM Center Information to Microsoft

When transferring information from Project Management to Microsoft Project, you need to specify how 
resources are identified in Project Management using the Resource name is done based on setting, 
so the Microsoft Project integration can create them correctly in Microsoft Project.

If you wish to track actuals for your project in Project Management, select the Transfer actuals 
information setting to enable the transfer of necessary data. This setting is used in shared control 
mode, and any time an Project Management work plan is used to create a new file in Microsoft Project. 
Depending on the option selected, the percent complete is applicable either at the task-level or 
resource-level but not both.

The options for the Transfer actuals information setting function as follows:

 l Percent Complete. If you select this option, percent complete, at the task level, is the only actuals 
information passed to Microsoft Project. Microsoft Project will automatically calculate the actual 
efforts and dates for each resource. Schedule information in Microsoft Project remains unchanged.

Many project managers use percent complete to manage their plans in Microsoft Project. However, 
some information in Project Management may not be visible in Microsoft Project. For example, if a 
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task in Project Management starts four days late, that information is not visible in Microsoft Project. 
To overcome this problem, try managing projects by exception in Project Management.

Select this option if the overall progress of the plan is the most important information to be shared.

 l Percent Complete and Actual Dates. If you select this option, the only actuals information 
passed to Microsoft Project are described below. All values are passed at the task level, and 
Microsoft Project applies data to assignments using its internal rules. Resource assignment data, 
including effort and dates, may not match the data in Project Management.

 o Actual start. Applying the actual start date to the task will move the scheduled start of the task 
in Microsoft Project and can have cascading impacts on the remainder of the schedule in 
Microsoft Project.

 o Actual finish (when available). Applying the actual finish date to the task will cause Microsoft 
Project to recalculate the task's scheduled finish and duration, which can also cause 
recalculation of resource efforts and trigger cascading schedule changes throughout the plan.

 o Estimated finish (if tracked). If the Estimated Finish field is being tracked in Project 
Management and no Actual Finish value exists, it will be passed to Microsoft Project as the 
scheduled finish for the task, which may have impacts on task duration, efforts, and schedule for 
the remainder of the plan.

 o Percent complete. When the task-level percent complete is applied, Microsoft Project will 
imply resource level efforts.

Select this option if a resource has logged actuals outside of a task's start or end date or when 
actuals dates are accurate but the project manager wants to adjust the schedule.

 l Actual Efforts. If you select this option, the only actuals information passed to Microsoft Project is 
the resource-level actual effort and estimated remaining effort. Microsoft Project will then infer the 
percent complete as well as actual start and scheduled finish dates for the task. Since the effort 
may indicate the task will take more or less effort than intended, this can have cascading impacts 
throughout the plan (for example, adjustments to the schedule, scheduled duration, and finish 
dates), depending on the task setup in Microsoft Project. 

You should always track actual effort in Project Management when using this option. You can also 
optionally track estimated remaining effort.

Estimated remaining effort is always synchronized, even if it is not tracked. This value is calculated 
in the background by Project Management and indicates if a task will take more or less effort than 
expected.
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Microsoft Project calculates the percent complete. If the effort among resources is uneven, or if the 
effort is contoured, the task-level percent complete in Microsoft Project may not match the value in 
Project Management because the applications use slightly different calculations.

Select this option if the project manager wants to focus on effort metrics to manage his plans.

Microsoft Storage Location for PPM Center System 

Information

The integration requires a custom Microsoft Project field for both tasks and resources in order to 
properly transfer information between applications. The first three settings in this category allow you to 
specify which field to use.

Note:  If you change the custom Microsoft Project field after a work plan has been integrated, data 
in the original custom Microsoft Project field is not deleted.

When synchronizing projects in shared control mode, several more custom Microsoft Project fields 
must be specified in this category. These fields hold the following: 

 l Snapshots of data that will be automatically changed by Microsoft Project once synchronization is 
complete

 l Flags for fields that are changed by the synchronization, and fields that are changed by Microsoft 
Project based on those synchronized fields

This project-level setting also allows you to change the field value colors in the custom Microsoft 
Project table view for synchronized actuals fields and the fields automatically changed by Microsoft 
Project based on the synchronization. For information on using this custom table view, see 
"Custom Microsoft Project Filters and Tables" on page 209.

Microsoft Field Mapping

This setting maps Project Management user data and Microsoft Project custom fields. Currently, only 
user data and custom fields associated with tasks are supported.
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Map Project Management user data fields to Microsoft Project custom fields

 1.  Configure Project Management user data.

To configure user data, refer to the section "Configuring Task User Data" in the Project 
Management Configuration Guide. Select a text field (for example, Text Field - 200) for the 
Validation field. 

Note:  Microsoft custom text fields for tasks support a field length of 255 characters. The 
Project Management user data supports a maximum field length of 200 characters. Data may 
be truncated when synchronizing these fields.

If you change user data in the PPM Workbench after uploading the mapping file, the user data 
must be saved and the project settings must be refreshed in order to see the changes in the table.

 2.  Click Edit in the User Data & Activity Fields Mapping section.

 3.  In the mapping window, double-click a PPM user data field in the Available PPM Fields.

By default, the user data field Activity is enabled, available for you to map.

 4.  In Available MSP Fields, double-click a MSP custom field to be mapped with the PPM user data 
field.

 5.  Repeat step 3 and step 4 to create another mapping relationship.

The one-one mapping relationships are displayed in the middle table.

 6.  Click OK to confirm the mapping and close the mapping window.

 7.  Click Save on the Project Setting page to save the mapping.

Remove a user data fields mapping relationship

 1.  Click Edit in the Microsoft Field Mapping section.

 2.  In the mapping window, select the mapping relationship you want to remove in the middle table.

 3.  Click Remove.

 4.  Click OK to confirm the mapping removal.

 5.  Click Save on the Project Setting page to save the change.
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Synchronization Modes

Synchronization modes determine how user data fields are controlled:

 l If your work plan is Project Management-controlled, user data fields are controlled by Project 
Management.

 l If your work plan is Microsoft Project-controlled, user data fields are controlled by Microsoft Project.

 l If control is shared, user data fields are controlled by Microsoft Project.

Note:  If a Project Management user data field is disabled, when resynchronizing the data, the data 
for this user field is not updated (even if it is defined in the mapping file).

Tasks Creation Mode 

Note:  This section applies to Microsoft Project 2010 only.

In Microsoft Project 2010, you can create tasks in two different modes: Auto Scheduled or Manually 
Scheduled. To successfully integrate tasks between Microsoft Project 2010 and PPM Center, all 
Microsoft Project 2010 tasks must be created in Auto Scheduled mode.

If a task is created in Auto Scheduled mode, data in task date and duration fields are validated by 
Microsoft Project and all tasks can be successfully integrated with PPM Center.

If a task is created in Manually Scheduled mode, data in task date and duration fields are not validated 
by Microsoft Project. PPM Center considers this data to be invalid and does not integrate the data. To 
successfully integrate all task data, the task must be changed to Auto Scheduled mode.

To change a task's mode, update the Task Mode field.

To set the default task creation mode for new tasks that are added to an existing project, click on the 
New Tasks menu at the bottom of the work plan window and select Auto Scheduled.  

To set the default task creation mode for new projects, go to the File tab and select Options. Select 
Schedule and then set the New tasks created field to Auto Scheduled.
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Microsoft Notes Synchronization

Enabling Microsoft Notes Synchronization

To enable notes synchronization,

 1.  Open the Project Settings page of the project.

 2.  Click Microsoft Project Integration.

 3.  In the Microsoft Notes Synchronization section, select Enable Notes Synchronization.

 4.  (Required for shared control only) Select the Notes synchronization direction. 

 o If you select From PPM to Microsoft Project, notes are editable in both PPM and Microsoft 
Project. Upon synchronization, notes in Microsoft Project are updated with PPM notes.

 o If you select From Microsoft Project to PPM, notes are editable in Microsoft Project only. 
Upon synchronization,   the Notes tab of task details page is updated with Microsoft Project 
notes.

 5.  Click Save or Done.

Notes Synchronization in Each Synchronization Mode

If Project Management controls all shared work plan information, notes are editable in PPM Center. 
Notes are also editable in Microsoft Project, however, upon synchronization, any changes made to 
Microsoft Project notes are overwritten. When PPM Center project information is transferred to 
Microsoft Project, each note along with its task description, user, and timestamp, are consolidated into 
the Microsoft Project Notes field.

Note:  When Project Management controls all shared work plan information, even if notes 
synchronization is disabled, the task description is always copied from PPM Center to the 
Microsoft Project notes field.

If Microsoft Project controls all shared work plan information, notes are editable in Microsoft Project 
only. When the Microsoft Project work plan information is transferred to a PPM Center project, the 
Microsoft Project Notes field is imported into a single PPM Center Notes field. Formatted text, OLE 
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objects, and bitmaps, which are allowed in Microsoft Project notes are not allowed in Project 
Management notes.

If control is shared, the application that controls and edits notes is determined by the Microsoft Project 
integration project settings of the project. See step 4 in "Enabling Microsoft Notes Synchronization" on 
the previous page. 

Size of Synchronized Notes

By default, both PPM Center and Microsoft Project limit the size of a synchronized note to 1,500 bytes. 
This limitation is only applicable for synchronized notes. That is, you can create and store notes larger 
than 1,500 bytes in PPM Center or in Microsoft Project, but the information that is synchronized 
between the two applications is limited in size.

In Microsoft Project, a synchronized note's size is not configurable. That is, the size of a synchronized 
note sent from Microsoft Project to PPM Center cannot be larger than 1,500 bytes and cannot be 
modified. 

In PPM Center, a synchronized note's size is configurable. That is, the size of a synchronized note 
sent from PPM Center to Microsoft Project is determined by the MSP_NOTES_SIZE_LIMIT 
server.conf parameter. To configure a synchronized note's size in PPM Center, edit the MSP_
NOTES_SIZE_LIMIT parameter in server.conf. By default, a synchronized note's size is 1,500 
bytes. Refer to the Installation and Administration Guide for more information about editing the 
server.conf file.

Notes Synchronization when Changing Synchronization 

Modes

If the synchronization mode of a project is changed from Project Management-controlled to Microsoft 
Project-controlled, notes initially provided in Project Management are deleted when the project is 
synchronized. To preserve notes initially provided in Project Management, synchronize the project to 
Microsoft Project before changing the synchronization mode.
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Project Management Activity Synchronization

Activities are simple configuration entities that can be associated with tasks in the project work plan. 
Tasks can be characterized by the type of activity involved in accomplishing the task. For example, 
certain tasks could be categorized as design activity while other tasks could be characterized as 
testing activity. 

Although they can be used for simple categorization, activities are usually used to identify costs that 
can be capitalized for Statement of Position (SOP) 98-1 compliance. For example, activities marked as 
capitalized will categorize the costs of associated tasks as capital if the project supports capitalization. 
A project or task is identified as capitalized when it is associated with a capitalized activity.

Project Management comes with a pre-defined set of activities reflecting common SOP 98-1 categories 
that can be configured for use with tasks.

If you choose not to activate SOP 98-1 tracking, activities can still be associated with tasks as a 
categorization tool, and any associated costs will be considered operating expenses. That is, activities 
can be used even when SOP 98-1 functionality is not enabled, but they cannot be marked as 
capitalized, nor will projects or tasks associated with any activities track capitalization data.

Note:  Activities can also be associated with requests and packages (but cannot be capitalized). 
However, only activities associated with tasks can be mapped and synchronized between Project 
Management and Microsoft Project.

For detailed discussion of configuring activities and activity behavior, see the Financial Management 
User’s Guide.

Enabling Microsoft Project Integration Options: Activity 

Synchronization and Mapping

Activities in Project Management are mapped to and from the Microsoft Project custom field Text1 (by 
default, Text1 is configured).

To enable activity mapping, from PPM Center, do the following:

 1.  Open the project.

 2.  Click Settings on the Project Overview page.
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 3.  Click Microsoft Project Integration.

 4.  In the Microsoft Field Mapping section, select Enable Activity Synchronization.

 5.  Select the Microsoft Project custom field to map to Project Management activities. By default, 
Text1 is selected.

Note:  By default, you can select custom field Text1 - Text29 from the drop-down list 
because, by default, the Microsoft Project custom field Text30 is used to store the project link 
information (see Project Management Configuration Guide for more information). The custom 
field used to store the project link cannot be used to map activities. If your administrator has 
configured the project link to use a different custom field, that field does not display in the 
drop-down list.

 6.  Click Done.

Project Management and Microsoft Project Activity 

Synchronization Modes

The synchronization mode of a project determines which application (PPM Center or Microsoft Project) 
has control over project information when updating information between Project Management and 
Microsoft Project.

If Project Management controls all shared work plan information, activities are editable in PPM Center 
only. When PPM Center project information is transferred to Microsoft Project, the PPM Center 
Activity field is exported to Microsoft Project custom field Text1 (by default).

If Microsoft Project controls all shared work plan information, activities are editable in Microsoft Project 
only. When the Microsoft Project work plan information is transferred to a PPM Center project, the 
Microsoft Project custom field Text1 (by default) is imported into the PPM Center Activity field.

If control is shared, activities are controlled by and editable in Microsoft Project only. When the 
Microsoft Project work plan information is transferred to a PPM Center project, the Microsoft Project 
custom field Text1 (by default) is imported into the PPM Center Activity field.

Activity Synchronization Behavior in Microsoft Project

When synchronizing activities, you should either let the Plug-in for PPM generate the activity column in 
Microsoft Project or define the activity column in Microsoft Project using the label "Activity" and map 
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the same custom field configured in the PPM Center project settings. 

If the activity column is defined incorrectly (either the Microsoft Project column is not labeled "Activity" 
or the custom field used is not the same custom field configured in the PPM Center project settings), 
the following occurs:

 Project Management-controlled
Microsoft Project-controlled or 
Shared Control

Microsoft 
Project 
Column 
Label is 
Incorrect, 
Custom 
Field is 
Correct

When a PPM Center work plan is first opened 
from Microsoft Project, a column labeled 
"Activity" in Microsoft Project is created. If the 
"Activity" column is renamed, activities in PPM 
Center are still synchronized to the same 
(renamed) column in Microsoft Project.

Mislabeled activities in Microsoft 
Project are synchronized to activities 
in PPM Center. A warning message 
is logged.

Microsoft 
Project 
Column 
Label is 
Correct, 
Custom 
Field is 
Incorrect

When a PPM Center work plan is first opened 
from Microsoft Project, a column labeled 
"Activity" in Microsoft Project is created. If 
another column labeled "Activity" is added in 
Microsoft Project that is mapped to a different 
custom field (not the one configured in the PPM 
Center project settings), it is ignored during 
synchronization.

The column labeled "Activity" in 
Microsoft Project is not synchronized 
in PPM Center. Instead, another 
column labeled "Activity" is created 
that is mapped to the correct custom 
field. A warning message is logged to 
rename the initial column labeled 
"Activity."

Table 10-6. Mislabeled Activity Column Behavior

Note:  After the first synchronization, do NOT modify the column label or mapped custom field in 
Microsoft Project.

Activity Inheritance Behavior

Tasks and summary tasks can inherit their activity settings from their parent projects, making it 
unnecessary to manually set the activity for every task and summary task within a project. 

Activity inheritance follows certain rules (also described in the Financial Management User’s Guide):

 l When an activity is set on a project, the same activity cascades down to all its children. These 
children will continue to inherit whatever their parent's activity setting is. If one of these children is 
moved to a different parent with a different activity setting, the child will acquire the new parent's 
activity setting.

 l When a child with a different activity setting than its parent is found, the activity setting cascade 
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stops and that child's activity setting is preserved. This child's activity setting will be preserved 
even if the child is indented, outdented, or cut-and-pasted under a different parent.

 l In the case of a child with a different activity setting, manually setting that child's activity setting to 
that of its parent means that its activity setting will no longer be preserved, and will become that of 
its current parent.

 l Manually setting a child's activity to an empty value will keep it empty, but it will not stay empty if 
the child is moved to a parent with a non empty activity setting.

 l If a summary task's parent changes its activity setting, the new activity will be applied to the 
summary task and all its children as well, unless the summary task's activity setting is different 
than its parent's, in which case the summary task and its children will remain untouched.

Additional rules regarding activity inheritance behavior:

 l In Project Management-controlled mode, when activities are synchronized, if a child's activity is 
empty in PPM Center, it will remain empty in Microsoft Project.

 l In Microsoft Project-controlled mode and shared control mode, when activities are synchronized, if 
a child's activity is empty in Microsoft Project, that child's activity will inherit its parent's activity in 
PPM Center.

Preserving External Predecessors

In Microsoft Project-controlled or shared control synchronization mode, you can decide whether or not 
the existing external predecessors of work plan tasks in Project Management projects are preserved 
after synchronization from Microsoft Project.

To do so,

 1.  Open the project from PPM Center.

 2.  Click Settings to go to the Project Settings page.

 3.  Click Microsoft Project Integration.

 4.  Scroll to the bottom, and in the External Predecessors section, select or deselect the checkbox 
Preserve existing external predecessors in this project when the work plan is 
synchronized from Microsoft Project.

By default, this checkbox is selected. The existing external predecessors in the project are 
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preserved after synchronization.

 5.  Click Save or Done.

Service Portfolio Management Support

In PPM Center, Service Portfolio is used to track, categorize, and analyze business services and labor 
cost-related IT project initiatives and requests. A Service field may be added to a task in an Project 
Management work plan and may be a required field. There is no service-related field in Microsoft 
Project.

When you synchronize a Microsoft Project work plan to PPM Center or open a work plan from PPM 
Center, synchronization of the Service field depends upon the synchronization mode and the project 
settings for the field.

Project Management-Controlled

Because there is no service-related field in Microsoft Project, when you export a new PPM Center 
project work plan or synchronize updates to Microsoft Project, the Service fields and their values are 
not imported to Microsoft Project. 

If you modify the service for an existing project in Project Management-controlled mode, the service is 
saved but is not synchronized to your Microsoft Project work plan. If you switch to Microsoft Project-
controlled mode, update the Microsoft Project work plan actuals, and synchronize the updates of 
actuals information back to the PPM Center project work plan, the services for existing work plan tasks 
maintain the same values and new work plan tasks inherit their parent service. 

Microsoft Project-Controlled and Shared Control

Service field synchronization behavior is described in "Table 10-7. Service Synchronization Behavior 
for Microsoft Project-Controlled" on the next page, defining what happens when the Service field is or 
is not required, if a default service is or is not defined, and if a service is or is not assigned to a parent 
task. During synchronization, when assigning a service to a new work plan subtask, the service 
assigned to a parent task takes precedence over the default service. A root task does not have a parent 
service.
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 Service is Not Required Service is Required

No Default Service

 

 

 

 

For existing work plan tasks in the 
PPM Center project, the Service 
field maintains the same values.

For a new work plan task, the 
Service field is empty.

 

 

 

 

 

For existing work plan tasks in the 
PPM Center project, the Service 
field maintains the same values.

For a new work plan task, 
synchronization fails. An error 
message opens indicating that the 
Service field is required and is not 
set on this project. Set a default 
service in the PPM Center project 
and send the Microsoft Project work 
plan again.

No Service Assigned to 
Parent Task (may be a 
root task)

 

 

 

No Default Service For existing work plan tasks in the 
PPM Center project, the Service 
field maintains the same values.

For a new work plan task, the 
Service field inherits the parent 
service.

For existing work plan tasks in the 
PPM Center project, the Service 
field maintains the same values.

For a new work plan task, the 
Service field inherits the parent 
service.

Service Assigned to 
Parent Task

 

 

 

Default Service 
Specified

For existing work plan tasks in the 
PPM Center project, the Service 
field maintains the same values.

For a new work plan task, the 
Service field inherits the default 
service. 

For existing work plan tasks in the 
PPM Center project, the Service 
field maintains the same values.

For a new work plan task, the 
Service field inherits the default 
service. 

No Service Assigned to 
Parent Task (may be a 
root task)

 

 

Default Service 
Specified

For existing work plan tasks in the 
PPM Center project, the Service 
field maintains the same values.

For a new work plan task, the 
Service field inherits the parent 
service.

For existing work plan tasks in the 
PPM Center project, the Service 
field maintains the same values.

For a new work plan task, the 
Service field inherits the parent 
service.

Service Assigned to 
Parent Task

 

 

Table 10-7. Service Synchronization Behavior for Microsoft Project-Controlled

For more information about service inheritance behaviors, see the Project Management Configuration 
Guide.
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Cost and Effort Policy and Time Management

If you are using Time Management to track actuals, in the Cost and Effort policy, you can select the 
level (task or project) at which actuals are tracked.

If actuals are tracked at the project level, these actuals are not sent to Microsoft Project because 
Microsoft Project only tracks actuals at the task level. Project level actuals in Microsoft Project are 
automatically calculated or rolled up from task level actuals.

When you track actuals using Time Management, you can change the level at which actuals are 
tracked. If you have entered actuals at the task level and then change the project to track time at the 
project level, you cannot change the level back to the task level until you remove all the actuals for the 
project from the time sheets that track time against the project.

User Preferences for the Plug-in for PPM
The tasks included in this section are optional.

In Microsoft Project, you can set user preferences for the Plug-in for PPM to configure the interaction 
between Microsoft Project, PPM Center, and Microsoft Project Server. From the PPM Plugin 
Preferences page, you can change settings for language, prompting, highlighting, backup files, log 
files, the PPM Server, custom HTTP header, the proxy server, and the calendar used.

To access the PPM Plugin Preferences page, from Microsoft Project, select PPM Center > User 
Preferences.

Microsoft Project Options

Microsoft Project options are used to configure the interaction between Microsoft Project and the Plug-
in for PPM. Use these options to set the language and to enable or disable save prompting, highlighting, 
backups, and log files.

Project Management User’s Guide
Chapter 8: Integrating Project Management with Microsoft Project

HPE Project and Portfolio Management Center (9.40) Page 249 of 292



Setting the Language for the Plug-in for PPM

Both PPM Center and Microsoft Project provide support for multiple languages. The Plug-in for PPM 
also supports multiple languages. Setting the language for the Plug-in for PPM provides standard 
translations of static interface elements of the PPM Center menu in Microsoft Project. By default, the 
language used by the Plug-in for PPM is the language configured for Microsoft Project.

When the language setting is changed and the preferences are saved, Microsoft Project must be 
restarted for the change to take effect.

The following fields can be used to set the language for the Plug-in for PPM.

Field Description

Use 
Microsoft 
Project 
language

Default selection. Select this checkbox to use the language that is configured for 
Microsoft Project. 

If this checkbox is selected and you change the language for Microsoft Project, the 
language for the Plug-in for PPM automatically changes to the language of Microsoft 
Project when Microsoft Project is restarted.

If the language configured for Microsoft Project is not supported by PPM Center, the 
Plug-in for PPM does not load. At a minimum, the MspTextResources_
<xx>.properties must exist for the Plug-in for PPM to load. See the Multilingual User 
Interface Guidefor more information.

Language Select a language used by the Plug-in for PPM. If the Use Microsoft Project language 
checkbox is selected, you cannot select a language in this field. If you select a 
language, this selection is not affected by any changes you make to the Microsoft 
Project language.

By default, Dutch, English, French, German, Italian, Japanese, Korean, Portuguese, 
Russian, Simplified Chinese, Spanish, and Turkish are the language selections 
available. Additional language selections are determined by the language packs installed 
on the PPM Server or if properties files have been translated and deployed (see the 
Multilingual User Interface Guidefor more information).

Table 10-8. Language Settings

Note:  The Plug-in for PPM language setting only affects the PPM Center menu and dialogs. The 
language settings in PPM Center and Microsoft Project determine how menus, dialogs, and data is 
displayed in the respective applications.
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Disabling Save Prompting

When you save a Microsoft Project file that is associated with an Project Management work plan that is 
Microsoft Project-controlled or shares control, you are prompted to send the work plan to Project 
Management. This gives you the option to send changes to Project Management.

If you do not want the option to send changes to the Microsoft Project work plan to Project 
Management after saving the file, you can disable the prompt. By default, the prompt is enabled.

To disable save prompting,

 1.  Open the project in Microsoft Project.

 2.  Select PPM Center > User Preferences.

 3.  In the Microsoft Project tab, unselect the Prompt me to update the associated project in PPM 
Center when I save the Microsoft Project file checkbox.

 4.  Click Save.

Enabling Highlighting for Work Plans Controlled by 

Project Management

You can enable the Plug-in for PPM to change the color of the scheduled dates that are automatically 
changed by Microsoft Project in the Microsoft Project table view for work plans controlled by Project 
Management. When enabled, the default color is blue but can be set to a different color in the Project 
Management project-level settings (see "Microsoft Storage Location for PPM Center System 
Information" on page 238).

To enable highlighting,

 1.  Open the project in Microsoft Project.

 2.  Select PPM Center > User Preferences.

 3.  In the Microsoft Project tab, select the Highlight schedule slip in PPM control mode 
checkbox.

 4.  Click Save.

If your project is large, enabling this option may decrease the performance of synchronization.
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Loading the Plug-in for PPM on Demand

By default, when starting Microsoft Project, the Plug-in for PPM is loaded automatically. However, it 
may take some time to load the Plug-in for PPM. If this delay is not acceptable, you can set a 
preference to load the Plug-in for PPM when you want to use it.

To load the Plug-in for PPM on demand,

 1.  Open the project in Microsoft Project.

 2.  Select PPM Center > User Preferences.

 3.  In the Microsoft Project tab, unselect the Load PPM Center Plugin on Startup checkbox.

 4.  Click Save.

Backing Up Microsoft Project Files

By default, every time work plan information is successfully sent from Microsoft Project to Project 
Management, the open .mpp file is saved and a copy of the .mpp file is saved to a backup file. The 
backup file has the same name as the .mpp file but uses the extension .bak. By default, the directory 
to which the backup file is saved is the same directory in which the original .mpp file is stored.

Note:  When .mpp file and user settings point to different PPM Server URLs, a warning message 
pops up asking you to choose one.

If you experience an integration error related to the deletion of a task or resource in Microsoft Project 
that had actuals, you can use the backup copy as a starting point from which to reapply your most 
recent edits. See "Deleting Required Tasks or Tasks/Resources with Actuals" on page 286 for more 
information.

You can enable or disable the automatic backup and set the backup directory from the PPM Plugin 
Preferences page.

Note:  Automatic backups do not occur for Microsoft Project Server-based projects.

To enable or disable backups and to set the backup directory,

 1.  Open the project in Microsoft Project.

 2.  Select PPM Center > User Preferences.
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 3.  In the Microsoft Project tab, select the Back up the Microsoft Project file after synchronizing 
with PPM Center checkbox to enable automatic backups. Unselect the checkbox to disable 
automatic backups.

 4.  Optionally, set the backup directory in the Save backup project files to field. By default, the 
directory to which the backup file is saved is the same directory in which the original .mpp file is 
stored.

 5.  Click Save.

Enabling Synchronization Logs

By default, logging synchronization information between Project Management and Microsoft Project is 
disabled (this also helps to optimize performance). You can choose to enable information tracing for 
synchronizations, making detailed synchronization logs available from the Info tab of the Errors, 
Warnings, and Info window.

To enable full information tracing for a synchronization:

 1.  Open the project in Microsoft Project.

 2.  Select PPM Center > User Preferences.

 3.  In the Microsoft Project tab, select the Enable logging checkbox.

 4.  Optionally, type the directory in which to save the log files.

Note:  If the user does not have permission to write to the Plug-in for PPM log file, logging is 
disabled.

 5.  Click Save.

Enabling Data Trace Logging

You can enable logging for importing tasks from PPM Center. With this log available, you can see what 
and how (in which sequence) tasks information is imported.

 1.  Open the project in the Microsoft Project.

 2.  In the Add-Ins tab, select PPM Center > User Preferences.

 3.  In the Microsoft Project tab, select Enable logging and Enable data trace logging.
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The Enable data trace logging option is disabled unless you select the Enable logging option. 
By default, the Enable logging option is not selected.

 4.  (Optionally) Select the directory in which the log files are saved.

 5.  Click Save.

After you import tasks from PPM Center, the log is recorded in the msp.log file located in the 
directory you specified.

The following is an example of the log for importing tasks.

PPM Center Options

PPM Center options are used to configure the interaction between Microsoft Project and PPM Center. 
Use these options to change the PPM Server connection, set a custom HTTP header, and configure 
proxy settings.
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Changing the PPM Server Connection

By default, the PPM Server to which Microsoft Project connects is the PPM Server from which you 
installed the Plug-in for PPM. The PPM Server URL displayed is the PPM Center instance to which 
Microsoft Project synchronizes its files.

To change the PPM Server URL setting,

 1.  Open the project in Microsoft Project.

 2.  Select PPM Center > User Preferences.

 3.  In the PPM Center tab, to synchronize with a different PPM Server, type in a different URL in the 
PPM Server URL field.

 4.  Optionally, select or deselect the Remember username checkbox. If selected, the Plug-in for 
PPM uses the same username to log in to the PPM Server. If unselected, the Username field in 
the Login dialog will be blank.

 5.  Click Save.

Setting a Custom HTTP Header

If a custom HTTP header is required for authentication by the PPM Server, you can configure the 
header used by the Plug-in for PPM. This custom header is included in every request sent to PPM 
Center.

The following fields can be used to configure a custom HTTP header for the Plug-in for PPM.

Field Description

Send a 
custom HTTP 
authentication 
header

Select this checkbox to enable the ability to include a custom HTTP header when 
connecting to the PPM Server.

Header name Type the name of the custom HTTP header. The header name should only contain 
alphanumeric and special characters, except for space and colon (:). If an invalid 
character is typed, it is automatically removed from the header name when you 
leave the field.

Include  Select this checkbox to include the Windows Server domain name with the 

Table 10-9. Custom HTTP Header Settings
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Field Description

Windows 
domain

username.

Table 10-9. Custom HTTP Header Settings, continued

The custom HTTP header consists of the header name followed by the Windows Server domain name 
(if selected) and the username.

For example, if your system is set up as follows:

Username: smithj
Windows Server Domain: ASIAPACIFIC
Header Name: PPM_Authentication

When you select the Send a custom HTTP authentication header checkbox and if the Include 
Windows domain checkbox is not selected, the custom header used is: PPM_
Authentication:smithj 

If the Include Windows domain checkbox is selected, the custom header used is: PPM_
Authentication:ASIAPACIFIC\smithj

Configuring a Proxy Server for the Plug-in for PPM

The Plug-in for PPM and the PPM Server exchange data using HTTP. If this connection uses a proxy 
server, you must configure the proxy settings. By default, a proxy server is not used.

The following fields can be used to configure a proxy server for the Plug-in for PPM.

Field Description

Direct connection Default selection. Select this option if a proxy server is not required for the 
connection between the Plug-in for PPM and the PPM Server.

Internet Explorer 
proxy settings

Select this option to use the same proxy server that is configured in Internet 
Explorer.

Custom proxy Select this option to specify a proxy server.

  Proxy 
server

Type the IP address or name of the proxy server.

  Port Type the port number used to connect to the proxy server.

Proxy 
authentication

If the proxy server requires authentication, select or enter the credentials 
(username, password, and domain) used to connect to the proxy server.

Table 10-10. Proxy Settings
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Field Description

  Use 
Windows 
credentials

Select this checkbox to use credentials provided by Windows to connect to 
the proxy server.

  Username Type the username used to connect to the proxy server. If you selected the 
Use Windows credentials checkbox, you do not need to enter a username.

  Password Type the password used to connect to the proxy server. If you selected the 
Use Windows credentials checkbox, you do not need to enter a password.

  Domain Optional. Type the Window Server domain name used to connect to the proxy 
server. If you selected the Use Windows credentials checkbox, you do not 
need to enter a domain.

Table 10-10. Proxy Settings, continued

Enabling PPM-MSP Connection to Go via Web Browser

PPM does not support Common Access Card (CAC), and cannot send client certificate to Citrix 
Netscaler. If you log on to MSP plug-in under CAC and Netscaler deployment environment, you would 
receive "invalid username and password" exceptions. To address this issue, you should enable the 
connections between PPM and MSP to go via Web browser.

 1.  Open the project in Microsoft Project.

 2.  Select PPM Center > User Preferences.

 3.  In the PPM Center tab, select the option Enable Web Logon.

 4.  Click Save.

Tasks Creation Options

Tasks creation options are used to specify task type and the sequence of actuals fields when you 
import tasks to Microsoft Project from PPM Center.
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Specifying Task Type When Importing Tasks from PPM 

Center

 1.  Open the project in Microsoft Project.

 2.  In the Add-Ins tab, select PPM Center > User Preferences.

 3.  In the Tasks Creation tab, Task type section, select the task type for the imported tasks.

 4.  (Optionally) Select the option Override Default Task Type in MSP Project Options if you want 
to change the default task type in MSP Project options to what you select in step 3.

For example, if you check this option and select Fixed Work as the task type in step 3, the default 
task type in MSP Project Options will be changed to Fixed Work.

 5.  Click Save.

Specifying the Sequence of Actuals Fields When 

Importing Tasks from PPM Center

 1.  Open the project in Microsoft Project.

 2.  In the Add-Ins tab, select PPM Center > User Preferences.

 3.  In the Tasks Creation tab, Actual fields section, specify the sequence of the actuals fields. The 
actual field on the top will be inserted first while the actual field on the bottom will be inserted last.

You cannot specify the sequence of actuals fields unless you select the option Override PPM 
Project Settings.... If you select the option, it only applies to new tasks and is not applicable 
when you retrieve actuals from PPM. If you deselect the option, you have to follow the setting of 
Transfer actuals information in PPM project.

 4.  Click Save.

Microsoft Project Server Options

Microsoft Project Server options are used to configure the interaction between Microsoft Project 
Server, Microsoft Project, and the Plug-in for PPM. Use this option to set the project calendar used 
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from the Microsoft Project Server.

Setting the Microsoft Project Server Calendar for the 

Plug-in for PPM

If a Microsoft Project file is stored on a Microsoft Project Server, the calendar used by the Microsoft 
Project file is also stored on the Microsoft Project Server. You can configure the Plug-in for PPM to use 
one of the existing project calendars on the Microsoft Project Server. If you do not configure a calendar 
(either by not selecting the checkbox or not typing a calendar name), a default calendar, based on the 
language configured for Microsoft Project, is used.

Set the Microsoft Project Server calendar for the Plug-in for PPM if you are required to use a specific 
project calendar on the Microsoft Project Server for the Plug-in for PPM. In Project Management-
controlled mode, the Plug-in for PPM must be configured to use a calendar on the Microsoft Project 
Server. The calendar is used by the Plug-in for PPM to synchronize task information during integration. 

The following fields are used to configure the Microsoft Project Server calendar used by the Plug-in for 
PPM.

Field Description

Use custom calendar name for 
Microsoft Project Server

Select this checkbox to use an existing project calendar from 
Microsoft Project Server.

calendar name Type the name of an existing project calendar on the Microsoft 
Project Server. If a name is not entered, a default calendar, 
based on the language of Microsoft Project, is used. For 
example, in English, the default calendar is PPM Calendar. In 
German, the default calendar is PPM Kalender.

Table 10-11. Microsoft Project Server Calendar Option

Note:  If the calendar name does not exist, the next time you synchronize the project, the 
synchronization fails.

Creating and Managing the Work Plan
Once you have selected and configured the synchronization mode and determined your project 
management strategy, you are ready to start creating and managing your work plans.
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 l You can create a new work plan in Microsoft Project from an existing Project Management work 
plan (see "Opening a Work Plan in Microsoft Project using Project Management" on the next page 
and "Opening an Project Management Work Plan from Microsoft Project" on the next page). 

 l You can create a new work plan in Project Management from an existing Microsoft Project work 
plan (see "Sending a Microsoft Project Work Plan to Project Management" on page 263).

 l The synchronization mode of the associated Project Management project determines how you can 
manage the work plan.

 o In Project Management-controlled mode, you can update the Microsoft Project work plan from 
the associated Project Management work plan [see "Updating an Associated Work Plan from 
Project Management (Project Management-Controlled Mode)" on page 265].

 o In shared control mode, you can retrieve actuals from the associated  Project Management work 
plan [see "Retrieving Actuals from Project Management (Shared Control Mode)" on page 266] 
and send work plan (planned) information to the associated Project Management work plan [see 
"Sending Work Plan (Planned) Information from Microsoft Project to Project Management 
(Shared Control Mode)" on page 267].

 o In Microsoft Project-controlled mode, you can update the associated Project Management work 
plan from the Microsoft Project work plan [see "Updating an Associated Work Plan to Project 
Management (Microsoft Project-Controlled Mode)" on page 268].

 o In shared control mode and Microsoft Project-controlled mode, you can manually map resources 
from Microsoft Project to Project Management [see "Manually Mapping Resources Between 
Applications (Shared Control Mode and Microsoft Project-Controlled Mode)" on page 269].

 l In Project Management, some editing features may be disabled depending on the synchronization 
control mode selected for the project (see "Conditional Editing Allowed in Project Management" on 
page 274).

 l You can remove, restore, and refresh Microsoft Project and Project Management associations (see 
"Removing Microsoft Project and Project Management Associations" on page 276, "Restoring 
Microsoft Project and Project Management Associations" on page 277, and "Refreshing Microsoft 
Project and Project Management Associations " on page 277).

 l If you are working with a Microsoft Project Server-based project, Project Management functions 
slightly differently (see "Working with Projects Using a Microsoft Project Server" on page 279).

 l If you experience any synchronization problems, see "Troubleshooting" on page 282.
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Opening a Work Plan in Microsoft Project using 

Project Management

A project manager who uses Project Management to manage projects can open, in Microsoft Project, 
the current Project Management work plan using a menu in the Project Management work plan.

Note:  ActiveX is no longer required to open a work plan in Microsoft Project using Project 
Management.

To open an Project Management work plan in Microsoft Project using Project Management:

 1.  Open the work plan in Project Management.

 2.  From the work plan, click Actions > Open Work Plan in Microsoft Project.

The Opening PPM_Project.mpp dialog displays.

 3.  Select Open with Microsoft Office Project (default).

 4.  Click OK.

 5.  If prompted, type your Project Management username and password and click OK.

The work plan opens in Microsoft Project.

Note:  Because the Plug-in for PPM must open the work plan, a temporary Microsoft Project 
file (PPM_Project.mpp) is created. Do not save this file and do not use it to manually re-open 
the work plan in Microsoft Project. If the temporary file is not launched from Project 
Management, Microsoft Project may not open the most current or correct work plan. When 
the work plan has been opened by Microsoft Project, the temporary file is deleted.

Opening an Project Management Work Plan from 

Microsoft Project

A project manager who uses Project Management to manage projects can open, in Microsoft Project, 
an Project Management work plan from Microsoft Project. The manager can distribute the Microsoft 
Project file to external audiences (such as a PMO group). The manager could also synchronize the 
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Microsoft Project file with Project Management periodically, and run Microsoft Project reports for 
distribution.

For more information on synchronizing your Project Management work plan with its Microsoft Project 
counterpart, see "Setting a Synchronization Mode for Project Management and Microsoft Project" on 
page 234.

To open an Project Management work plan in Microsoft Project:

 1.  From the Microsoft Project Add-Ins tabbed area, select HP PPM Center > Open a PPM Work 
Plan.

 2.  If prompted, type your Project Management username and password and click OK.

 3.  Search for then select a work plan to open.

You can only select from projects that have active work plans. Additionally, the system will 
indicate whether the work plan you have chosen has already been integrated with Microsoft 
Project.

 4.  Click Select or double-click the selected item.

Select HP PPM Center > Show Errors, Warnings and Info to view any informational 
messages, errors, or warnings that occurred while opening the work plan in Microsoft Project.

The task structure and task names for the project in Project Management and the project in Microsoft 
Project will be identical. There will be a one-to-one relationship between tasks, and tasks will appear in 
the same sequence in both projects. Tasks are marked as fixed duration, which causes resource 
assignments and efforts to match. Scheduled start and finish dates for tasks without actuals will be 
identical in Project Management and Microsoft Project.

Duration is calculated by Microsoft Project based both on the start and finish dates and the resource 
calendars in Microsoft Project. Task durations and roll-up durations will sometimes differ slightly 
between the two applications.

Variances in duration may also be caused by:

 l Calendar exceptions and holidays (they are not synchronized)

 l Task constraints when Microsoft Project is in automatic calculation mode (for example, if Task 2 
starts when Task 1 ends, and if the duration of Task 1 changes, then the start date of Task 2 also 
changes)

Regional calendar settings applied to the project calendar in Microsoft Project include:
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 l Number of hours per day

 l Working days for each week

Custom filters and tables are available for you to quickly view any changes. See  "Custom Microsoft 
Project Filters and Tables" on page 209 for more information.

Sending a Microsoft Project Work Plan to Project 

Management

Sending a Microsoft Project work plan to Project Management (using the PPM Center > Send Work 
Plan to PPM menu selection) creates an association between the Microsoft Project work plan and an 
Project Management project. A Microsoft Project work plan can be associated to only one Project 
Management project.

The Plug-in for PPM sends both planned information and actuals from the Microsoft Project work plan 
to a blank Project Management work plan. This menu selection cannot be used to update planned 
information and actuals in an existing Project Management work plan.

Note:  You may need to create a project without a work plan in Project Management before 
sending the file from Microsoft Project.

You can send a Microsoft Project work plan to an Project Management project that is configured with 
any of the three synchronization modes. Your project management strategy helps to determine when 
and why you would send a Microsoft Project work plan to a blank Project Management work plan.

For example, in Project Management-controlled mode, you might send a Microsoft Project work plan to 
Project Management in order to create a new Project Management project based on an existing 
Microsoft Project work plan or to convert an existing Microsoft Project work plan to an Project 
Management project.

In shared control mode, you might send a Microsoft Project work plan to Project Management because 
you are collecting actuals in Project Management but are using an existing Microsoft Project work plan 
or want to use Microsoft Project planning tools.

In Microsoft Project-controlled mode, you might send a Microsoft Project work plan to Project 
Management in order to publish a project using Project Management and present the project in the PPM 
Dashboard.
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When you send a Microsoft Project work plan to an Project Management project, a new work plan is 
created in Project Management based on the current .mpp file in Microsoft Project. Projects using 
Microsoft Project Server behave somewhat differently; see "Working with Projects Using a Microsoft 
Project Server" on page 279.

To send a Microsoft Project work plan to Project Management:

 1.  From the Microsoft Project Add-Ins tabbed area, select PPM Center > Send Work Plan to 
PPM.

 2.  If prompted, type your Project Management username and password and click OK.

 3.  From the Select a Project dialog, click Search.

 4.  Select a project to which to send the Microsoft Project work plan.

You can only select from projects that do not have work plans, and only for projects for which you 
are the project manager. If no such project exists, you must create one in Project Management.

 5.  Click Select or double-click the selected item.

 6.  The integration automatically performs resource mapping between applications for an Project 
Management project that is Microsoft Project-controlled or has shared control. If resources in 
Microsoft Project cannot be automatically mapped to resources in Project Management, the 
Mapping Resources dialog displays.

Note:  Automatic resource mapping occurs upon the first synchronization or when a new 
resource is added to Microsoft Project. See "Planned Information" on page 210.

Specify mapping for unmapped resources and click Finish.  

You can verify the automatic mappings, modify any of the automatic mappings, and specify any 
mappings for unmapped resources at a later time. See "Manually Mapping Resources Between 
Applications (Shared Control Mode and Microsoft Project-Controlled Mode)" on page 269 for more 
information about the Mapping Resources dialog.

 7.  If the Project Management project is Project Management-controlled or has shared control, the 
Send Actuals dialog displays. You must choose to either Include Actuals (send actuals to 
Project Management) or Ignore Actuals (do not send the actuals to Project Management). Click 
OK after you have made your selection.

 8.  The integration is completed when the Integration Complete dialog displays.

From the Integration Complete dialog, you may choose to remove the association between the 
Microsoft Project work plan and the Project Management project.
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You can also click Show Info to view any informational messages, errors, or warnings that 
occurred while sending the work plan to Project Management. See  "Enabling Synchronization 
Logs" on page 253 for information on how to enable full information tracing.

Click Done to close the dialog.

By default, whenever you send a Microsoft Project file to Project Management, a backup copy of the
 .mpp file is automatically saved to the same directory in which the original file is stored, with the 
extension .bak. See "Backing Up Microsoft Project Files" on page 252.

During integration, Project Management recalculates the duration of each task based on the Project 
Management base and resource calendars, but keeping the start and finish dates the same.

The Project Management project is initially assigned the In Planning status. After the project manager 
verifies that the dates are correct, the project should be moved to the Active status.

Note:  If the Project Management work plan is integrated with Time Management and the 
synchronization mode is either Project Management-controlled or shared control, when the actual 
effort is rolled up to the work plan from Time Management, if the actual effort has not been modified 
(no new time has been logged using a time sheet), the corresponding actual effort in the work plan 
is not updated. If the actual effort has been modified (new time has been logged using a time 
sheet), the corresponding actual effort in the work plan is updated. Therefore, when the actual 
effort is rolled up to the work plan from Time Management, if the actual effort in  Time Management 
has been updated, the actuals that originated from the Microsoft Project work plan are overwritten. 
If the actual effort in Time Management has not been updated, the actuals that originated from the 
Microsoft Project work plan are retained.

Updating an Associated Work Plan from Project 

Management (Project Management-Controlled 

Mode)

You can update a Microsoft Project file from the associated Project Management work plan when 
Project Management controls the work plan. Changes made directly to the Microsoft Project file are 
overwritten during this update.

You can enable the Plug-in for PPM to highlight the scheduled dates automatically changed by 
Microsoft Project in the Microsoft Project table view (see "Enabling Highlighting for Work Plans 
Controlled by Project Management" on page 251). When enabled, the highlight color is blue.
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To update the Microsoft Project file from an associated work plan in Project Management:

 1.  Open the project in Microsoft Project.

 2.  Select PPM Center > Update Work Plan from PPM Project.

Retrieving Actuals from Project Management 

(Shared Control Mode)

You can update the Microsoft Project file with actuals data retrieved from the associated Project 
Management work plan when Project Management and Microsoft Project share control of the plan. The 
integration will show you the tasks in the Microsoft Project work plan that will be updated with new 
actuals, and gives you the option of cancelling the update if the changes are not what you expected.

Microsoft Project maintains internal rules that determine the way field values are calculated in actuals 
fields. This will lead to situations where the data in each application does not match exactly. To 
manage the transfer of actuals information, use the Microsoft Project Integration policy for the 
project. See "Transferring PPM Center Information to Microsoft" on page 236 for more information.

Caution:  Do not filter out all tasks in Microsoft Project before you retrieve actuals from Project 
Management.

To update the Microsoft Project work plan with actuals from Project Management for a plan using 
shared control:

 1.  Open the project in Microsoft Project.

 2.  Select PPM Center > Retrieve Actuals from PPM.

The integration retrieves the actuals specified in the Transfer actuals information setting in the 
Microsoft Project Integration policy.

 3.  The Accepting PPM Actuals dialog box opens, displaying the tasks that have changed and the 
nature of their changes. If the changes are not what you expected, you can click Cancel to cancel 
the update.

Click Continue to accept the changes.

 4.  The integration is completed when the Integration Complete dialog displays.

From the Integration Complete dialog, you may choose to remove the association between the 
Microsoft Project work plan and the Project Management project.

Project Management User’s Guide
Chapter 8: Integrating Project Management with Microsoft Project

HPE Project and Portfolio Management Center (9.40) Page 266 of 292



You can also click Show Info to view any informational messages, errors, or warnings that 
occurred while sending the work plan to Project Management. See "Enabling Synchronization 
Logs" on page 253 for information on how to enable full information tracing.

Click Done to close the dialog.

 5.  The Microsoft Project work plan is updated with new actuals from Project Management, and a new 
table opens in Microsoft Project identifying both tasks whose actuals changed (changed actuals) 
as well as tasks whose schedule information changed as a result of Microsoft Project's internal 
field rules (impacted actuals). See "Impact of Microsoft Project Rules on Fields" on page 208 for 
more detailed information.

By default, tasks with changed actuals are displayed in red, while tasks with impacted actuals 
(changes as a result of automatic calculations performed by Microsoft Project) are displayed in 
blue. These colors can be configured in the Microsoft Project Integration policy in the project 
settings. See "Project-Level Settings for Integration" on page 232 for details on its settings.

You can also use custom filters and data table views provided by the integration for Microsoft 
Project to view changed actuals. See "Custom Microsoft Project Filters and Tables" on page 209 
for more details.

To return to the normal Gantt chart view in Microsoft Project, select View Entry.

Sending Work Plan (Planned) Information from 

Microsoft Project to Project Management (Shared 

Control Mode)

You can update the associated Project Management work plan with planned information (such as work 
breakdown structure, schedule, and assignments) from a Microsoft Project file when Project 
Management and Microsoft Project share control of the work plan.

To send work plan information from Microsoft Project to Project Management:

 1.  Open the project in Microsoft Project.

 2.  Select HP PPM Center > Update PPM Project with Work Plan Information.

 3.  The integration automatically performs resource mapping between applications. If resources in 
Microsoft Project cannot be automatically mapped to resources in Project Management, the 
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Mapping Resources dialog displays.

Note:  Automatic resource mapping occurs upon the first synchronization or when a new 
resource is added to Microsoft Project. See "Planned Information" on page 210.

Specify mapping for unmapped resources and click Finish. You can verify the automatic 
mappings, modify any of the automatic mappings, and specify any mappings for unmapped 
resources at a later time. See "Manually Mapping Resources Between Applications (Shared 
Control Mode and Microsoft Project-Controlled Mode)" on the next page for more information about 
the Mapping Resources dialog.

 4.  The integration is completed when the Integration Complete dialog displays.

From the Integration Complete dialog, you may choose to remove the association between the 
Microsoft Project work plan and the Project Management project.

You can also click Show Info to view any informational messages, errors, or warnings that 
occurred while sending the work plan to Project Management. See  "Enabling Synchronization 
Logs" on page 253 for information on how to enable full information tracing.

Click Done to close the dialog.

By default, whenever you send a Microsoft Project file to Project Management, a backup copy of the
 .mpp file is automatically saved to the same directory in which the original file is stored, with the 
extension .bak. See "Backing Up Microsoft Project Files" on page 252.

If you experience an integration error related to the deletion of a task or resource in Microsoft Project 
that had actuals, see "Deleting Required Tasks or Tasks/Resources with Actuals" on page 286.

Updating an Associated Work Plan to Project 

Management (Microsoft Project-Controlled Mode)

You can update the associated Project Management work plan from a Microsoft Project file when 
Microsoft Project controls the work plan.

To update an associated work plan in Project Management from a Microsoft Project file:

 1.  Open the project in Microsoft Project.

 2.  Select PPM Center > Update PPM Project from Work Plan.
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 3.  The integration automatically performs resource mapping between applications. If resources in 
Microsoft Project cannot be automatically mapped to resources in Project Management, the 
Mapping Resources dialog displays.

Note:  Automatic resource mapping occurs upon the first synchronization or when a new 
resource is added to Microsoft Project. See "Planned Information" on page 210.

Specify mapping for unmapped resources and click Finish. You can verify the automatic 
mappings, modify any of the automatic mappings, and specify any mappings for unmapped 
resources at a later time. See "Manually Mapping Resources Between Applications (Shared 
Control Mode and Microsoft Project-Controlled Mode)" below for more information about the 
Mapping Resources dialog.

 4.  The integration is completed when the Integration Complete dialog displays.

Note:  If a resource or task in Microsoft Project is deleted and that resource or task has 
actuals configured in Project Management or that task is required in Project Management, the 
integration fails. See "Deleting Required Tasks or Tasks/Resources with Actuals" on 
page 286 for more information.

From the Integration Complete dialog, you may choose to remove the association between the 
Microsoft Project work plan and the Project Management project.

You can also click Show Info to view any informational messages, errors, or warnings that 
occurred while sending the work plan to Project Management. See  "Enabling Synchronization 
Logs" on page 253 for information on how to enable full information tracing.

Click Done to close the dialog.

By default, whenever you send a Microsoft Project file to Project Management, a backup copy of the
 .mpp file is automatically saved to the same directory in which the original file is stored, with the 
extension .bak. See "Backing Up Microsoft Project Files" on page 252.

Manually Mapping Resources Between Applications 

(Shared Control Mode and Microsoft Project-

Controlled Mode)

In shared control mode and Microsoft Project-controlled mode, during synchronization, Microsoft 
Project resources are automatically mapped to PPM Center resources. Automatic resource mapping 
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occurs upon the first synchronization or (during synchronization) when a new resource has been added 
to Microsoft Project. You can also manually map resources. See  "Planned Information" on page 210for 
more information about automatic resource mapping. See "How to Manually Map Resources" below for 
information on how to manually map resources.

When mapping or unmapping resources, consider the following:

 l The list of project participants includes resources, the project manager, stakeholders, and summary 
task owners.

 l Project Management resources that are listed are users who are resources in a resource pool that 
the current user manages or resources in the project's staffing profile.

 l Some Microsoft Project resources may not be automatically mapped to an Project Management 
resource. There are two types of unmapped resources. The first type is one that cannot be 
automatically mapped by the Plug-in for PPM and have a question mark in each PPM Center 
resource column. The second type is one that is intentionally set as unmapped and have empty 
fields in each PPM Center resource column.

 l You can leave some resources intentionally unmapped. In this case, the effort associated with 
those resources will appear as unassigned effort on the task in Project Management.

 l You can map a single Project Management resource to more than one Microsoft Project resource. 
However, these Microsoft Project resources cannot be assigned to the same task.

How to Manually Map Resources

To manually map resources from Microsoft Project to Project Management:

 1.  Open the project in Microsoft Project.

 2.  Select PPM Center > View Mapping of Resources.

The Mapping Resources dialog opens. In the table, each row is associated with a Microsoft 
Project resource. These resources may be mapped to one or more PPM Center resources or they 
may be unmapped. Unmapped resources will have a question mark or empty fields in each PPM 
Center resource column.

 3.  You can map or unmap a Microsoft Project resource.

To map a Microsoft Project resource:

 a.  Select the Microsoft Project resource from the table and click Map.
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The Project Participants dialog opens. The table lists PPM Center resources who are defined 
as participants in the project.

 b.  You can map a resource from the table or search for additional PPM Center resources.

 l To map a resource from the table:

 A.  Select the resource from the table.

 B.  Click Select or double-click the selected item.

 l To search for additional PPM Center resources:

 A.  Click Search.

The Search for Resources dialog opens.

 B.  Provide search criteria in the appropriate fields.

 C.  Click Search.

The Search for Resources dialog reloads, displaying the results of your search.

 D.  Select one resource to map and click Select.

 c.  Verify the mapping in the Mapping Resources dialog.

To unmap a Microsoft Project resource:

 a.  Select the Microsoft Project resource from the table and click Unmap.

 b.  Verify the mapping in the Mapping Resources dialog.

 4.  Click Finish.

 5.  If you have unmapped resources (resources that cannot be automatically mapped by the Plug-in 
for PPM and have not been set as intentionally unmapped), a warning message displays. 

 o To save unmapped resources, click Continue. 

 o To map the unmapped resources, click Previous (you will be returned to the Mapping 
Resources dialog).
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Manually Mapping Enterprise Resources Between 

Applications 

During synchronization with a Microsoft Project enterprise project, Microsoft Project resources (both 
enterprise and local) are automatically mapped to PPM Center resources. Automatic resource mapping 
occurs upon the first synchronization or (during synchronization) when a new resource has been added 
to Microsoft Project. You can also manually map resources. See "Planned Information" on page 210 for 
more information about automatic resource mapping. See "How to Manually Map Resources" on 
page 270 for information on how to manually map resources.

When mapping or unmapping enterprise resources, consider the following:

 l The list of project participants includes resources, the project manager, stakeholders, and summary 
task owners.

 l Project Management resources that are listed are users who are resources in a resource pool that 
the current user manages, resources in the project's staffing profile, or resources in any resource 
pool when the RM_OVERRIDE_ASSIGNMENT_CONTROLS parameter is set to TRUE.

 l Some Microsoft Project resources may not be automatically mapped to an Project Management 
resource. There are two types of unmapped resources. The first type is one that cannot be 
automatically mapped by the Plug-in for PPM and have a question mark in each PPM Center 
resource column. The second type is one that is intentionally set as unmapped and have empty 
fields in each PPM Center resource column.

 l You can leave some resources intentionally unmapped. In this case, the effort associated with 
those resources will appear as unassigned effort on the task in Project Management.

 l You can map a single Project Management resource to more than one Microsoft local resource. 
However, these Microsoft Project resources cannot be assigned to the same task.

 l You can map an Project Management resource to both a Microsoft local resource and a Microsoft 
enterprise resource in a Microsoft enterprise project.

 l You can map an Project Management resource to only one Microsoft enterprise resource.

 l In order to map and edit the mapping of Microsoft Project enterprise resources, you must have the 
Create MSPS Resource Mapping and Edit MSPS Resource Mapping access grants in PPM 
Center. See  "Access Grants for Mapping Enterprise Resources" on the next page for more 
information.
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 l Both Microsoft enterprise resources and PPM Center resources are shared across the enterprise. 
Microsoft local resources are not shared. Once a Microsoft enterprise resource is mapped to a PPM 
Center resource, the mapping is also shared across the enterprise and may be shared among 
multiple enterprise projects. When remapping an enterprise resource, remember that any change 
may affect multiple enterprise projects.

For instructions on how to manually map resources, see "How to Manually Map Resources" on 
page 270. 

Differences in the Mapping Resources Dialog when 

Mapping Enterprise Resources

When mapping Microsoft enterprise resources, differences in the Mapping Resources dialog are as 
follows:

 l Icons for enterprise resources (mapped and unmapped enterprise resources) are differentiated from 
local resources with a red square around the icon. 

 l A new column, Enterprise, is displayed in the table and specifies if the resource is or is not an 
enterprise resource (the project must be an enterprise project and Microsoft Project must be 
connected to the Microsoft Project server in order for this column to display).

Access Grants for Mapping Enterprise Resources

In order to map and edit the mapping of Project Management resources to Microsoft enterprise 
resources, a user must have the appropriate access grants, as described in "Table 10-12. Mapping 
Microsoft enterprise resources access grants" below.

Access Grant Description

Create MSPS 
Resource Mapping

Allows the user to do the following:

 l Create a new mapping between an Project Management resource and a 
Microsoft Project enterprise resource.

Edit MSPS Resource 
Mapping

Allows the user to do the following:

 l Edit the mapping between an Project Management resource and a 
Microsoft Project enterprise resource.

Table 10-12. Mapping Microsoft enterprise resources access grants
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Access Grant Description

 l Unmap an Project Management resource from a Microsoft Project 
enterprise resource.

Table 10-12. Mapping Microsoft enterprise resources access grants, continued

The Create/Edit MSPS Resource Mapping access grants are automatically given to the following 
security groups:

 l PPM All Access Grants 

 l PPM Project Manager 

Conditional Editing Allowed in Project Management

Depending on the synchronization mode that has been selected for a project, the project structure and 
task information will be controlled by either Project Management or Microsoft Project. Depending on the 
synchronization control mode selected for the project, some editing features in Project Management 
will be disabled. Information controlled by Microsoft Project cannot be edited in Project Management.

Summaries of the conditional editing restrictions for each synchronization mode are listed in 
"Conditional Editing Allowed in Project Management" on page 224.

Editing Project Management-Controlled Projects

When Project Management controls the project, the user is allowed to edit all information in Project 
Management. This includes changing the task structure, adding or deleting new subprojects and tasks, 
and editing task scheduling and actual fields. 

Editing Microsoft Project-Controlled Projects

When Microsoft Project controls all the project planning and tracking activities, the comparable editing 
functions in Project Management are disabled. The data that is distinct to Project Management and not 
shared with Microsoft Project can still be edited. This includes task activity, role, skill values, 
description, user data, notifications, notes, and task references.

When working with a project type that enforces a particular work plan template, you can create the 
work plan initially in Project Management from the specified work plan template. You can then open the 
work plan in Microsoft Project.
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Any function that could change the project and task structure is disabled in Project Management. This 
includes the following components:

 l Add Task icon

 l Delete icon

 l Indent/Outdent icons

 l Move up/Move down icons

Since scheduling can change dates and durations, the Schedule Project icon is disabled. The status 
of the PPM Center project cannot be changed in this synchronization mode; therefore the Change 
Status is also disabled. The keyboard shortcuts for these icons are disabled as well.

In the standard Project Management interface, the My Tasks portlet and the Task Detail page will not 
allow users to enter task actuals. The My Tasks portlet and the Task Search page still return the 
current incomplete tasks assigned to a user regardless of the control mode. This provides visibility to 
the project's participants. The actuals collected in Microsoft Project are visible through the Work Plan 
page.

Roll-up calculations are disabled through Project Management, whether triggered by actions in the 
PPM Workbench, the standard web pages, or any other method. Therefore, the rolled-up values in 
Project Management will match Microsoft Project even if calculations in Project Management would 
normally produce a different value.

Editing in Shared Control Mode

The shared control mode is more complex than the other two modes when disabling fields. This mode 
allows users to change the actual fields while keeping the planning fields unchanged.

Only actual fields are editable, through the Resources tab on the Task Details page. The planning 
fields are disabled. In the Schedule view, planning fields in the subproject/task table are also not 
editable. 

Similar to the Microsoft Project control mode, any function that could change the project and task 
structure is disabled. This includes the following components:

 l Add Task icon

 l Delete icon

 l Indent/Outdent icons

 l Move up/Move down icons
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Some roll-up operations are disabled. Roll-up of actuals fields still occurs, but schedule fields will not 
roll up. The imported values from Microsoft Project are retained. 

The functionality allowed in shared control mode is very similar to the functionality allowed to a user 
who has been given only the Update Tasks access grant.

Removing Microsoft Project and Project 

Management Associations

A Microsoft Project file can be associated to only one Project Management project. You can remove 
the association between a Microsoft Project file and an Project Management project at any time.

Note:  You should only remove the association if you are sure you no longer need to link the 
Microsoft Project file to the Project Management project. Removing the link may make it 
impossible to re-associate the file.

To remove the association:

 1.  Open the project in Microsoft Project.

 2.  Select PPM Center > Project Details.

The Project and Portfolio Management Center Integration Details dialog box opens.

 3.  Click Remove Association.

If you have already removed the association, the button will be labeled Restore Association, 
which allows you to restore the association with the same Project Management work plan.

 4.  Click Remove.

 5.  Click OK.

Note:  Resource mapping is still retained even though the association has been removed. This 
allows you to restore the association without remapping resources. Therefore, if you link the 
project again, automatic resource mapping does not occur (but you can modify the resource 
mapping manually). See "How to Manually Map Resources" on page 270. If you want to remove 
the resource mapping from the unlinked file, see "How to Remove Resource Mappings from an 
Unlinked File" on page 287.
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Restoring Microsoft Project and Project 

Management Associations

You can restore an association between a Microsoft Project file and an Project Management project if 
an association has been removed or has unexpectedly been removed. Associations cannot be restored 
if an association never existed between a Microsoft Project file and an Project Management project. 
Instead, send the Microsoft Project file to an Project Management project (see "Sending a Microsoft 
Project Work Plan to Project Management" on page 263).

To restore an association:

 1.  Open the project in Microsoft Project.

 2.  Select PPM Center > Project Details.

The Project and Portfolio Management Center Integration Details dialog box opens. The fields in 
the dialog are empty.

 3.  Click Restore Association.

Information about the associated Project Management work plan appears in the dialog fields.

Field Name Description

Server URL of the PPM Server.

Username Username used to log in to the PPM Server.

Name Name of the Project Management project.

Mode Synchronization mode of the Project Management project.

 4.  Click OK.

Refreshing Microsoft Project and Project 

Management Associations 

Refreshing the association between a Microsoft Project file and Project Management project reconciles 
tasks in the work plan such that the work plan can be synchronized.
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If an Project Management work plan is opened in Microsoft Project and, in Microsoft Project you delete 
a required task or a task with actuals, when you synchronize the work plan, you will get an error 
message.

In the case of a deleted required task, you will not be able to synchronize planned information (in shared 
control mode and Microsoft Project-controlled mode).

In the case of a deleted task with actuals, you will not be able to synchronize actuals information (in 
Project Management-controlled mode and shared control mode).

The tasks must be reconciled before the work plan is synchronized. You can reconcile the tasks by 
refreshing the work plan associations.

To refresh the association between Microsoft Project and Project Management:

 1.  From the Microsoft Project Add-Ins tabbed area, select PPM Center > Refresh Association.

Note:  This menu option is only available after an unsuccessful attempt to synchronize work 
plans.

 2.  If prompted, type your Project Management username and password and click OK.

 3.  From the Select a Project dialog, click Search.

 4.  Select a project to which to refresh the association to the Microsoft Project work plan.

You can only select from projects that have work plans, and only for projects for which you are the 
project manager. If no such project exists, you must create one in Project Management.

 5.  Click Select or double-click the selected item.

 6.  In the Refresh Task Mapping Table dialog, verify the associations that will be refreshed. If a task 
has more than one matching task or option, select the most appropriate task or option. Click 
Continue.

 7.  The refresh is completed when the Integration Complete dialog displays.

From the Integration Complete dialog, you may choose to remove the association between the 
Microsoft Project work plan and the Project Management project.

You can also click Show Info to view any informational messages, errors, or warnings that 
occurred while refreshing the work plan. See  "Enabling Synchronization Logs" on page 253 for 
information on how to enable full information tracing.

 8.  Click Done to close the dialog.
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Working with Projects Using a Microsoft Project 

Server

When working with a Microsoft Project Server-based project, Project Management functions slightly 
differently, in the following ways:

 l In Project Management-controlled mode, the Plug-in for PPM must be configured to use a calendar 
on the Microsoft Project Server. The calendar is used by the Plug-in for PPM to synchronize task 
information during integration. By default, the calendar used is PPM Calendar (for the English 
language). This calendar can be configured from the user preferences of the Plug-in for PPM (see 
"Setting the Microsoft Project Server Calendar for the Plug-in for PPM" on page 259). If a calendar 
is not configured and the default calendar does not exist on the Microsoft Project Server, integration 
fails.

 l Work plans that are controlled by Project Management cannot be directly opened in Microsoft 
Project from Project Management.

 l If actual effort is supplied by Microsoft Project, PPM Center calculates the percent complete of a 
task. If actual effort is not supplied, PPM Center uses the percentage completed supplied by 
Microsoft Project.

 l Backup files are not created for Microsoft Project Server-based projects.

 l If a temporary project file that is created for Microsoft Project Server is integrated with PPM Center, 
after the temporary Microsoft Project file is closed, it cannot be re-opened from PPM Center. The 
temporary Microsoft Project file is never saved and does not exist on the Microsoft Project Server. 
Therefore, PPM Center cannot find the Microsoft Project file to which it was integrated. 

You may import the existing PPM Center project into Microsoft Project. However, any information 
specific to Microsoft Project (such as extra columns) that was part of the temporary Microsoft 
Project file is lost. Information specific to Microsoft Project is not included in the integration with 
PPM Center. Therefore, during the initial integration with the temporary Microsoft Project file, the 
information was not integrated with PPM Center.

Note:  After synchronizing a Microsoft Project Server-based project with a work plan, you should 
also check in the project to the Microsoft Project Server.
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Working with Projects Using Microsoft Enterprise 

Project Management 

When working with a Microsoft enterprise project, consider the following:

 l Project Management functions slightly differently. See "Working with Projects Using a Microsoft 
Project Server" on the previous page.

 l You can map Microsoft enterprise resources to Project Management resources. See "Manually 
Mapping Enterprise Resources Between Applications " on page 272.

 l If you are using multiple instances of Microsoft Project Server with a single instance of PPM 
Center, you must uniquely identify Microsoft enterprise resources across all Microsoft Project 
Server instances. See "Using Multiple Microsoft Project Server Instances" on the next page.

 l If you are opening an integrated enterprise project, the behavior is different if you are connected or 
not connected to the Microsoft Project Server. See "Table 10-13. Opening an Integrated Enterprise 
Project When Connected and Not Connected to the" below for a description of this behavior.

 l If you synchronize a local copy of an enterprise project (Microsoft Project 2007 only), you must 
relink the PPM Center project to the local copy of the enterprise project. If you are connected to the 
Microsoft Project Server, PPM Center resources are mapped to Microsoft enterprise and local 
resources. If you are not connected, resource mapping is retained until you connect to the Microsoft 
Project Server.

 Connected to Microsoft Project Server
Not Connected to Microsoft 
Project Server

Open an Integrated 
Microsoft Enterprise 
Project from PPM 
Center

The integrated Microsoft enterprise project 
opens. Enterprise and local resource 
mapping is retained.

The integrated Microsoft 
enterprise project cannot be 
opened. A new local copy of an 
enterprise project may be 
created.

Open an Integrated     
PPM Center Project 
from Microsoft 
Project

You have the option to do the following:

 l The integrated PPM Center project 
can be opened. Enterprise and local 
resource mapping is retained.

A new local Microsoft enterprise 
project can be created. PPM 
Center resources are mapped to 
Microsoft local resources.

Table 10-13. Opening an Integrated Enterprise Project When Connected and Not Connected to 
the
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 Connected to Microsoft Project Server
Not Connected to Microsoft 
Project Server

 l A new Microsoft enterprise project can 
be created. PPM Center resources are 
mapped to local resources. If there are 
conflicts between enterprise and local 
resources, you are prompted to 
replace or rename the local resources.

Table 10-13. Opening an Integrated Enterprise Project When Connected and Not Connected to 
the, continued

Using Multiple Microsoft Project Server Instances

If you are using multiple instances of Microsoft Project Server with a single instance of PPM Center, 
you must uniquely identify Microsoft enterprise resources across all Microsoft Project Server 
instances. 

In Microsoft Project Server, the ID assigned to an enterprise resource on one instance may be 
assigned to another enterprise resource on another instance. That is, the same ID may be used among 
multiple Microsoft Project Server instances. You must use an enterprise custom field of type text (that 
is not a field ID) to uniquely identify each enterprise resource.

Note:  Microsoft Project Server 2003 and Microsoft Project Server 2007 support different 
enterprise custom fields. In Microsoft Project Server 2003, you can only use the existing enterprise 
custom fields (for example, EnterpriseText1). In Microsoft Project Server 2007, you may create 
new enterprise custom fields.

On the PPM Server, add the parameter MSPS_RESOURCE_CUSTOM_FIELD to the server.conf file. This 
parameter must be set to the name the Microsoft Project Server enterprise custom field used to 
uniquely identify the enterprise resource. See the Installation and Administration Guide for information 
on editing the server.conf file.

Working with Projects using Project Web Access

Using Project Web Access to check out an enterprise resource generates a temporary project file for 
Microsoft Project Server. While you can integrate this temporary project file with PPM Center, once 
you close this temporary file, the file is not saved on the Microsoft Project Server. Even if you save the 
temporary project file, it is not saved on the Microsoft Project Server. Therefore, after closing the 
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temporary project file, you cannot open the integrated project file on PPM Center from Microsoft Project 
Server because it is associated with a project file that does not exist on Microsoft Project Server.

Troubleshooting
Microsoft Project supports many features that are not duplicated in or synchronized with Project 
Management. When a Microsoft Project file is imported into Project Management, this information is 
not represented. Sending a Microsoft Project file to Project Management does not remove this data 
from Microsoft Project. Opening an Project Management work plan in Microsoft Project does not create 
or default this data.

Other Microsoft Project features deal with the scheduling and tracking information that is synchronized 
between the two applications. In these cases, the interface converts the Microsoft Project data into 
information that Project Management can represent. The interface attempts to maintain the intent of the 
original work plan as closely as possible.

Errors and Warnings

During synchronization, the Errors and Warnings window informs you of errors or warnings, and 
includes suggestions for resolving issues as they occur.

 l Errors are fatal problems that must be resolved for the task to be successful. Errors stop the 
integration process, allowing you to correct the problem and restart the integration.

 l Warnings are for informative purposes. After reviewing a warning, you may choose to respond to 
the warning or ignore it.

Installing Visual Studio Tools for Office (VSTO) on 

Windows Vista or Windows 7

On a Windows Vista or Windows 7 system, if you have the ability to install software on the system but 
are having problems installing VSTO using the Plug-in for PPM installer, you may need to invoke the 
Plug-in for PPM installer as an administrator. Do the following:
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 1.  Right-click on the setup.exe file and select Run as administrator.

 2.  Click OK.

 3.  Follow the prompts to install VSTO. Install only VSTO (do not install the Plug-in for PPM at this 
time).

After VSTO is installed and you have exited from the Plug-in for PPM installer, install the Plug-in for 
PPM (see "Installation Instructions" on page 197).

The HPE PPM Center Menu is Not Visible and How 

to Re-enable the Plug-in for PPM

If PPM Center was unexpectedly halted during operation (for example, the system on which PPM 
Center is running fails), you may need to re-enable the Plug-in for PPM from Microsoft Project in order 
to display the PPM Center menu.

To re-enable the Plug-in for PPM from Microsoft Project:

 1.  Click Help > About.

 2.  Click Disabled Items.

 3.  If the Plug-in for PPM is listed, remove it from the list to enable it.

Connecting to a PPM Server with an Invalid SSL 

Certificate

If the SSL certificate on the PPM Server is not valid, a warning message displays when you try to 
connect to the PPM Server. You can choose to Always Ignore (always ignore this warning message), 
Session Only (ignore the warning message for this Microsoft Project session only), or Cancel (do not 
connect to the PPM Server).

If you choose to always ignore the warning message, the message will always be ignored unless you 
change the connection to the PPM Server. If, after choosing to always ignore the warning message, 
you would like to display the warning message, change the PPM Server connection, save the changes, 
and then change the PPM Server connection back to the original connection.
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Single Sign-on Systems and Microsoft Internet 

Explorer

If you are having problems accessing a single sign-on system, verify that the Plug-in for PPM proxy 
settings and Microsoft Internet Explorer proxy settings are the same.

The PPM Center Menu

The PPM Center menu shows the menu selections for the last active Microsoft Project file. For 
example, if you have two project files opened in Microsoft Project, one is controlled by Microsoft 
Project and the other is shared control, if you close the file controlled by Microsoft Project, the PPM 
Center menu shows the menu selections for a Microsoft Project-controlled project (even though the 
shared control project is the only project opened and being displayed). To view the correct menu 
selections, click anywhere in the shared control project to make it active.

Opening a Work Plan in Microsoft Project from PPM 

Center

Using Internet Explorer and Microsoft Project 2007, opening a work plan in Microsoft Project from PPM 
Center generates a lock file for the Microsoft Project file. However, after closing the Microsoft Project 
file, the lock file is not reset. When opening the same work plan in Microsoft Project from PPM Center 
(without restarting Internet Explorer), the File in Use message is displayed and the Microsoft Project 
file can only be opened in read-only mode (you may also choose to be notified when the file is no longer 
in use).

After closing the Microsoft Project file that has been opened from PPM Center, reset the lock file by 
doing one of the following:

 l Delete the lock file

From any Internet Explorer window, do the following:
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 a.  Select Tools > Internet Options.

 b.  In the General tabbed area, in the Temporary Internet files section, click Delete Files.

 c.  From the Delete Files dialog, click OK.

 d.  From the Internet Options dialog, click OK.

 l Restart Internet Explorer

 l Restart the system on which Internet Explorer is running

Manual Scheduling Mode in Microsoft Project

If your Microsoft Project file is in manual scheduling mode and you did not select this option, it could be 
because:

 l The previous synchronization with Project Management failed. During synchronization, in Project 
Management-controlled mode or shared control mode, the scheduling mode is set to manual and 
then returned to automatic once the synchronization completes. If the synchronization did not 
complete, the scheduling mode may have been left in manual.

 l You opened a project that was in manual mode and then created the Microsoft Project file resulting 
in the project inheriting the manual mode setting as a default.

Roll-up Values Are Not Being Recalculated in 

Microsoft Project

In Microsoft Project, there are two scheduling modes: automatic and manual. By default, a project is in 
automatic scheduling mode and roll-up values are automatically recalculated. If, for some reason, the 
project is in manual scheduling mode (see "Manual Scheduling Mode in Microsoft Project" above), then 
you can do one of the following:

 l Set the project to automatic scheduling mode.

 l Select F9 to recalculate roll-up values.

Note:  If the work plan is Project Management-controlled, you may not want to recalculate the roll-
up values. Recalculating the roll-up values results in changes to project dates.
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Synchronization Failures

Synchronization may fail or may appear to fail for the following reasons:

 l A Microsoft Project Help dialog opens and requires a response. The Microsoft Project button in the 
Windows task bar should flash if a dialog opens. Select the Don't tell me about this again 
checkbox and close the dialog to continue with the synchronization.

 l Any Microsoft Project dialog opens and requires a response. The Microsoft Project button in the 
Windows task bar should flash if a dialog opens. Respond to the Microsoft Project dialog to 
continue with the synchronization.

Note:  Do not open other Microsoft Project files if asked to do so by the dialog.

 l Another Microsoft Project file is open. Close all open Microsoft Project files and Microsoft Project 
before restarting the synchronization.

Deleting Required Tasks or Tasks/Resources with 

Actuals

When a work plan is being shared between Microsoft Project and Project Management, deleting one of 
the following entity types in Microsoft Project results in an error that will halt the next integration 
process (you cannot delete tasks or resources with actuals in Project Management):

 l A task marked as required by the work plan template, if the work plan was originally created in 
Project Management from a work plan template.

 l A task or resource that has actuals.

If you experience an integration error related to the deletion of a task or resource in Microsoft Project 
that had actuals, you can do one of the following:

 l Use the existing backup copy as a starting point from which to reapply your most recent edits. See 
"Backing Up Microsoft Project Files" on page 252 for more information about backups.

 l In Microsoft Project, select PPM Center > Refresh association to restore the task and 
dependency.
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Recovering Deleted Tasks Using Microsoft Project 

Associations

You can relink the work plan to the Microsoft Project file manually by selecting PPM Center > Project 
Details in Microsoft Project (see "Restoring Microsoft Project and Project Management Associations" 
on page 277). After you select the project whose link you want to reestablish, the integration examines 
the work plan task by task and presents you with a list of work plan tasks whose Microsoft Project 
counterparts are ambiguous or nonexistent. For each task, you can choose from the following options:

 l Select a matching task in the Microsoft Project plan

 l Create a new task in the Microsoft Project plan

 l Do nothing

Any tasks in the Microsoft Project plan that are not associated with an Project Management task are 
ignored.

How to Remove Resource Mappings from an 

Unlinked File

If you have removed the association between a PPM Center project and a Microsoft Project file, 
resource mapping is retained (in case you want to re-associate the files). 

You can manually remove the resource mappings from the unlinked file. After manually removing the 
resource mappings, if you re-link the file, automatic resource mapping is performed.

To remove the resource mappings from the unlinked file, do the following:

 1.  Open the project in Microsoft Project.

 2.  Locate the column that contains the PPM Center IDs used for mapping. The name of the column 
is set in the Microsoft Project Integration policy by the field PPM resource information requires 
one Microsoft resource custom field (by default, the column is named Number20).

 3.  Delete all the PPM Center IDs from this column.

 4.  Save the project.
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Chapter 9: Integration with Time 
Management 
 l "Overview of Time Management Integration" below

 l "Enabling Time Management for Projects" on page 290

 l "Using the My Tasks Portlet" on page 290

Overview of Time Management Integration
This section explains how Project Management integrates with Time Management to offer a more 
detailed way for resources to report time worked on projects. This section is only useful if you have 
purchased and installed Time Management.

In the project settings, you use the Cost and Effort policy (primarily its Time Management section) to 
integrate Time Management and Project Management for a particular project. There you specify:

 l At what level of detail the project's tasks are tracked on time sheets

 l Who can log time for the project

 l Whether certain project representatives must approve time logged

 l Which effort fields are tracked

 l Whether time can be logged after a task is complete

In configuring integration, consider the following:

 l Any resource who is licensed for Time Management must use time sheets or the My Tasks portlet, 
rather than the project work plan, to enter actuals for integrated projects.

 l You can configure which actuals are tracked. For integrated projects, where Time Management is 
used to track project actuals, you must require resources to track Actual Effort. 

 l You can configure the level of the project (Project, Summary Task level 1 to 6, or Task) against 
which resources log time. If time is logged at summary task level 2, for example, resources who are 
assigned to any tasks that are hierarchically under level 2 report time for those tasks only at 
summary task level 2.
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 l If Estimated Remaining Effort is to be tracked, time must be logged at the task level.

 l After time is logged against an integrated project, you cannot change logging from any summary 
task level to the task level, nor from project level to the summary task level. However, you can 
change logging from the task level to the summary task level, or from the summary task level to the 
project level.

 l After time is logged against an integrated project, you cannot disable integration.

 l Resources cannot contribute time to the same task from both Project Management and Time 
Management. Therefore, if you plan to establish integration for a project having tasks that are 
partially complete, first ensure that actuals are up to date, then divide each partially completed task 
into a completed task and a new task.

 l Some actuals fields that are updated by Time Management assignments are read-only on the Task 
Details page. Once effort has been provided by the assigned resource, only the assigned resource 
can delete it.

 l Time logged by assigned resources appear as contributions for tasks and summary tasks.

 l Managers of an integrated project do not necessarily need to assign all work plan tasks to Time 
Management users; actuals for Project Management users and unassigned effort will roll up 
automatically.

Note:  The time sheet update service (TM-PM Sync Service) sends updates of actual effort 
entered on tasks in time sheets to the same tasks in their project work plans, as often as specified 
by the service (by default, every 3 hours). Providing these updates as a service improves the 
performance of Time Management. For information about configuring services, see the Installation 
and Administration Guide.

In addition to a Time Management section, the Cost and Effort policy also has a Resource Load 
Settings section and a Financial Management section. 

For information about the Resource Load Settings section, see "Resource Load Settings" on page 45.

In the Financial Management section, you can specify whether to use automatic cost calculation so 
that, whenever a resource updates and saves a time sheet, Time Management automatically passes 
the effort data to Project Management, which calculates and updates the Actual Cost for the project. 
(Then the Actual Cost cannot be edited directly in Project Management.) If you do not roll up any values 
from the work plan (cost data is entered manually into the financial summary), Time Management still 
passes effort data to Project Management, but Project Management does not calculate Actual Cost. 
For more information, see "Financial Management" on page 47.
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The Project Fields policy determines whether Estimated Finish Date and certain other fields are 
tracked.

Enabling Time Management for Projects
The Cost and Effort policy determines whether Time Management is active for a given project type. 
Projects created using a project type with Time Management enabled will be able to use Time 
Management to collect actuals. For details on configuring the Cost and Effort policy to enable the use 
of Time Management, see "Cost and Effort" on page 43.

Using the My Tasks Portlet
The My Tasks portlet displays information for multiple tasks. The maximum number of tasks displayed 
can be specified by the user, as well as the portlet title. Most fields in the My Tasks portlet are 
updateable by resources.

With Time Management enabled, the My Tasks portlet allows you to enter time using time sheets for 
projects using Time Management. Summary tasks also appear on the My Tasks portlet for integrated 
projects.

If you are working on a project that uses Time Management, the My Tasks portlet displays the Actual 
Effort field for each task as a calculated roll-up of the effort breakdown, which corresponds to the time 
sheet indicated in the Use Time Sheet field, filtered for only the relevant tasks. Clicking the Actual 
Effort value opens the effort breakdown for direct editing. The effort breakdown displays only the tasks 
shown in the My Tasks portlet.

Note:  Values provided in the effort breakdown are for the time sheet specified in the Use Time 
Sheet field. If you wish to provide values for a different time sheet, select the desired time sheet 
before editing the effort breakdown for a task or summary task.

To enter actuals information for a project on a time sheet from the My Tasks portlet:

 1.  Navigate to the My Tasks portlet.

 2.  Ensure that the correct time sheet appears in the Use Time Sheet field.

If the time period being entered has no time sheet, you are offered the option to use a new time 
sheet, which will be created when Save is clicked.
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Time sheets in the "In Rework" and "Pending Approval" status cannot be edited from the My 
Tasks portlet. Time sheets in the "Frozen" and "Closed" states do not appear in the list of 
available time sheets.

 3.  Click the Actual Effort value for the task you wish to enter actuals information for.

The Effort Breakdown dialog box opens.

 4.  Provide the information for the desired time sheet lines.

You can provide time on separate lines for tasks with different activities.

 5.  Click Done.

 6.  Click Save.

You can open the time sheet being affected anytime from the My Tasks portlet by clicking Go To Time 
Sheet.

Note:  Data for tasks that appear in the My Tasks portlet that have actuals will be automatically 
saved to the time sheet when Go To Time Sheet is clicked.

Any unsaved changes that have been made to the effort breakdown are discarded when Go To 
Time Sheet is clicked.
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Send documentation feedback
If you have comments about this document, you can contact the documentation team by email. If an 
email client is configured on this system, click the link above and an email window opens with the 
following information in the subject line:

Feedback on Project Management User’s Guide (Project and Portfolio Management Center 
9.40)

Just add your feedback to the email and click send. 

If no email client is available, copy the information above to a new message in a web mail client, and 
send your feedback to your_IE_team_PDL@hpe.com.

We appreciate your feedback!
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